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1 Getting Started

Simulink Design Verifier Product Description

Identify design errors, generate test vectors, and verify designs
against requirements

Simulink Design Verifier uses formal methods to identify hard-to-find design
errors in models without requiring extensive tests or simulation runs. Design
errors detected include dead logic, integer overflow, division by zero, and
violations of design properties and assertions.

Simulink Design Verifier highlights blocks in the model containing these
errors and blocks proven to be without them. For each block with an error,
it calculates signal-range boundaries and generates a test vector that
reproduces the error in simulation.

The generated test vectors provide simulation inputs that exercise
functionality captured in the model structure and specified by the test
objectives. The test vectors, together with the design properties and test
objectives, can be used to verify code running in software-in-the-loop (SIL)
and processor-in-the-loop (PIL) test configurations.

Learn more about verification, validation, and test in Model-Based Design
and support for certification standards in automotive, aerospace, and
industrial automation applications.

Key Features

e Polyspace® and Prover Plug-In formal analysis engines

e Detection of dead logic, integer and fixed-point overflows, division by zero,
and violations of design properties

¢ Blocks and functions for modeling functional and safety requirements

¢ Test vector generation from functional requirements and model coverage
objectives, including condition, decision, and modified condition/decision

MCDC)

® Property proving, with generation of violation examples for analysis and
debugging

¢ Fixed-point and floating-point model support

1-2


http://www.mathworks.com/discovery/formal-verification.html
http://www.mathworks.com/verification-validation/
http://www.mathworks.com/automotive/standards/iso-26262.html
http://www.mathworks.com/aerospace-defense/standards/do-178b.html
http://www.mathworks.com/industrial-automation-machinery/standards/iec-61508.html

Before You Begin

Before You Begin

In this section...
“What You Need to Know” on page 1-3

“Required Products” on page 1-3

What You Need to Know

Getting started with the Simulink Design Verifier software requires that
you have experience using model coverage, as well as building and running
Simulink models.

For more information, see:

® “Model Coverage” in the Simulink Verification and Validation™
documentation

® “Getting Started with Simulink” in the Simulink documentation

Required Products

You must have the following products installed to use the Simulink Design
Verifier software:

e MATLAB®
e Simulink

e Simulink Verification and Validation

If you want to use the Simulink Design Verifier software to analyze models
that contain Stateflow® charts, you must have the Stateflow installed.



1 Getting Started

Starting the Simulink Design Verifier Software
The Simulink Design Verifier software is part of your MATLAB installation.

To open the Simulink Design Verifier block library, type at the MATLAB
prompt, type sldvlib.

©-© W

Ohbjectives and Constraints Verification Utilities
—_rrn_
1 Example
xxxxxxxxxxxxxxxxxxxxxx - Properties

Temporal Operators

The Simulink Design Verifier block library has three categories of blocks:

¢ Objectives and Constraints — Blocks that define custom objectives and
constraints

e Temporal Operators — Blocks that define temporal properties on Boolean
signals

e Verification Utilities — Miscellaneous verification utilities
The block library also has a sublibrary, Example Properties, that includes

examples of how to specify common properties in your model. You can easily
adapt these examples for use in your models.



Analyze a Model

Analyze a Model

In this section...

“About This Example” on page 1-5
“Open the Model” on page 1-5

“Generate Test Cases” on page 1-7

“Combine Test Cases” on page 1-25

About This Example

The following sections describe an example model, Cruise Control Test
Generation. This example illustrates how to use the Simulink Design Verifier
software to generate test cases that achieve complete model coverage.
Through this example, you learn how to analyze models with the Simulink
Design Verifier software and interpret the results.

Open the Model

To open the Cruise Control Test Generation model, at the MATLAB prompt,
enter:

sldvdemo_cruise_control
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Simulink Design Verifier
Cruise Control Test Generation

enable

[;J
¥

brake throt 1 )

@
¥

set [0 100]
Actual speed

speead

[

8
h

ine target———»(( 2 )
inc target

dec

@
¥

dec

Controller

This example shows howto generate test cases that achieve complete model
coverage. By default, Simulink Design Verifier generates test cases that satisfy
objectives in the fewest steps. One ofthe test objectiv es forces the discrete integrator
in the Pl controller to exceed its upper limit. When you run Simulink Design Verifier
without canstraints, the limitis exceeded in a single step by forcing speed to be 500.
The constraint on speed limits the values in test cases between 0 and 100. This

forces the test casesto take several samples to exceed the integrator limit.
T A AR AAAAANNNAN—A—A—N——A—— R RRRRRRRRRNN NN NN NNRRRRA——RRAEEEE GGG

Togale Speead
Constraint
{double-click)

Run
{double-click)

View Options
{double-click)

Run Simulink Design Verifier Toggle Constraint  View Simulink Design Verifier Options

1-6
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Generate Test Cases

“Run Analysis” on page 1-7

“Generate Analysis Results” on page 1-9

“Highlight Analysis Results on Model” on page 1-10

“Generate Detailed Analysis Report” on page 1-13

“Create Harness Model” on page 1-20

“Simulate Tests and Produce Model Coverage Report” on page 1-24

Run Analysis

To generate test cases for the Cruise Control Test Generation model, open the
model window and double-click the block labeled Run.

Simulink Design Verifier begins analyzing the model to generate test cases,
and the Simulink Design Verifier Results Summary window opens. The
Results Summary window displays a running log showing the progress of
the analysis.



1 Getting Started

P

Simulink Design Verifier Results Summary: sldvdemo_cruise_con... @

Progress |

Objectives processed 32/34

m

Satisfied 32
Falsified 0
Flancad tima ne=n il

m

12-Jun-2013 15:40:44

Starting test generation for model 'sldvdemo_cruise_control'
Compiling model... done

Translating model... done

'sldvdemo_cruise_control' is compatible with Simulink
Design Verifier,

Generating tests...

SATISFIED

Controller/Logical Operator

Logic: MCDC expression for output with input port 3 T
Analysis Time = 00:00:00

SATISFIED i

Highlight | |  Stop

-

If you need to terminate an analysis while it is running, click Stop. The
software asks if you want to produce results. If you click Yes, the software
creates a data file based on the results achieved so far. The path name of the

data file appears in the Results Summary window.

The data file is a MAT-file that contains a structure named sldvData. This
structure stores the data that the software gathers and produces during the

analysis.
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For more information, see “Simulink® Design Verifier™ Data Files” on page
13-9.

Generate Analysis Results
When the Simulink Design Verifier software completes its analysis of the

sldvdemo_cruise_control model, the Results Summary window displays
several options:

e Highlight analysis results on model

¢ Generate detailed analysis report

¢ Create harness model

¢ Simulate tests and produce a model coverage report

Note When you analyze other models, depending on the results of the
analysis, you may see a subset of these four options.

1-9
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P "

Simulink Design Verifier Results Surmmary: sldvdemo_cruise_con... @

s

Progress |

Objectives processed 34/34

m

Satisfied 34
Falsified 0
Elapsed time 0:06 -

Test generation completed normally.
All 34 objectives are satisfied

Results:

= Highlight analvsis results on model

* Generate detailed analvsis report

* Create harness model

* Simulate tests and produce a model coverage report

Data saved in: sldvdemo cruise control sldvdata.mat
in folder: H:
\DocumentsiR2013b\sldv output'sldvdemo cruise control

View Log I I Close

The sections that follow describe these options in detail.

Highlight Analysis Results on Model

In the Simulink Design Verifier Results Summary window, if you click
Highlight analysis results on model, the software highlights objects in the
model in three different colors, depending on the analysis results:
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® “Green: Objectives Satisfied” on page 1-11
® “Orange: Objectives Undecided” on page 1-12
e “Red: Objectives Unsatisfiable” on page 1-12

When you highlight the analysis results on a model, the Simulink Design
Verifier Results Inspector opens. When you click an object in the model that
has analysis results, the Results Inspector displays the results summary for
that object.

Green: Obijectives Satisfied. Green outline indicates that the analysis
generated test cases for all the objectives for that block. If the block is a
subsystem or Stateflow atomic subchart, the green outline indicates that
the analysis generated test cases for all objectives associated with the child
objects.

For example, in the sldvdemo_cruise_control model, the green outline
shows that the PI controller subsystem satisfied all test objectives. The
Results Inspector lists the two satisfied test objectives for the PI controller
subsystem.

v

In
—» error throt —

Pl Controller

P

'DE Simulink Design Verifier Results Inspector EI@
£t - W

Back to summary - Close results
sldvdemo_cruise_controlfController/PI Controller
enable logical value F SATISFIED - View test case
enable logical value T SATISFIED - View test case

1-11
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Orange: Objectives Undecided. Orange outline indicates that the

analysis was not able to determine if an objective was satisfiable or not. This
situation might occur when:

® The analysis times out

* The software satisfies test objectives without generating test cases due to:

= Automatic stubbing errors

= Limitations of the analysis engine

In the following example, the analysis timed out before it could determine if
one of the objectives for the Discrete-Time Integrator block was satisfiable.

P

'DE Simulink Design Verifier Results Inspector EI@

i) - R
Back to summary - Close results

sldvdemo_cruise_control/Controller/PI Controller/ Discrete-
Time Integrator

integration result <= lower limit F SATISFIED - View test case
integration result <= lower limit T

integration result »= upper limit F SATISFIED - View test case
integration result == upper limit T SATISFIED - View test case

Red: Objectives Unsatisfiable. Red outline indicates that the analysis

found some objectives for which it could not generate test cases, most likely
due to unreachable design elements in your model.

In the following example, input 2 always satisfies the criterion for the Switch
block, so the Switch block never passes through the value of input 3.

1-12
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v

—4
!
_I"-.__

v

—*1—
Switch

P

'F'E Simulink Design Verifier Results Inspector EI@
b - B

Back to summary - Close results
sldvdemo_cruise_control_red_switch/Controller/Switch
logical trigger input false (outputis  UNSATISFIABLE

from 3rd input port)

logical trigger input true (outputis  SATISFIED - View test case
from 1st input part)

Generate Detailed Analysis Report

In the Simulink Design Verifier Results Summary window, if you click
Generate detailed analysis report, the software saves and then opens a
detailed report of the analysis. The path to the report is:

<current_folder>/sldv_output/...
sldvdemo_cruise_control/sldvdemo_cruise_control_report.html

The HTML report includes the following chapters.

1-13
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Table of Contents

1
2

. Summary

. Analysis Information

. Test Objectives Status

. Model Items

LI Ny L

. Test Cases

For a description of each report chapter, see:

“Summary” on page 1-14

“Analysis Information” on page 1-15
“Test Objectives Status” on page 1-17
“Model Items” on page 1-18

“Test Cases” on page 1-19

Summary. In the Table of Contents, click Summary to display the
Summary chapter, which includes the following information:

Name of the model

Mode of the analysis (test generation, property proving, design error
detection)

Status of the analysis
Length of the analysis in seconds

Number of objectives satisfied
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Chapter 1. Summary

Analysis Information

Model: sldvdemo cruise control
Mode: TestGeneration

Status: Completed normally
Analysis Time: 7s

Objectives Status

Number of Objectives: 34
Objectives Satisfied: 34

Analysis Information. In the Table of Contents, click Analysis
Information to display information about the analyzed model and the
analysis options.

1-15
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Chapter 2. Analysis Information

Table of Contents

Model Information
Analysis Options
Constraints
Approximations

Model Information

File:
Version:
Time Stamp:
Author;

Analysis Options

Mode:

Test Suite Optimization:
Maximum Testcase Steps:
Test Conditions:

Test Objectives:

Model Coverage Objectives:
Maximum Analysis Time:
Block Replacement:
Parameters Analysis:

Parameters Configuration File:

Save Data;
Save Harness:
Save Report:

sldvdemo_cruise control
1.56

Wed Jul 18 10:45:08 2012
The MathWorks Inc.

TestGeneration
CombinedObjectives
500 time steps
UseLocalSettings
UseLocalSettings
MCDC

605

off

on

sldv_params template.m
on

off

off
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Test Objectives Status. In the Table of Contents, click Test Objectives
Status to display a table of satisfied objectives. The following figure shows a
partial list of the objectives satisfied in the Cruise Control Test Generation
model.

Chapter 3. Test Objectives Status

Table of Contents

Obijectives Satisfied

Objectives Satisfied

Simulink Design Verifier found test cases that exercise these test objectives.

# Type Model Item Description Test Case

1 Decision Controller/Switch3 !Ogjcal trigger input false (output is from 3rd 8
input port)

2 Decision Controller/Switch3 }og:tcal trigger input true (output s from 1st 4
input port)

3 Decision Controller/Switch2 10g:tcal trigger input false (output is from 3rd 1
input port)

4 Decision Controller/Switch2 10g1ca1 trigger input true (output is from 1st g
input port)

5 Decision Controller/Switchl ngal trigger input false (output is from 3rd 5
input port)

6 Decision Controller/Switch1 10g:tcal trigger input true (output is from 1st g
input port)

7 Condition Controller/Logical Operatorl Logic: input port 1 T 3

8 Condition Controller/Togical Operatorl Logic: input port 1 F 8

9 Condition Controller/Logical Operator2 Logic: input port 1 T 8

10 Condition Controller/Logical Operator2 Logic: input port 1 F 5

11 Condition Controller/Logical Operator2 Logic: input port 2 T 6

12 Condition Controller/Logical Operator2 Logic: input port 2 F 5

13 MCDC Controller/Logical Operator2 Logic: MCDC expression for output with input 3

port1 T

The Objectives Satisfied table lists the following information for the model:
® # — Objective number
e Type — Objective type

¢ Model Item — Element in the model for which the objective was tested.
Click this link to display the model with this element highlighted.

1-17
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¢ Description — Description of the objective

e Test Case — Test case that achieves the objective. Click this link for more
information about that test case.

In the row for objective 34, click the test case number (7) to display more
information about Test Case 7 in the report’s Test Cases chapter.

Test Case 7

Summary
Length: 0.06 second (7 sample periods)
Objectives 1

Satisfied:

Objectives

Step Time Model Item
7 0.06 Controller/PI Controller/Discrete-Time Integrator

Generated Input Data

0.01-

Time |0 0.08 0.06
Step |1 2-6 7
enable |1 1 1
brake |0 0 0

set 1 0 1
inc 1 1

dec 0 0 -
speed |97 0 0

Objectives
integration result >= upper limit T

In this example, Test Case 7 satisfies one objective, that the integration result
be greater than or equal to the upper limit T in the Discrete-Time Integrator
block. The table lists the values of the six signals from time 0 through time

0.06.

Model Items. In the Table of Contents, click Model Items to see detailed
information about each item in the model that defines coverage objectives.
This table includes the status of the objective at the end of the analysis. Click
the links in the table for detailed information about the satisfied objectives.
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Chapter 4. Model Items

Table of Contents

Controller/Switch3

Controller/Switch2

Controller/Switchl

Controller/Logical Operatorl

Controller/Logical Operator2

Controller/Logical Operator

Controller/PI Controller

Controller/PI Controller/Discrete-Time Integrator

This section presents, for each object in the model defining coverage objectives, the list of objectives and their individual status at the end of the analysis. It
should match the coverage report obtained from running the generated test suite on the model, either from the hamess model or by using the sldvruntests
command.

Controller/Switch3
View
L Test
He Type Description Status Case
logical trigger input
1 Decision false (output is from Satisfied |8
3rd input port)
logical trigger input true
2 Decision (output is from 1st Satisfied |4
input port)
Controller/Switch2
View
N Test
H Type Description Status Case
logical trigger input
3 Decision false (output is from  |Satisfied|1
3rd input port)
logical trigger input true
4 Decision (output is from 1st Satisfied 8
mput port)

Test Cases. In the Table of Contents, click Test Cases to display detailed
information about each generated test case, including:

Length of time to execute the test case

Number of objectives satisfied

Detailed information about the satisfied objectives

Input data

1-19
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For an example, see the section for Test Case 7 in “Test Objectives Status”

on page 1-17.

Create Harness Model

In the Simulink Design Verifier Results Summary window, if you click
Create harness model, the software creates and opens a harness model

named sldvdemo_cruise_control_harness.

Test Case 1

™
L

_____

¥

Inputs

DO

Teaxt

Test Case Explanation

1-20
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IEE]

throt b————

Test Unit {copied from sldvdemo_cruise_control)

The harness model contains the following blocks:

target
target

D)

throt

® The Test Case Explanation block is a DocBlock block that documents the
generated test cases. Double-click the Test Case Explanation block to view
a description of each test case for the objectives that the test case satisfies.
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_T Editer - St\sca_sldvisldvdemo_cruise_contrel_hamess_testcases.bd

EDITOR coserclearal (Al |5 4 B [@ 9 @

Hl:llj ﬁ E EFlndF\le& Insert fx o ¢ X

| Compare ~  Comment GoTo =
Mew Open Save ] 2 e L EH] Breakpoints.
- - > FAPint - Indent (4 Find =~ -
FILE EDIT NAVIGATE BREAKPOINTS

[ sldvdemo_cruise_control_harness_testc.. ® ]

1 Test Case 1 (1 Cbjectives)

»

2 Parameter walues:

3

4 1. Controller/Switch2 - logical trigger input false (output is from 3rd input port) @ T=0.00

L

[ Test Case 2 (3 Objectives)

7 Parameter walues:

g

k] 1. Controller/Logical Cperator - Logic: input port 1 F @ T=0.00

10 2. Controller/Logical Operator - Logic: MCDC expression for output with input port 1 F @ T=0.00
11 3. Controller/PI Controller - enable logical walue F @ T=0.00

13 Test Case 3 (3 Cbjectives)

14 Parameter values:

15 L
16 1. Controller/Logical Operatorl - Logic: input port 1 T @ T=0.00 3
17 2. Controller/Logical Operator - Logic: input port 2 F @ T=0.00

18 3. Controller/Logical Operator - Logic: MCDC expression for output with input port 2 F @ T=0.00

2 Test Case 4 (1 Cbjectives)
Parameter values:

iy

1. Controller/Switch3 - logical trigger input true (output is from 1=t input port) @ T=0.00

Test Case 5 (7 Cbjectives)
Parameter values:

LRI RRI ORI ORI ORI R R RS
[ =R R = R S R N

1. Controller/Switchl - logical trigger input false (output i=s from 3rd input port) @ T=0.00
2. Controller/Logical Operator2 - Logic: input port 1 F @ T=0.00 R
3. Controller/Logical Operator2 - Logic: input port 2 F @ T=0.00
31 4. Controller/Logical Operator2 - Logic: MCDC expression for cutput with input port 1 F @ T=0.00
32 5. Controller/Logical Operator2 - Logic: MCDC expression for output with input port 2 F @ T=0.00
33 6. Controller/Logical Operator - Logic: input port 3 F @ T=0.00
34 7. Controller/Logical Operator - Logic: MCDC expression for output withl input port 3 F @ T=0.00
35
36 Test Case & (2 Cbjectives)
37 Parameter wvalues:
38
39 1. Controller/Logical Cperator2 - Logic: input port 2 T @ T=0.01
40 2. Controller/Logical Operator2 - Logic: MCDC expression for ocutput with input port 2 T @ T=0.01
41
42 Test Case 7 (1 Cbjectives)
43 Parameter walues:
a4 ol
Click and drag to move the document bar... plain text file Ln 25 Col 27 OVR

® The Test Unit block is a Subsystem block that contains a copy of the
original model that the software analyzed. Double-click the Test Unit block
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to view its contents and confirm that it is a copy of the Cruise Control
Test Generation model.

Note You can configure the harness model to reference the model that you
are analyzing using a Model block instead of using a subsystem. In the
Configuration Parameters dialog box, on the Design Verifier > Results
pane, select Save test harness as model and Reference input model
in generated harness.

® The Inputs block is a Signal Builder block that contains the generated
test case signals. Double-click the Inputs block to open the Signal Builder
dialog box and view the eight test case signals.

® The Size-Type block is a subsystem that transmits signals from the Inputs
block to the Test Unit block. This block verifies that the size and data type
of the signals are consistent with the Test Unit block.

The Signal Builder dialog box contains eight test cases.

1 To view Test Case 7, from the Active Group list, select Test Case 7.

In Test Case 7 at 0.01 seconds:

The enable and inc signals remain 1.

The brake and dec signals remain 0.

The set signal transitions from 1 to O.

The speed signal transitions from 100 to 0.

1-22
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n Signal Builder (sldvdemo_cruise_control_harness/Inputs) * EI@

File Edit Group Signal Axes Help N

= = R == o o [~ FJE) &R EE oo | Pl B

Active Group: | Test Case 7 v: @'

A TTTTTTTTmmt CooTTTren N N L oTTTTTTT e “.
enable i : : : ; i I
1 b ; ; ; ; A4 Y
"? | | | | | | |
brake
1 | | | | | | i
............... L ——
set H . . . :
R R R pomTemmemeenes peomtomeomeses R Y 3
] a a a R U ]
1 - ' : : : — - E
inc : . . . . .
L e pommrnnennes pornememeenes R R 3
[ SESSSEN. I S S ; i i
U|_ : E E E
N | i i i
10 o A e R RS EEEEE LR e R R EEEEEEEEEEEE.-
spee H . .
L e oo porremmmoees :
1] S : : :
i 0.0 0.02 0.03
Time (sec)
Lefi Point Right Point
brake {shown)
Hame: |enable T: T: set {shown)
. inc {shown)
Index: 1 - e f- dec {shown)
' speed {shown) -
Click to select point or segment, Shift+click to add points enable (#1) [YMin ¥YMax ]

In the Signal Builder block, the signal group satisfies the test objectives
described in the Test Case Explanation block.

2 To confirm that the Simulink Design Verifier software achieved complete
model coverage, simulate the harness model using all the test cases. In
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Summary

the Signal Builder dialog box, click the Run all and produce coverage

all
button ﬂ

The Simulink software simulates all the test cases. The Simulink
Verification and Validation software collects coverage data for the harness
model and displays a coverage report. The report summary shows that the
sldvdemo_cruise_control_harness model achieves 100% coverage.

Model Hierarchy/Complexity:

D1 Cl MCDC
1. sldvdemo_cruise_control _harness 8 100% s 100% o 100%
2. ... Test Unit (copied from sldvdemo cruise control) 7 100% s 100% s 100% —
£ I Controller 7 100% e 100% —100% —
4 . PI Controller 4 100% o— NA NA

1-24

Simulate Tests and Produce Model Coverage Report

In the Simulink Design Verifier Results Summary window, if you

click Simulate tests and produce a model coverage report, the
software simulates the model and produces a coverage report for the
sldvdemo_cruise_control model. The software stores the report with the
following name:

<current_folder>/sldv_output/sldvdemo_cruise_control/...
sldvdemo_cruise_control_report.html

When you click Run all and produce coverage to simulate tests in the
harness model, you may see the following differences between this coverage
report and the report you generated for the model itself:

® The harness model coverage report might contain additional time steps.
When you collect coverage for the harness model, the model stop time
equals the stop time for the longest test case. As a result, you might achieve
additional coverage when you simulate the shorter test cases.
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® The cyclomatic complexity coverage for the Test Unit subsystem in the
harness model might be different than the coverage for the model itself due
to the structure of the harness model.

Combine Test Cases

If you prefer to review results that are combined into a smaller number of test
cases, set the Test suite optimization parameter to LongTestcases. When
you use the LongTestcases optimization, the analysis generates fewer, but
longer, test cases that each satisfy multiple test objectives. This optimization
creates a more efficient analysis and results that are easier to review.

Open the sldvdemo_cruise_control model and rerun the analysis with the
LongTestcases optimization:

1 Select Analysis > Design Verifier > Options.

2 In the Configuration Parameters dialog box, in the Select tree on the left
side, under the Design Verifier category, select Test Generation.

3 Set the Test suite optimization parameter to LongTestcases.
4 Click Apply and OK to close the Configuration Parameters dialog box.

5 In the sldvdemo_cruise_control model, double-click the block labeled
Run.

6 In the Results Summary window, click Create harness model.

In the harness model, the Signal Builder block and the Test Case
Explanation block now contain one longer test case instead of the eight
shorter test cases created earlier in “Generate Test Cases” on page 1-7.
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_T Editor - S\sca_sldvisldvdemo_cruise_control_hamess_testcase_long bt

EDITOR mﬂ@ﬁé E@@

I{:j ™~ E (5] Find Files Insert . f% 5 =

Compare ~  Comment = - o GoTo +

Mew Open Save — Breakpoints
v v v~ [FSPint - Indent |- | &g |5k 4 Find -
FILE EDIT NAVIGATE BREAKPOINTS
[;\dvdemo_crulse_contro\_hamess_testc‘.‘ X]
1 Test Case 1 (34 Objectives)
2 Parameter wvalues:
3
4 1. Controller/Switch3 - logical trigger input false (output is from 3rd input port) @ T=0.00
5 2. Controller/Switch3 - logical trigger input true (output is from 1st input port) @ T=0.02
[ 3. Controller/SwitchZ - logical trigger input false (output is from 3rd input port) @ T=0.03
7 4, Controller/Switch2 - logical trigger inmput true (output is from lst input port) @ T=0.00
8 5. Controller/Switchl - logical trigger input false (output is from 3rd input port) @ T=0.04
g 6. Controller/Switchl - logical trigger input true (output is from lst input port) @ T=0.00
10 7. Controller/Logical Operatorl - Logic: input port 1 T @ T=0.02
11 8. Controller/Logical Operatorl - Logic: input port 1 F @ T=0.00
2 9. Controller/Logical Operator2 - Logic: input port 1 T @ T=0.00
13 10. Controller/Logical Operator2 - Logic: input port 1 F @ T=0.04
14 11. Controller/Logical Operator2 - Logic: input port 2 T @ T=0.07
15 12. Controller/Logical Operator2 - Logic: input port 2 F @ T=0.04
16 13. Controller/Logical Cperator2 - Logic: MCDC expression for output with input port 1 T @ T=0.00
17 14. Controller/Logical Cperator2 - Logic: MCDC expression for output with input port 2 T @ T=0.07
8 15. Controller/Logical Operator2 - Logic: MCDC expression for output with input port 1 F @ T=0.04
13 16. Controller/Logical Operator? - Logic: MCDC expression for output with input port 2 F @ T=0.04
20 17. Controller/Logical Operator - Logic: input port 1 T @ .00
21 18. Controller/Logical Cperator - Logic: input port 1 F @ .01
22 19. Controller/Logical Cperator - Logic: input port 2 T @ .00
23 20. Controller/Logical Operator - Logic: input port 2 F @ .02
24 21. Controller/Logical Operator - Logic: input port 3 T @ .00
25 22. Controller/Logical Operator - Logic: input port 3 F @ .05
26 23. Controller/Logical Cperator - Logic: MCDC expression for output with input port 1 T € T=0.00
27 24. Controller/Logical Operator - Logic: MCDC expression for ocutput with input port 2 T @ T=0.00
28 25. Controller/Logical Operator - Logic: MCDC expression for cutput with input port 3 T @ T=0.00
29 26. Controller/Logical Operator - Logic: MCDC expression for output with input port 1 F @ T=0.01
30 27. Controller/Logical Operator - Logic: MCDC expression for output with input port 2 F § T=0.02
31 28. Controller/Logical Cperator - Logic: MCDC expression for output with input port 3 F € T=0.05
2 29. Controller/PI Controller - enable logical value F @ T=0.01
33 30. Controller/PI Controller - enable logical value T @ T=0.00
34 31. Conctroller/PI Controller/Discrete-Time Integrator - integration result <= lower limit F @ 0.00
35 32. Controller/PI Controller/Discrete-Time Integrator - integration result <= lower limit T @ T=0.14
36 33. Controller/PI Controller/Discrete-Time Integrator - integration resumlt >= upper limit F @ T=0.00
37 34. Controller/PI Controller/Discrete-Time Integrator - integration result >= upper limit T @ T=0.26
plain text file Ln 1 Col 1 OVR

7 Click Run all and produce coverage to collect coverage.

The analysis still satisfies all 34 objectives.
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Analyze a Subsystem

In addition to analyzing a model, you can analyze a subsystem within a
model. This technique is good for large models, where you want to review the
analysis in smaller, manageable reports.

This example analyzes the Controller subsystem in the
sldvdemo_cruise_control model.

1 Open the example model:

sldvdemo_cruise_control

2 Right-click the Controller subsystem, and select Design Verifier > Enable
‘Treat as Atomic Unit’ to Analyze.

The Function Block Parameters dialog box for the Controller subsystem
opens.

3 Select Treat as atomic unit.

An atomic subsystem executes as a unit relative to the parent model;
subsystem block execution does not interleave with parent block execution.
You can extract atomic subsystems for use as standalone models.

You must set the Treat as atomic unit parameter to analyze a subsystem
with the Simulink Design Verifier software.

After you set the parameter, other parameters become available, but you
can ignore them.

4 Click OK to close the dialog box.

5 Select File > Save As and save the Cruise Control Test Generation model
under a new name.

6 To start the subsystem analysis and generate test cases, right-click the

Controller subsystem, and select Design Verifier > Generate Tests for
Subsystem.
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7 The Simulink Design Verifier software analyzes the subsystem. When the
analysis 1s complete, view the analysis results for the Controller subsystem
by clicking one of the following options:

e Highlight analysis results on model
* Generate detailed analysis report
¢ Create harness model

¢ Simulate tests and produce a model coverage report

8 Review the results of the subsystem analysis and compare them to the
results of the full-model analysis described in “Analyze a Model” on page
1-5:

® The subsystem analysis analyzes the Controller as a standalone model.

® The Controller subsystem contains all the test objectives in the Cruise
Control Test Generation model, so both analyses generate the same
test cases.
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Analyze a Stateflow Atomic Subchart

In a Stateflow chart, an atomic subchart is a graphical object that allows you
to reuse the same state or subchart across multiple charts and models. You
can use the Simulink Design Verifier software to analyze atomic subcharts
individually. You do not have to analyze the chart that contains the atomic
subchart, or the model that contains the chart.

If you are having problems analyzing a large model, analyzing an atomic
subchart in a controlled environment is helpful. As described in “Bottom-Up
Approach to Model Analysis” on page 14-16, by analyzing atomic subcharts
or other components in the model hierarchy individually, you can analyze a
model to:

® Solve problems that slow down or prevent test generation, property
proving, or design error detection.

® Analyze model components that are unreachable in the context of the
container model or chart.

Note For more information about atomic subcharts, see “What Is an Atomic
Subchart?” in the Stateflow documentation.

Analyze an Atomic Subchart Using the Simulink
Design Verifier Software

The sf_atomic_sensor_pair example model models a redundant sensor
pair using atomic subcharts. This example analyzes the Sensor1 subchart in
the RedundantSensors chart.

1 Open the sf_atomic_sensor_pair example model:

sf_atomic_sensor_pair

This model demonstrates how to model a simple redundant sensor pair
using atomic subcharts.

2 Double-click the RedundantSensors chart to open it.
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ink Sensor

[Sensor.inFailed()]

ink Sensor?

[SensorZ.inF ailed()]

o

This Stateflow chart has two atomic subcharts:
® Sensori

® Sensor2

To analyze the Sensor1 subchart using the Simulink Design Verifier
software, right-click the subchart and select Design Verifier > Generate
Tests for Subchart.

During the analysis, the software creates a Simulink model named Sensor1
that contains the Sensor1 subchart. The new model contains Inport and
Outport blocks that respectively correspond to the data objects u and y

in the subchart.
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) B In 1 Ot 1)

Sensori

The software saves the new model and other files generated by the analysis
in:

<current_folder>/sldv_output/Sensori
4 When the analysis is complete, view the analysis results for the Sensor1
subchart by clicking one of the following options:
¢ Highlight analysis results on model
¢ Generate detailed analysis report
* Create harness model

¢ Simulate tests and produce a model coverage report
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Basic Workflow for Simulink Design Verifier

The basic workflow for analyzing your model is described in the following
steps, with links to related documentation.

Step | Action See...
1 Check the compatibility of your model. “Check Model Compatibility” on page 3-2
2 If you want to work around compatibility | ® “What Is Block Replacement?” on page 4-2
Ll oo iy ioslel or I ELA: e “Parameters as Variables in Simulink®
model elements for analysis, you Design Verifier™ Analysis” on page 5-2
can use Simulink Design Verifier g Y pag
block replacement rules. If you want
to generate additional values for
parameters in your model during
analysis, use Simulink Design Verifier
parameter configurations.
3 Set Simulink Design Verifier options. “Simulink® Design Verifier™ Configuration
Parameters” on page 15-2
4 If you plan to generate test cases or prove | ® “What Is Design Error Detection?” on
properties in your model, first run design page 6-2
error detection for integer overflow and e “Detect Integer Overflow and
division by zero. . ”
Division-by-Zero Errors” on page
6-23
5 Analyze your model to: ¢ “Run a Design Error Detection Analysis”
on page 6-5
R .
Wit closign eaiums o “Workflow for Test Case Generation” on
® Generate test cases page 7-4
® Prove properties o “Workflow for Proving Model Properties”
on page 12-4
6 Generate the results. “Generate Analysis Results” on page 1-9
7 Interpret the results. “Results Interpretation and Use”




Learning More

Learning More

In this section...

“Next Steps” on page 1-33

“MathWorks Online” on page 1-34

Next Steps

To begin learning how to use the Simulink Design Verifier software, see
“Analyze a Subsystem” on page 1-27. Also see the following topics to continue
your exploration of the software:

To...

See...

Detect design errors

“Run a Design Error Detection Analysis” on
page 6-5

Generate test cases

e “Generate Test Cases for Model Decision
Coverage” on page 7-5

® “Generate Test Cases for a Subsystem”
on page 7-23

Prove properties

® “Prove Properties in a Model” on page
12-5

® “Prove Properties in a Subsystem” on
page 12-31

Extend existing test cases
for a model

“Extend Test Cases for Model with Temporal
Logic” on page 8-5

“Extend Test Cases for Closed-Loop System”
on page 8-13

“Extend Test Cases for Modified Model” on
page 8-20
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To... See...
Generate test cases for “Achieve Missing Coverage in Referenced
missing coverage Model” on page 9-3

“Achieve Missing Coverage in Closed-Loop
Simulation Model” on page 9-9

Verify individual “Verify a Component for Code Generation”
components in a model on page 10-6

MathWorks Online

For addition information and support, go to the MathWorks® Web site:

http://www.mathworks.com/products/sldesignverifier/
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How the Simulink Design
Verifier Software Works

® “Analyze a Simple Model” on page 2-2

e “Model Blocks” on page 2-4

e “Block Reduction” on page 2-5

e “Inline Parameters” on page 2-6

* “Large Models” on page 2-7

e “Handle Incompatibilities with Automatic Stubbing” on page 2-8
e “Nonfinite Data” on page 2-15

® “Approximations” on page 2-16

® “Logic Operations Short-Circuiting” on page 2-19
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Analyze a Simple Model

This simple Simulink model includes two Logical Operator blocks and a
Memory block.

Logical aut
|- =
D " scoR [ ] Operstar
in g v
Logical Memony
Cperator

The persistent information in this model is limited to the Boolean value of
the Memory block. The input to the model is a single Boolean value. The
following table describes the complete behavior of the model, including the
behavior that would result from an arbitrarily long sequence of inputs.

# | Input Memory Output of XOR Output of AND
Value Block = Next Block
Memory Value
1 false false false false
2 true false true false
3 false true true false
4 true true false true

Suppose you want to generate test cases that result in a true output; this goal
1s your test objective. If you run the Simulink Design Verifier software to
generate test cases that result in a true output, the software searches this
table to see if such a scenario is possible.

After the Simulink Design Verifier software discovers a configuration that
satisfies the test objective (in this case, when both the input and the Memory
block output are true), it needs to find a path to reach this configuration from



Analyze a Simple Model

the initial conditions. If the initial memory value is true, the test case only
needs to be a single time step (row 4) where the input was true.

If the initial memory value is false (the default), the test case must force the
memory value to be true. In this example, the path requires two steps:

1 The input value is true and the memory value is false (row 2). Thus, the
output of the XOR block is true, making the memory value true.

2 Now that the input value and memory value are both true (row 4), the
output is true, so the analysis achieves the specified test objective.

An infinite number of test cases can cause the output to be true, and
regardless of the state value, the output can be held false for an arbitrary time
before making it true. When the Simulink Design Verifier software searches,
it returns the first test case it encounters that satisfies the objective. This
case is invariably the simulation with the fewest time steps. Sometimes you
may find this result undesirable because it is unrealistic or does not satisfy
some other test requirement.

The same basic principles from this example apply to property proving

and test case generation. During test case generation, option parameters
explicitly specify the search criteria. For example, you can specify that the
Simulink Design Verifier software find paths for all block outputs or find only
those paths that cause the block output to be true.

During a property proving analysis, you specify a functional requirement, or
property, that you want the Simulink Design Verifier software to prove, for
example, that the output is always true. If the search completes without
finding a path that violates the property, the property is proven. If the
software finds a path where the output is false, it creates a counterexample
that causes the output to be false.

During an error detection analysis, the Simulink Design Verifier software
identifies objectives where data overflow or division-by-zero errors can and
cannot occur. The analysis creates test cases that demonstrate how the
errors can occur.
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Model Blocks

If your model contains Model blocks that reference external models, the
Simulink Design Verifier software creates test cases for the top-level model,
considering each referenced model in its execution context.

If you have multiple Model blocks that reference the same model, the software
analyzes each instance of the referenced model in the context from which it is
referenced. The software attempts to satisfy test objectives for each instance
within its execution context in the top-level model. If you have three Model
blocks that reference a certain model, the analysis produces results for all
three instances.

If you simulate the model using the test cases that the analysis generates, and
collect coverage, the Simulink Verification and Validation software combines
the coverage data for multiple instances of the same referenced model. The
simulation produces one set of coverage results for each referenced model; if
you have three Model blocks that reference a certain model, the simulation
produces one set of results for that referenced model.

For example, suppose you have three Model blocks that reference the same
model. Suppose also that referenced model has three test objectives. When
you run a Simulink Design Verifier analysis for the top-level model, the total
number of test objectives for the three Model blocks is nine. If you then
simulate the model with the test cases generated by the analysis, the coverage
results for that referenced model specify three test objectives.



Block Reduction

Block Reduction

Block reduction is a Simulink feature that lets you achieve faster execution
during model simulation and in generated code. When block reduction is
enabled, the Simulink software collapses certain groups of blocks into a
single, more efficient block, or removes them entirely.

When the Simulink Design Verifier software translates a model, block
reduction happens automatically, and blocks in unused code paths are
eliminated from the model. The Simulink Design Verifier results do not
include test objectives for blocks that have been reduced.

Consider the Switch block in the following model.

St

Switch

For this Switch block, the control input is always 0. If the Criteria for
passing first input block parameter is u2 ~= 0, the Switch block always
passes the third input through to the output port. When you analyze this
model, the Simulink Design Verifier software removes the Switch block from
the model and does not report any test objectives for the Switch block.

For more information about block reduction, see the description of the “Block
reduction” parameter.
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Inline Parameters

The Inline parameters parameter is a Simulink optimization that
transforms tunable parameters into constant values. For example, suppose
you have a Gain block whose Gain parameter is a, where a is defined in
the model workspace. During simulation, Simulink converts that Gain
parameter to a constant value, as defined in the workspace.

When the Simulink Design Verifier software translates a model, it transforms
all tunable parameters in the model into constant values, even if the Inline
parameters option is off.

To tune parameters for an analysis, define parameter values in a
parameter configuration file and specify that file in the Configuration
Parameters > Design Verifier > Parameters pane to apply those
parameter values during the analysis. For example, to constrain the values
of a Gain parameter a to integer values from 4 to 10, in the parameter
configuration file, specify the following:

params.a = int8([4 10]);

The analysis generates the specified values and returns results for those
values.

For detailed information about how to specify parameters during a Simulink
Design Verifier analysis, see “Define Parameters as Variables” on page 5-3.



Large Models

Large Models

In larger, more complicated models, the Simulink Design Verifier software
uses mathematical techniques to simplify the analysis:
¢ [t identifies portions of the model that do not affect the desired objectives.

¢ [t discovers relationships within the model that reduce the complexity of
the search.

¢ [t reuses intermediate results from one objective to another.

In this way, the problem is reduced to a search though the logical values that
describe your model.

For detailed information about analyzing large models, see “Analyze a Large
Model” on page 14-3.
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Handle Incompatibilities with Automatic Stubbing

In this section...

“What Is Automatic Stubbing?” on page 2-8

“How Automatic Stubbing Works” on page 2-8
“Analyze a Model Using Automatic Stubbing” on page 2-10

What Is Automatic Stubbing?

Automatic stubbing lets you analyze a model that contains objects that the
Simulink Design Verifier software does not support.

When you enable the automatic stubbing option (it is enabled by default), the
software considers only the interface of the unsupported objects, not their
actual behavior. This technique allows the software to complete the analysis.
However, the analysis may achieve only partial results if any unsupported
model element affects the simulation outcome.

How Automatic Stubbing Works

If you enable automatic stubbing, when the Simulink Design Verifier analysis
comes to an unsupported block, the software “stubs” that block. The analysis
ignores the behavior of the block, and as a result, the block output can take
any value.

Stub Trigonometric Function Block

The Simulink Design Verifier software does not support Trigonometric
Function blocks when the Function parameter is set to acos, such as the
one in the following graphic.

[

BCOS Scope

D

Il

Y

— BCOS -
n_signal ort_signal
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When stubbing this block during analysis, out_signal can take any value,
with the following results.

Analysis Model Result of Stubbing out_signal

Design error detection | ® If a design-error objective that depends on
out_signal is proven valid, that objective

is valid for all simulations. In this case, the
stubbing did not affect the results of the analysis.

e [f a design-error objective that depends on
out_signal is falsified, the analysis cannot
create a test case. The analysis cannot determine
which input to the stubbed block produces the
output that falsifies the objective.

Test case generation | ® If a test objective that depends on the value of
out_signal is satisfied, the analysis cannot
create a test case. The analysis cannot determine
which input to the stubbed block produces the
output that satisfies the objective.

e If a test objective that depends on the value
of out_signal is unsatisfiable, there is no
simulation that can satisfy that objective. In this
case, the stubbing did not affect the results of
the analysis.

Property proving e [f a proof objective that depends on out_signal
1s proven valid, that objective is valid for all
simulations. In this case, the stubbing did not
affect the results of the analysis.

e [f a proof objective that depends on out_signal
is falsified, the analysis cannot create a
counterexample. The analysis cannot determine
which input to the stubbed block produces the
output that falsifies the objective.

Stub S-Function Block Containing Function-Call Triggers

The Simulink example model sfcndemo_sfun_fcncall has an S-Function
block. The S-function sfun_fcncall triggers the execution of the function-call
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subsystems f1 subsysl and f2 subsys2 on the first and second elements of
the first output port.

[

Constant + 4
Sum sfun_feneall i
1
- |u Demuei Ot B 1)
z Function call Ot
Linit Delay S-Functicn — 1 subsys 1 St
£
ot ]
f2 subsys2

Scope

matlabrootitoolbox'simulink'simdemes'simfeatures\srcisfun_foneall.c .

The Simulink Design Verifier software does not support the S-Function
block, so if automatic stubbing is enabled, the analysis ignores the behavior
of the S-function. As a result, the code that triggers the two function-call
subsystems is ignored, resulting in two unsatisfiable objectives. Since the
function calls are ignored, the contents of those subsystems are effectively
eliminated from the analysis.

Analyze a Model Using Automatic Stubbing

This section describes a workflow for using automatic stubbing, with a simple
Simulink model as an example.

¢ “Check Model Compatibility” on page 2-11
¢ “Turn On Automatic Stubbing” on page 2-13
¢ “Review Results” on page 2-14

e “Achieve Complete Results” on page 2-14
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The following model contains a Discrete State-Space block, which is not
compatible with the Simulink Design Verifier software.

sorcronout) JoF "D

#(n+1=Ax{n+Bu{n}
In1

Dscrete State-Space Saturaticn

Check Model Compatibility

From the Simulink Editor, there are two ways to check whether a model is
compatible with the Simulink Design Verifier software:

¢ Run the Simulink Design Verifier compatibility check by selecting
Analysis > Design Verifier > Check Compatibility > Model.
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Simulink Design Verifier Results Summany: ex_auto_stubbing_ho... @

08-Jul-2013 13:52:45

Checking compatibility of model
'ex_auto_stubbing_how_sldv_works'
Compiling model... done

Checking compatibility... done
'ex_auto_stubbing_how_sldv_works' is
with Simulink Design Verifier.

The model can be analyzed by Simulink Design Verifier.
It contains unsupported elements that will be stubbed
out during analysis. The results of the analysis might
be incomplete.

Save Log J l Close

e Select the analysis that you want:
= Analysis > Design Verifier > Detect Design Errors > Model
= Analysis > Design Verifier > Generate Tests > Model
= Analysis > Design Verifier > Prove Properties > Model

The software first checks the compatibility of the model. If the model itself
is incompatible, for example, if it uses a variable-step solver, the analysis
cannot continue.

If it finds incompatible elements in the model, the software analyzes
the model and, by default, stubs out the incompatible elements. The
Simulation Diagnostics Viewer also opens, listing the incompatibilities.
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- o)

a Simulink Design Verifier Errors: ex_auto_stubbing E'@

View Font Size

Message Source Reported By Summary
& Design Verifier compatibility warning ex_auto_stubbing sldv Simulink Design Verifier has only
2 Design Verifier compatibility warning Discrete State-Space  sldv Elock ‘ex_auto_stubbing/Discrete

1| n [ b

@ ex_auto_stubbing/Discrete State-Space

Block 'ex_auto stubbing Discrete State-Space’ is of type DiscreteStateSpace, Simulink Design Verifier does not
support blocks of this type,

Open ] [ Help ] [ Close

Note For more information, see “Simulation Diagnostics Viewer” in the
Simulink documentation.

Turn On Automatic Stubbing

Automatic stubbing is enabled by default. To change the automatic stubbing
setting, in the Configuration Parameters dialog box, on the main Design
Verifier pane, select Automatic stubbing of unsupported block and
functions. When you run the analysis, the software tells you that stubbing is
turned on and the analysis continues.
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Review Results

If you run an analysis with automatic stubbing enabled, make sure to review
the results. In this report, generated after a test case generation analysis, you

see a table of unsupported blocks that the software encountered.

Unsupported Blocks

The following blocks are not supported by Simulink Design Verifier. They were abstracted during the
analysis. This can lead Simulink Design Verifier to produce only partial results for parts of the model that

depends on the output values of these blocks.

Block Type
Discrete State-Space DiscreteStateSpace

The generated analysis report for the example model shows that the objectives
are undecided because of stubbing. The software cannot generate test cases
because it does not understand the operation of the Discrete State-Space block.

Objectives Undecided Due to Stubbing

Simulink Design Verifier was not able to decide these objectives due to stubbing.

# Type Model Item Description

2 Decision Saturation input > lower limit F

3 Decision Saturation input > lower limit T
14 Decision Saturation input >= upper limit F
5 Decision Saturation input >= upper limit T

Achieve Complete Results

Analysis Time
(sec)

12

12

12

12

If your analysis does not achieve complete results because of the
stubbing, you can define custom block replacements to give a more
precise definition of the unsupported blocks. For more information, see
“Define Custom Block Replacements” on page 4-8 or enter echodemo
sldvdemo_blockreplacement _unsupportedblocks at the MATLAB
command line to step through the Block Replacements for Unsupported

Blocks example.
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Nonfinite Data

The Simulink Design Verifier software does not support nonfinite data (for
example, NaN and Inf) and related operations.

During an analysis, the software handles nonfinite operations as follows:

¢ In the Relational Operator block:

= If the Relational operator parameter is isFinite, the output is
always 1.

= If the Relational operator parameter is isNan or isInf, the output
is always 0.

¢ In the MATLAB Function block:
= For the isFinite function, the output is always 1.

= For the isNan and isInf functions, the output is always 0.
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Approximations

In this section...

“Approximations During Model Analysis” on page 2-16
“Types of Approximations” on page 2-16
“Floating-Point to Rational Number Conversion” on page 2-17

“Linearization of Two-Dimensional Lookup Tables” on page 2-17

“While Loops” on page 2-18

Approximations During Model Analysis

The Simulink Design Verifier software attempts to generate inputs and
parameters to achieve objectives. However, there could be an infinite number
of values for the software to search. To create reasonable limits on the
analysis, the software performs approximations to simplify the analysis. The
software records any approximations it performed in the Analysis Information
chapter of the Simulink Design Verifier HTML report. For a description of
this chapter, see “Analysis Information Chapter” on page 13-30.

Review the analysis results carefully when the software uses approximations.
Evaluate your model to identify which blocks or subsystems caused the
software to perform the approximations.

Rarely, an approximation can result in test cases that fail to achieve test
objectives or demonstrate a design error, or counterexamples that fail to
falsify proof objectives. For example, suppose the software generates a test
case signal that should achieve an objective by exceeding a threshold; a
floating-point round-off error might prevent that signal from attaining the
threshold value.

Types of Approximations

The Simulink Design Verifier software performs three types of approximations
when it analyzes a model:

* “Floating-Point to Rational Number Conversion” on page 2-17
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® “Linearization of Two-Dimensional Lookup Tables” on page 2-17

® “While Loops” on page 2-18

Floating-Point to Rational Number Conversion

The Simulink Design Verifier software simplifies the linear arithmetic of
floating-point numbers by approximating them with infinite-precision rational
numbers. The software discovers how the logical relationships between these
values affects the objectives. This analysis enables the software to support
supervisory logic that is commonly found in embedded controls designs.

If your model contains floating-point values in the signals, input values, or
block parameters, the Simulink Design Verifier software converts those
values to rational numbers before performing its analysis.

Note As a result of these approximations, Simulink Design Verifier software
does not consider the effect of round-off error, or the upper and lower bounds
of floating-point numbers.

Linearization of Two-Dimensional Lookup Tables

The Simulink Design Verifier software does not support nonlinear arithmetic.
If your model contains any 2-D Lookup Table blocks, or n-D Lookup

Table blocks where n = 2, with all of the following characteristics, the
software approximates nonlinear two-dimensional interpolation with linear
interpolation by fitting planes to each interpolation interval.

Block Characteristics
n-D Lookup Table ¢ Interpolation method parameter is Linear.
block, n = 2:

¢ Extrapolation method parameter is C1ip or
Linear.

® The input and output signals both have the
floating-point data type.
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While Loops

If your model or a Stateflow chart in your model contains a while loop,
Simulink Design Verifier tries to detect a conservative constant bound that
allows the while loop to exit. If the software cannot find a constant bound, it
performs a while loop approximation. With this approximation, the analysis
does not prove objectives to be valid or unsatisfiable and it does not prove
dead logic. The generated analysis report notes this approximation.

The behavior of the while loop approximation is consistent in all modes of
analysis, as described in the following table.

Analysis Mode While Loop Approximation

Design Error Detection Sets number of while loop iterations
to 3. Does not report dead logic or
valid objectives.

Test Case Generation Sets number of while loop iterations
to 3. Does not report unsatisfiable
objectives.

Property Proving Sets number of while loop iterations

to 3. Does not report valid objectives.




Logic Operations Short-Circuiting

Logic Operations Short-Circuiting

When the Simulink Design Verifier software performs an analysis, if possible,
the software short-circuits logic blocks. When the previous inputs alone
determine the block output, the analysis ignores any remaining block inputs.
For example, if the first input to a Logical Operator block whose Operator
parameter specifies AND is false, the analysis ignores the values of the other
inputs.

Consider the following example model, with the Model coverage objectives
parameter set to Condition Decision.

2z »|  AND —p@
In2 out1
-
Legical
Crperator

When the Simulink Design Verifier software analyzes this model for Condition
Decision coverage, the analysis can only satisfy five of six objectives for the
Logical Operator block inputs. The software cannot generate a test case when
the third input to the Logical Operator block is false. If the second input is
false, the third input is false, but the software ignores the third input due to
the short-circuiting. If the second input is true, the third input is never false.
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Ensuring Compatibility
with the Simulink Design
Verifier Software

® “Check Model Compatibility” on page 3-2

¢ “Simulink Block Support” on page 3-8

® “Support Limitations for Simulink Software Features” on page 3-20
e “Support Limitations for Model Blocks” on page 3-23

e “Support Limitations for Stateflow Software Features” on page 3-25

e “Support Limitations for MATLAB for Code Generation” on page 3-29
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Check Model Compatibility

The Simulink Design Verifier software analyzes Simulink models in order to:

¢ Detect design errors that may occur at runtime
® Generate test cases that achieve model coverage

® Prove properties and identify property violations
For these analyses, the models must:

e Compile into an executable form
® Be compatible with code generation
e Perform a zero-second simulation with no errors, where the simulation

start time and stop time are both 0.

The software supports a broad range of Simulink and Stateflow software
features in your models. However, there are features that the product
does not support, as described in the following sections. Avoid using these
particular features in models that you plan to analyze with the Simulink
Design Verifier software.

The software automatically checks the compatibility of your model before
it begins an analysis.

In addition, you can run a compatibility check before you start the
analysis. To run this check, in the model window, select Analysis > Design
Verifier > Check Compatibility > Model.

Alternatively, you can use the sldvcompat function to run the compatibility
checker programmatically at the command line or in a MATLAB program.
For more information, see the sldvcompat reference page.

There are three outcomes of a compatibility check:

¢ “Model Is Compatible” on page 3-3
e “Model Is Incompatible” on page 3-3
e “Model is Partially Compatible” on page 3-6
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Model Is Compatible

In the log window, you see if your model is compatible with the software.

- "

Simulink Design Verifier log: sldvderne_cruise_control @

11-May-2012 16:40:36

Checking compatibility of model 'sldvdemo_cruise_control’
Compiling model... done

Checking compatibility... done

'sldvdemo_cruise_control' is compatible with Simulink Design
Verifier.

Sawve Log | | Close

Model Is Incompatible

If the model itself is incompatible with the software, you see two dialog boxes:

¢ Simulink Design Verifier log
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P "

Simulink Design Verifier log: sldemo_fuelsys @

11-May-2012 16:42:13

Preprocessing model... done

Checking compatibility of model 'sldemo_fuelsys'
'sldemo_fuelsys_replacementd' is incompatible with Simulink
Design Verifier.

Save Log ] [ Close

¢ Simulation Diagnostics Viewer. Use the information in this dialog box to
identify and fix the incompatibility.

= If your model uses a variable-step solver, configure the solver options
to a fixed-step.
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€ simulink Design Verifier Errors: sldermo_fuelsys

View Font Size

[o & e

Message Source

Reported By Summary

& Design Verifier compatibility error  sldemo_fuelsys  simulink

Simulink Design Verifier cannot be ...

- ] Design Verifier compatibility error  sldemo_fuelsys simulink

Simulink Design Verifier failed to ini...

@ sldemo_fuelsys

simulink Design verifier cannot be used with a variable-step solver, You must configure the solver options for a
fixed-step solver

Open ] [ Help ] [ Close

= If your model has nonfinite data, change the value of the data or
configure the model so that the data is treated as a variable during
Simulink Design Verifier analysis.



3 Ensuring Compatibility with the Simulink® Design Verifier™ Software

f o)

a Simulink Design Verifier Errors: ex_mManlnf E'@

View Font Size

Message Source Reported By Summary
] Design Verifier compatibility error  ex_mManInf simulink Simulink Design Verifier failed to ini...
- ] Design Verifier compatibility error Constant sldv The base workspace parameter ‘G ...
& Design Verifier compatibility error  Constantl  sldwv The base workspace parameter 'K u...

@ ex_mManInf/Constant

The base workspace parameter 'G' used by 'ex_mManInf/Constant’ has nonfinite value (MaM or Inf or -Inf),
simulink Design verifier does not support parameters with this configuration. Please consider changing the value of
this parameter or configure Simulink Design Verifier so that it is treated as variable during analysis.

Open ] [ Help ] [ Close

Note For more information about this dialog box, see “Simulation
Diagnostics Viewer” in the Simulink documentation.

Model is Partially Compatible

A model is partially compatible if at least one object in the model is
incompatible. Automatic stubbing is enabled by default, so if you start an
analysis that determines that the model is partially incompatible, it gives the
following message, but the analysis proceeds.

This model can be analyzed by Simulink Design Verifier.
It contains unsupported elements that will be stubbed
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out during analysis. The results of the analysis might

be incomplete.

If you have disabled automatic stubbing, the analysis stops. A query asks if
you want to enable automatic stubbing so that the analysis can proceed.

P

Simulink Design Verifier log: ex_auto_stubbing_how_sldv_works

11-May-2012 16:45:01

Checking compatibility of model
'ex_auto_stubbing_how_sldv_waorks'
Compiling model... done

Checking compatibility... done
'ex_auto_stubbing_how_sldv_waorks' is
Simulink Design Verifier.

The model contains unsupported elements and cannot be
analyzed directly by Simulink Design Verifier.

You can analyze it by turning on the

AutomaticStubbing option.

with

=

Save Log I I

Close

-,

Click Continue to enable automatic stubbing and proceed with the analysis.

Note For instructions on how to use automatic stubbing, see “Handle

Incompatibilities with Automatic Stubbing” on page 2-8.
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Simulink Block Support

The software provides various levels of support for Simulink blocks:

e Fully supported

e Partially supported

* Not supported

If your model contains unsupported blocks, you can enable automatic
stubbing. Automatic stubbing considers the interface of the unsupported
blocks, but not their behavior. If any of the unsupported blocks affect the
simulation outcome, however, the analysis may achieve only partial results.

For details about automatic stubbing, see “Handle Incompatibilities with
Automatic Stubbing” on page 2-8.

To achieve 100% coverage, avoid using unsupported blocks in models that
you analyze. Similarly, for partially supported blocks, specify only the block
parameters that the software recognizes.

The following tables summarize the analysis support for Simulink blocks.
Each table lists the blocks in a Simulink library and describes support
information for that particular block.

Additional Math and Discrete Library

The software supports all blocks in the Additional Math and Discrete library.
Commonly Used Blocks Library

The Commonly Used Blocks library includes blocks from other libraries.
Those blocks are listed under their respective libraries.

Continuous Library

Block Support Notes
Derivative Not supported
Integrator Not supported and not stubbable




Simulink® Block Support

Block

Support Notes

Integrator Limited

Not supported and not stubbable

PID Controller

Not supported

PID Controller (2 DOF)

Not supported

Second Order Integrator

Not supported and not stubbable

Second Order Integrator Limited

Not supported and not stubbable

State-Space

Not supported and not stubbable

Transfer Fen

Not supported and not stubbable

Transport Delay

Not supported

Variable Time Delay

Not supported

Variable Transport Delay

Not supported

Zero-Pole Not supported and not stubbable
Discontinuities Library
The software supports all blocks in the Discontinuities library.
Discrete Library

Block Support Notes

Delay Supported

Difference Supported

Discrete Derivative Supported

Discrete Filter Supported

Discrete FIR Filter Supported

Discrete PID Controller Supported

Discrete PID Controller (2 DOF) Supported

Discrete State-Space

Not supported

Discrete Transfer Fen

Supported
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Block Support Notes
Discrete Zero-Pole Not supported
Discrete-Time Integrator Supported
First-Order Hold Supported
Memory Supported
Tapped Delay Supported
Transfer Fen First Order Supported
Transfer Fcn Lead or Lag Supported
Transfer Fecn Real Zero Supported
Unit Delay Supported
Zero-Order Hold Supported

Logic and Bit Operations Library

The software supports all blocks in the Logic and Bit Operations library.

Lookup Tables Library

Block Support Notes
Cosine Supported
Direct Lookup Table (n-D) Supported

Interpolation Using Prelookup

Not supported when:

¢ The Interpolation method parameter is Linear and
the Number of table dimensions parameter is greater
than 4.

or
® The Interpolation method parameter is Linear and

the Number of sub-table selection dimensions
parameter is not 0.




Simulink® Block Support

Block

Support Notes

1-D Lookup Table

Not supported when the Interpolation method or the
Extrapolation method parameter is Cubic Spline.

2-D Lookup Table

Not supported when the Interpolation method or the
Extrapolation method parameter is Cubic Spline.

n-D Lookup Table

Not supported when:

¢ The Interpolation method or the Extrapolation
method parameter is Cubic Spline.

or
¢ The Interpolation method parameter is Linear and

the Number of table dimensions parameter is greater
than 5.

Lookup Table Dynamic Supported
Prelookup Supported
Sine Supported

Math Operations Library
Block Support Notes
Abs Supported
Add Supported
Algebraic Constraint Supported
Assignment Supported
Bias Supported

Complex to Magnitude-Angle

Not supported

Complex to Real-Imag

Not supported

Divide

Supported

Dot Product

Supported
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Block Support Notes
Find Nonzero Elements Supported
Gain Supported

Magnitude-Angle to Complex

Not supported

Math Function

All signal types support the following Function

parameter settings.

conj hermitian

magnitude~2

mod

rem reciprocal| square

transpose

The software does not support the following Function

parameter settings.

10"u exp hypot
log log10 pow

Matrix Concatenate Supported

MinMax Supported

MinMax Running Resettable Supported

Permute Dimensions Supported

Polynomial Supported

Product Supported

Product of Elements Supported

Real-Imag to Complex

Not supported

Reciprocal Sqrt

Not supported

Reshape Supported
Rounding Function Supported
Sign Supported

Signed Sqrt

Not supported




Simulink® Block Support

Block

Support Notes

Sine Wave Function

Not supported

Slider Gain Supported
Sqrt Not supported
Squeeze Supported
Subtract Supported
Sum Supported
Sum of Elements Supported

Trigonometric Function

Supported when Function is sin, cos, sincos , or
atan2, and Approximation method is CORDIC.

Unary Minus Supported
Vector Concatenate Supported
Weighted Sample Time Math Supported

Model Verification Library

The software supports all blocks in the Model Verification library.

Model-Wide Utilities Library

Block Support Notes
Block Support Table Supported
DocBlock Supported
Model Info Supported

Timed-Based Linearization

Not supported

Trigger-Based Linearization

Not supported
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Ports & Subsystems Library

Block

Support Notes

Atomic Subsystem Supported
Code Reuse Subsystem Supported
Configurable Subsystem Supported
Enable Supported

Enabled Subsystem

Range analysis does not consider the design minimum
and maximum values specified for blocks connected to
the outport of the subsystem.

Enabled and Triggered Subsystem

Not supported when the trigger control signal specifies a
fixed-point data type.

Range analysis does not consider the design minimum
and maximum values specified for blocks connected to
the outport of the subsystem.

For Each Not supported and not stubbable
For Each Subsystem Not supported

For Iterator Subsystem Supported

Function-Call Feedback Latch Supported

Function-Call Generator Supported

Function-Call Split Supported

Function-Call Subsystem

Range analysis does not consider the design minimum
and maximum values specified for blocks connected to
the outport of the subsystem.




Simulink® Block Support

Block

Support Notes

If

When running test case generation for coverage, the If
block records condition, decision, and MCDC coverage.
However, the Simulink Design Verifier software
generates test cases only for condition and decision
coverage.

Parameter configurations are not supported. The
analysis ignores any parameter configurations that you
specify for an If block.

If Action Subsystem Supported
Inport Supported
Model Supported except for the limitations described in

“Support Limitations for Model Blocks” on page 3-23.

Model Variants

Supported except for the limitations described in
“Support Limitations for Model Blocks” on page 3-23.

Outport Supported
Subsystem Supported
Switch Case Supported
Switch Case Action Subsystem Supported
Trigger Supported

Triggered Subsystem

Not supported when the trigger control signal specifies a
fixed-point data type.

Range analysis does not consider the design minimum
and maximum values specified for blocks connected to
the outport of the subsystem.

Variant Subsystem

Not supported when the Generate preprocessor
conditionals parameter is enabled.

While Iterator Subsystem

Supported

Signal Attributes Library

The software supports all blocks in the Signal Attributes library.
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Signal Routing Library

Block Support Notes
Bus Assignment Supported
Bus Creator Supported
Bus Selector Supported
Data Store Memory Supported
Data Store Read Supported
Data Store Write Supported
Demux Supported
Environment Controller Supported
From Supported
Goto Supported
Goto Tag Visibility Supported
Index Vector Supported

Manual Switch

The Manual Switch block is compatible with the
software, but the analysis ignores this block in a model.
The analysis does not flag the coverage objectives for
this block as satisfiable or unsatisfiable.

Model coverage data is collected for the Manual Switch
block.

Merge Supported
Multiport Switch Supported
Mux Supported
Selector Supported
Switch Supported

Vector Concatenate

Supported
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Sinks Library

Block Support Notes
Display Supported
Floating Scope Supported
Outport (Outl) Supported
Scope Supported

Stop Simulation Not supported and not stubbable
Terminator Supported

To File Supported

To Workspace Supported

XY Graph Supported

Sources Library
Block Support Notes

Band-Limited White Noise

Not supported

Chirp Signal

Not supported

Clock Supported
Constant Supported unless Constant value is inf.
Counter Free-Running Supported
Counter Limited Supported
Digital Clock Supported
Enumerated Constant Supported

From File

Not supported. When MAT-file data is stored in
MATLAB timeseries format, not stubbable.

From Workspace

Not supported

Ground

Supported

Inport (In1)

Supported
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Block Support Notes
Pulse Generator Supported
Ramp Supported

Random Number

Not supported and not stubbable

Repeating Sequence

Not supported

Repeating Sequence Interpolated

Not supported

Repeating Sequence Stair

Supported

Signal Builder

Not supported

Signal Generator

Not supported

Sine Wave

Not supported

Step

Supported

Uniform Random Number

Not supported and not stubbable

User-Defined Functions Library

Block

Support Notes

Fen

Supports all operators except *, and supports only the
mathematical functions abs, ceil, fabs, floor, rem,
and sgn.

Parameter configurations are not supported. The
analysis ignores any parameter configurations that you
specify for these blocks.

Interpreted MATLAB Function

Not supported




Simulink® Block Support

Block Support Notes

Level-2 MATLAB S-Function Not supported

MATLAB Function For limitations, see “Support Limitations for MATLAB
for Code Generation” on page 3-29.

S-Function Not supported

S-Function Builder Not supported
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Support Limitations for Simulink Software Features

The software does not support the following Simulink software features.
Avoid using these unsupported features.

Not Supported

Description

Variable-step solvers

The software supports only fixed-step solvers.

For more information, see “Choosing a Fixed-Step
Solver” in the Simulink documentation.

Callback functions

The software does not execute model callback
functions during the analysis. The results that the
analysis generates, such as the harness model, may
behave inconsistently with the expected behavior.

¢ [f a model or any referenced model calls a callback
function that changes any block parameters,
model parameters, or workspace variables, the
analysis does not reflect those changes.

¢ Changing the storage class of base workspace
variables on model callback functions or mask
initializations is not supported.

e (Callback functions called prior to analysis,
such as the PreLoadFcn or PostLoadFcn model
callbacks, are fully supported.

Model callback
functions

The software only supports model callback functions
if the InitFcn callback of the model is empty.

Algebraic loops

The software does not support models that contain
algebraic loops.

For more information, see “Algebraic Loops” in the
Simulink documentation.

Masked subsystem
1nitialization
functions

The software does not support models whose masked
subsystem initialization modifies any attribute of
any workspace parameter.
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Not Supported

Description

Complex signals

The software supports only real signals.

For more information, see “Complex Signals” in the
Simulink documentation.

Variable-size signals

The software does not support variable-size signals.
A variable-size signal is a signal whose size (number
of elements in a dimension), in addition to its values,
can change during model execution.

For more information, see “Variable-Size Signal
Basics” in the Simulink documentation.

Arrays of buses

The software does not support arrays of buses.

For more information, see “Combine Buses into an
Array of Buses” in the Simulink documentation.

Multiword
fixed-point data

types

The software does not support multiword fixed-point
data types.

Nonzero start times

Although Simulink allows you to specify a nonzero
simulation start time, the analysis generates signal
data that begins only at zero. If your model specifies
a nonzero start time:

¢ If you do not select the Reference input model
in generated harness parameter (the default),
the harness model is a subsystem. The analysis
sets the start time of the harness model to 1 and
continues the analysis.

e [f you select the Reference input model in
generated harness parameter, a Model block
references the harness model. The software
cannot change the start time of the harness
model, so the analysis stops and you see a
recommendation to set the Start time parameter
to 0.
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Not Supported

Description

Nonfinite data

The software does not support nonfinite data (for
example, NaN and Inf) and related operations.

In the Relational Operator block, the software

assigns the output as follows:

e If the Relational operator parameter is
isFinite, the output is always 1.

e [f the Relational operator parameter is isNan

or isInf, the output is always 0.

In the MATLAB Function block, the software
assigns the return value as follows:
¢ For the isFinite function, the output is always 1.

® For the isNan and isInf functions, the output
is always 0.

Concurrent
execution

The software does not support models that are
configured for concurrent execution.

Signals with nonzero
sample time offset

The software does not support models with signals
that have nonzero sample time offsets.

Models with no
output ports

The software only supports models that have one or
more output ports.
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Support Limitations for Model Blocks

The software supports the Model block, but with the following limitations. The
software cannot analyze a model that contains one or more Model blocks if:

® The referenced model is protected. Protected referenced models are
encoded to obscure their contents. This feature allows third parties to use
the referenced model without being able to view the intellectual property
that makes up the model.

Note For more information, see “Protected Model”.

® The parent model or any of the referenced models
gives an error when you set the Configuration
Parameters > Diagnostics > Connectivity > Element name
mismatch parameter to error.

You can use the Element name mismatch diagnostic along with bus
objects so that your model meets the bus element naming requirements
imposed by some blocks.

® The Model block uses asynchronous function-call inputs.

® Any of the Model blocks in the model reference hierarchy creates an
artificial algebraic loop. If this occurs, take the following steps:

1 On the Diagnostics pane of the Configuration Parameters dialog box,
set the Minimize algebraic loop parameter to error so that Simulink
reports an algebraic loop error.

2 On the Model Referencing Pane of the Configuration Parameters
dialog box, select the Minimize algebraic loop occurrences parameter.

Simulink tries to eliminate the artificial algebraic loop during simulation.
3 Simulate the model.

4 If Simulink cannot eliminate the artificial algebraic loop, highlight
the location of the algebraic loop by selecting Simulation > Update
Diagram.
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5 Eliminate the artificial algebraic loop so that the software can analyze
the model. Break the loop with Unit Delay blocks so that the execution
order is predictable.

Note For more information, see “Algebraic Loops”.

The parent model and the referenced model have mismatched data type
override settings. The data type override setting of the parent model and
all of its referenced models must be the same, unless the data type override
setting of the parent model is Use local settings. You can select the
data type override settings for your model in the Analysis menu, in the
Fixed Point Tool dialog box under the Settings for selected system pane.
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Support Limitations for Stateflow Software Features

The software does not support the following Stateflow software features.

Avoid using these unsupported features in models that you analyze.

In this section...

“ml Namespace Operator, ml Function, ml Expressions” on page 3-25
“C Math Functions” on page 3-25

“Atomic Subcharts That Call Exported Graphical Functions Outside a
Subchart” on page 3-26

“Recursion and Cyclic Behavior” on page 3-26
“Custom C or C++ Code” on page 3-28
“Machine-Parented Data” on page 3-28

“Textual Functions with Literal String Arguments” on page 3-28

ml Namespace Operator, ml Function, ml Expressions

The software does not support calls to MATLAB functions or access to

MATLAB workspace variables, which the Stateflow software allows. (See
“Access Built-In MATLAB Functions and Workspace Data” in the Stateflow

documentation.)

C Math Functions

The software supports calls to the following C math functions:

abs
ceil
fabs
floor
fmod
labs
ldexp
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® pow (only for integer exponents)

The software does not support calls to other C math functions, which the
Stateflow software allows. If automatic stubbing is enabled, which it is by
default, the software eliminates these unsupported functions during the
analysis.

For information about C math functions in Stateflow, see “Call C Functions in
C Charts” in the Stateflow documentation.

Note For details about automatic stubbing, see “Handle Incompatibilities
with Automatic Stubbing” on page 2-8.

Atomic Subcharts That Call Exported Graphical
Functions Outside a Subchart

The software does not support atomic subcharts that call exported graphical
functions, which the Stateflow software allows.

Note For information about exported functions, see “Export Functions for
Reuse in Other Charts” in the Stateflow documentation.

Recursion and Cyclic Behavior

Simulink Design Verifier software does not support recursive functions,
which occur when a function calls itself directly or indirectly through another
function call. Stateflow software allows you to implement recursion using
graphical functions.

In addition, the software does not support recursion that the Stateflow
software allows you to implement using a combination of event broadcasts
and function calls.
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Note For information about avoiding recursion in Stateflow charts, see
“Guidelines for Avoiding Unwanted Recursion in a Chart” in the Stateflow
documentation.

Stateflow software also allows you to create cyclic behavior, where a sequence
of steps is repeated indefinitely. If your model has a chart with cyclic
behavior, the Simulink Design Verifier software cannot analyze it.

Note For information about cyclic behavior in Stateflow charts, see “Cyclic
Behavior in a Chart” in the Stateflow documentation.

However, you can modify a chart with cyclic behavior so that it is compatible,
as in the following example.

The following chart creates cyclic behavior. State A calls state A1, which
broadcasts a Clear event to state B, which calls state B2, which broadcasts a
Set event back to state A, causing the cyclic behavior.

A

=r
]
—

i}

A2

E Ic-:undj T lear
; B2
! send(Set A);
] \ ot

v

If you change the send function calls to use directed event broadcasts so that
the Set and Clear events are broadcast directly to the states B1 and Al,
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respectively, the cyclic behavior disappears and the Simulink Design Verifier
software can analyze the model.

A
send(Clear, B.B1);

T

o

w
Ty
Iee]
RS

i}

AD ]
e A

Note For information about the benefits of directed event broadcasts, see
“Broadcast Events to Synchronize States” in the Stateflow documentation.

Custom C or C++ Code

The software does not support custom C or C++ code, which the Stateflow
software allows.

Machine-Parented Data

The software does not support machine-parented data (i.e., defined at the
level of the Stateflow machine), which the Stateflow software allows.

For more information, see “Best Practices for Using Data in Charts” in the
Stateflow documentation.

Textual Functions with Literal String Arguments

The software does not support literal string arguments to textual functions
in a Stateflow chart.
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Support Limitations for MATLAB for Code Generation

In this section...

on page 3-30

“Unsupported MATLAB for Code Generation Features” on page 3-29
“Support Limitations for MATLAB for Code Generation Library Functions”

Unsupported MATLAB for Code Generation Features
The software does not support the following features of the MATLAB Function
block in the Simulink software and MATLAB functions in the Stateflow
software. Avoid using these unsupported features in models that you analyze
with the Simulink Design Verifier software.

Not Supported

Description

Complex numbers

The software supports only real numbers and
cannot analyze MATLAB for code generation
functions that use complex numbers.

Characters

The software does not support characters,
which MATLAB for code generation allows.

C functions

The software does not support calls to external
C functions, which MATLAB for code generation
allows.

Extrinsic functions

The software supports extrinsic functions
only when they do not affect the output of a
MATLAB function.

Handle classes

The software does not support handle classes
in the MATLAB Function block. The software
does support value classes.
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Support Limitations for MATLAB for Code Generation
Library Functions

The software provides various levels of support for MATLAB for code
generation library functions. The software either fully or partially supports
particular functions. It does not support other functions.

If your model contains unsupported functions, you can turn on automatic
stubbing, which considers the interface of the unsupported functions, but

not their behavior. However, if any of the unsupported functions affect the
simulation outcome, the analysis may achieve only partial results. For details
about automatic stubbing, see “Handle Incompatibilities with Automatic
Stubbing” on page 2-8.

To achieve 100% coverage, avoid using unsupported MATLAB library
functions in models that you analyze.

The following table lists Simulink Design Verifier support for categories of
library functions in code generation from MATLAB:

® Software supports functions in that category, indicated by a dash (—).

® Software does not support functions in that category.

® Software supports the function in that category with limitations as

specified.

For the complete listing of available functions, see “Functions Supported
for Code Generation”.

Function Category Support Notes
Aerospace Toolbox functions Not supported.
Arithmetic operator functions Supported with the following limitations:
mldivide (\) | Supports only scalar
arguments.
mpower (*) Supports only integer
exponents.
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Function Category

Support Notes

mrdivide (/) | Supports only scalar

arguments.

Supports only integer
exponents.

power (.")

Bit-wise operation functions

Casting functions

Supported with the following limitations:

char Not supported.

typecast Not supported.

Communications System Toolbox™ functions

Not supported.

Complex number functions

Not supported.

Computer Vision System Toolbox™ functions

Not supported.

Data type functions

Derivative and Integral functions

Not supported.

Discrete math functions

Error handling functions

Supported with the following limitations:

assert
like a Proof Objective block.

Supported, but does not behave

Exponential functions

Supported with the following limitations:

exp Not supported.
expm Not supported.
expm1i Not supported.
log Not supported.
log2 Not supported.
log10 Not supported.
logip Not supported.
nextpow?2 Not supported.
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Function Category Support Notes
nthroot Not supported.
reallog Not supported.
realpow Not supported.
realsqrt Not supported.
sqrt Not supported.
Filtering and convolution functions Supported with the following limitations:
detrend Not supported.
Fixed-Point Designer™ functions Supported with the following limitations:
complex Not supported.
Histogram functions Not supported.
Image Processing Toolbox™ functions Not supported.

Input and output functions =

Interpolation and computation geometry Supported with the following limitations:
cart2pol Not supported.
cart2sph Not supported.
pol2cart Not supported.
sph2cart Not supported.
Linear algebra Not supported.
Logical operator functions =
MATLAB Compiler™ functions Not supported.
Matrix and array functions Supported with the following limitations:
angle Not supported.
cond Not supported.
det Not supported.
eig Not supported.
inv Not supported.
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Function Category

Support Notes

invhilb Not supported.

logspace Not supported.

lu Not supported.

norm Supported only when invoked
using the syntax
norm(A,p)
where p is either 1 or inf.

normest Not supported.

pinv Not supported.

planerot Not supported.

qr Not supported.

rank Not supported.

rcond Not supported.

subspace Not supported.

Nonlinear numerical methods

Not supported.

Polynomial functions

Not supported.

Relational operations functions

Rounding and remainder functions

Set functions

Signal Processing functions in MATLAB

Not supported.

Signal Processing Toolbox™ functions

Not supported.

Special values

Supported with the following limitations:

rand

Not supported.

randn

Not supported.

Specialized math

Not supported.

Statistical functions
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Function Category

Support Notes

String functions

Supported with the following limitations:

char Not supported.

ischar Not supported.

Trigonometric functions

Not supported.
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What Is Block Replacement?

Using the Simulink Design Verifier software, you can define rules to replace
blocks automatically in your model. For example, you can work around a
block that is incompatible with the software by creating a rule that replaces
an unsupported Simulink block in your model with a supported block that is
functionally equivalent. Or, you can customize blocks for analysis by creating
a rule that adds constraints or objectives to particular blocks in your model.

When performing block replacements, the software makes a copy of your
model and replaces blocks in the copy, without altering your original model.
In this way, you can easily customize a model for analysis.

The Simulink Design Verifier software replaces blocks automatically in a
model using:
e Libraries of replacement blocks

® Rules that define which blocks to replace and under what conditions
You replace any block with any built-in block, library block, or subsystem.

Block replacements are extensible, allowing you to define your own libraries
of replacement blocks and custom block replacement rules. Use this capability
if you need to:

¢ Work around an incompatibility, such as the presence of unsupported
blocks in your model.

¢ Customize a block for analysis, such as:
= Adding constraints to its input signals
= Adding objectives to its output signals

= Eliminating the contents of a subsystem or Model block to simplify your
analysis



What Is Block Replacement?

Note You can use automatic stubbing as an alternative to block replacements
in order to resolve incompatibilities. Automatic stubbing replaces unsupported
blocks with elements that have the same interface. For more information, see
“Handle Incompatibilities with Automatic Stubbing” on page 2-8.
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Built-In Block Replacements

The Simulink Design Verifier software provides a set of block replacement

rules and a corresponding

library of replacement blocks. Use these built-in

block replacements when analyzing models. They serve as examples that you
can examine to learn how to create your own block replacements.

The following table lists the factory default block replacement rules, available
in the matlabroot\toolbox\sldv\sldv\private folder. There are two
implementations of each factory-default block replacement rule. Rules whose
file names end with _normal.m replace blocks with Subsystem blocks. Rules
whose file names end with _configss.m replace blocks with Configurable

Subsystem blocks.

File Name

Description

blkrep_rule_lookup_normal.m

blkrep_rule_lookup_configss.m

A rule that replaces 1-D Lookup Table blocks with
an implementation that includes test objectives
for each breakpoint and interval specified by the
Breakpoints parameter.

blkrep_rule_lookup2D_normal.m

blkrep_rule_lookup2D_configss.m

A rule that adds Test Condition/Proof Assumption
blocks to the input ports of 2-D Lookup Table
blocks. Each Test Condition/Proof Assumption
block constrains signal values to the interval
specified by the corresponding breakpoint vector.

blkrep_rule_mpswitch2_normal.m

blkrep_rule_mpswitch2_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the control input port of
Multiport Switch blocks whose Number of data
ports parameter is 2. The Test Condition/Proof
Assumption block constrains signal values to the
interval [1, 2] (or [0, 1] if the block uses zero-based
indexing).
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File Name

Description

blkrep_rule_mpswitch3_normal.m

blkrep_rule_mpswitch3_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the control input port of
Multiport Switch blocks whose Number of data
ports parameter is 3. The Test Condition/Proof
Assumption block constrains signal values to the
interval [1, 3] (or [0, 2] if the block uses zero-based
indexing).

blkrep_rule_mpswitch4_normal.m

blkrep_rule_mpswitch4_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the control input port of
Multiport Switch blocks whose Number of data
ports parameter is 4. The Test Condition/Proof
Assumption block constrains signal values to the
interval [1, 4] (or [0, 3] if the block uses zero-based
indexing).

blkrep_rule_mpswitch5_normal.m

blkrep_rule_mpswitch5_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the control input port of
Multiport Switch blocks whose Number of data
ports parameter is 5. The Test Condition/Proof
Assumption block constrains signal values to the
interval [1, 5] (or [0, 4] if the block uses zero-based
indexing).

blkrep_rule_switch_normal.m

blkrep_rule_switch_configss.m

A rule that replaces Switch blocks with an
implementation that includes test objectives,
requiring that each switch position be exercised
when the values of the first and third input ports
are different.
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File Name

Description

blkrep_rule_selector
IndexVecPort_normal.m

blkrep_rule_selector
IndexVecPort_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the index port of Selector
blocks whose Index Option parameter is Index
vector (port). The Test Condition/Proof
Assumption block constrains signal values to an
interval whose endpoints are derived from the
values of the Selector block’s Input port size and
Index mode parameters.

blkrep_rule_selector
StartingIdxPort_normal.m

blkrep_rule_selector
StartingIdxPort_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the index port of Selector
blocks whose Index Option parameter

1s Starting index (port). The Test
Condition/Proof Assumption block constrains
signal values to an interval whose endpoints are
derived from the values of the Selector block’s
Input port size, Output size, and Index mode
parameters.

The library of replacement blocks that corresponds to the factory default

rules 1s

matlabroot/toolbox/sldv/sldv/sldvblockreplacementlib
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Template for Block Replacement Rules

To help you create block replacement rules, the Simulink Design Verifier
software provides an annotated template that contains a skeleton
implementation of the requisite callbacks:

matlabroot/toolbox/sldv/sldv/sldvblockreplacetemplate.m

To create a block replacement rule, make a copy of the template and edit the
copy to implement the desired behavior for the rule you are creating. The
comments in the template provide hints about how to use each section. For
a tutorial on using the template to write custom block replacements rules,
see “Write Block Replacement Rules” on page 4-9.

4-7
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Define Custom Block Replacements

In this section...

“Basic Workflow for Defining Custom Block Replacements” on page 4-8
“Specify Replacement Blocks” on page 4-8
“Write Block Replacement Rules” on page 4-9

“Replace Multiport Switch Blocks” on page 4-9

Basic Workflow for Defining Custom Block
Replacements

To replace certain blocks in your model in a way that the factory-default
block replacement rules do not handle, create custom block replacement rules
by completing the following tasks:

® “Specify Replacement Blocks” on page 4-8

* “Write Block Replacement Rules” on page 4-9

Specify Replacement Blocks

A replacement block can be one of the built-in blocks in the Simulink model
library or a block in a user-created library.

In the Simulink Design Verifier software, replacement blocks have the
following restrictions:

® They must be built-in blocks or subsystems.

¢ They cannot be Model blocks, nor can they include any Model blocks.

Note A Model block cannot be a replacement block, but you can replace
Model blocks with built-in blocks or subsystems.

® They must reside in a block library that is available on your MATLAB
search path.

4-8
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e If the replacement block is a subsystem, any Inport and Outport blocks
must have the default names (In1 and Out1).

After constructing your replacement block, write a custom block replacement
rule.

Write Block Replacement Rules

Block replacement rules have the following restrictions:

¢ The function that represents a block replacement rule must include
particular callbacks. Use the block replacement rule template as a starting
point for writing a custom rule. (See “Template for Block Replacement
Rules” on page 4-7.)

¢ The function that represents a block replacement rule must be on the
MATLAB search path.

Replace Multiport Switch Blocks

¢ “Why Replace Multiport Switch Blocks?” on page 4-9
e “Create the Library and Replacement Block” on page 4-10
e “Write the Rule for the Replacement Block” on page 4-13

Why Replace Multiport Switch Blocks?

A Multiport Switch block has one control input port and one or more data
input ports; the default number of data inputs is 3.

i
Eli §
tb.
—
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Multiport Switch

A model may have test objectives on some blocks whose output is directly or
indirectly connected to the Multiport Switch block. For example, a Saturation
block may send data to the control input port. In this case, the analysis may
create test cases that satisfy those objectives. However, those test cases may
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create values that are out of range for the control input port, regardless of
whether the Multiport Switch block uses zero-based indexing or one-based
indexing. This causes the simulation to fail.

In this example, you create a rule to replace all Multiport Switch blocks that
have two data inputs and do not use zero-based indexing. The replacement
block is a subsystem that has a Test Condition block that constrains the value
of the control input to 1 or 2, so that the analysis does not create out-of-range
data input values. This allows the analysis to satisfy the objectives on blocks
that are connected to the control input port of the Multiport Switch block.

Create the Library and Replacement Block

Create a user library and specify the replacement block as a masked
subsystem:

1 In the Simulink Library Browser, select File > New > Library.

2 In your library, create a subsystem named myReplacementBlock to
represent your replacement block.

3 Inside myReplacementBlock, add two Inport blocks so that the subsystem
has three input ports and one output port. In your top-level model, the
subsystem should look like the following graphic.

} Ini
N in2 Cutt b
» 2

myH eplacementBlook

4 Add a Multiport Switch block and a Test Condition block to the subsystem.
Set the block parameters as follows.

¢ In the Multiport Switch block, set the Number of data ports parameter
to 2.

¢ In the Test Condition block, set the Values parameter to {[1, 2]}.

4-10
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After you set these parameters, the contents of your subsystem
myReplacementBlock should look like the following graphic.

. 2%
13 »—
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Switch

5 To create a mask for your subsystem, from the top-level model, right-click
myReplacementBlock. From the context menu, select Mask > Create

Mask.

6 In the Mask Editor, specify the following information:

¢ In the Parameters pane, define a mask parameter named InputSameDT
as shown.

This parameter replicates the behavior of the Require all data port
inputs to have the same data type parameter of the underlying
Multiport Switch block.
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| Mask Editor : myReplacementBlock E\@
Icon & Ports| Parameters & Dialog | Initialization | Documentation
Controls Dialog box Property editor
Pararneter Type Prompt MName El Properties
=R %< MaskType> DescGroupVar Name InputSameDT
o] %< MaskDescription> DescTextVar Value (]
| Parameters ParameterGroupVar Prompt Require all data ...
T = Attributes
@ Drag or double-click item; in left palett.eto add to dialog. Evaluate
Use Delete key to remove items from dialog. Tunable
Read only [
- Hidden 0
Action MNever save [l
=l Dialog
Enable
Visible
Callback 7]
= Layout
Item location  |Mew row
Unmask ] ’ Preview | oK | [ Cancel ] ’ Help l [ Apply ]

¢ In the Initialization pane, in the Initialization commands field,
enter commands to specify that the subsystem inherit the InputSameDT
parameter value of the top-level model:

maskInputSameDT = get_param(gcb, 'InputSameDT');
blkName = sprintf('/Multiport\nSwitch');

targetBlock = [gcb, blkName];

set_param(targetBlock, 'InputSameDT',maskInputSameDT);

7 Save your block library as a model file called custom_rule in a folder on
your MATLAB search path.

4-12
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Write the Rule for the Replacement Block
To write a rule for the replacement block:

1 Open the block replacement rule template

matlabroot/toolbox/sldv/sldv/sldvblockreplacetemplate.m

2 Make a copy of the file and save it as custom_rule_switch.min a folder on
your MATLAB search path.

Note Execute steps 3 through 11 for the copy of the template that you
saved.

3 To declare a function custom_rule switch and modify its help, modify
the first few lines of the template:

function rule = custom_rule_switch
%CUSTOM_RULE_SWITCH Custom block replacement rule for
%the Simulink Design Verifier software

o°

o°

This block replacement rule identifies Multiport
Switch blocks whose "Number of inputs" parameter
specifies '2' and "Use zero-based indexing" parameter
specifies 'off'. It replaces such blocks with an
implementation that includes a Test Condition block
on the control input signal.

o° o° o° o°

o°

The function name must match its file name, without the .m extension. The
comments that follow the function declaration create help for this rule.

4 Specify the type of block that you want to replace in your model by
specifying its BlockType parameter as the rule.blockType object. For this
example, change the rule.blockType object to 'MultiPortSwitch':

%% Target Block Type

o°

rule.BlockType = 'MultiPortSwitch’;

4-13



4 Working with Block Replacements

4-14

Note You can use the get_param function to obtain the value of the
BlockType parameter for the block that you want to replace.

Specify the full block path name for the replacement block as the
rule.ReplacementPath object. For this example, to replace Multiport
Switch blocks with the replacement block developed in “Specify
Replacement Blocks” on page 4-8, modify therule.ReplacementPath object
using the full block path name:

%% Replacement Library

o°

rule.ReplacementPath = sprintf('custom_rule/myReplacementBlock');

Note To get the full block path name, use the gcb function.

To specify the type of subsystem that the software uses when replacing
blocks, specify a value for the rule.ReplacementMode object. Valid values
are:

® Normal — The software replaces blocks with a copy of the subsystem
specified by the rule.ReplacementPath object. This is the default.

® ConfigurableSubSystem — The software replaces blocks with a
Configurable Subsystem block. With the Configurable Subsystem
block, you can choose whether it represents the subsystem specified
by the rule.ReplacementPath object, or the original block before its
replacement.

For this example, set rule.ReplacementMode to Normal:

%% Replacement Mode

o°

rule.ReplacementMode = ‘Normal’;

Specify parameter values that the replacement blocks inherit from the
blocks being replaced. You achieve inheritance by mapping the parameter
names in a structure. Each field of the structure represents a parameter
that the replacement block inherits. Specify the value of each field using
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the token $original.parameter$. parameter is the name of the parameter
that belongs to the original block.

To define a structure named parameter that maps the InputSameDT
parameter from the original Multiport Switch blocks to their replacement
blocks, change the content of the Parameter Handling section as follows:

%% Parameter Handling

[
“©

parameter.InputSameDT = '$original.InputSameDT$';

% Register the parameter mapping for the rule
rule.ParameterMap = parameter;

Note To determine block parameter names, refer to “Block Libraries” in
the Simulink documentation.

To define the callback functions, keep the following lines in the file:

%% Replacement Test Callback

o0

Customize the local function 'replacementTestFunction' to specify the

o0

conditions under which Simulink Design Verifier replaces blocks when

o

s using this rule. Simulink Design Verifier replaces blocks only when this

o0

local function returns true.

°
i)

rule.IsReplaceableCallBack = @replacementTestFunction;

%% Post Replacement Callback

o0

Customize the local function 'postReplacementFunction' to specify actions

o

s that will be performed after a block is replaced.

o°

The usage of this callback in replacement rules is optional. Simulink

o

s Design Verifier does not enforce its existence in the rule definition.

°
i)

rule.PostReplacementCallBack = @postReplacementFunction;

Customize replacementTestFunction by specifying conditions under
which the Simulink Design Verifier software replaces blocks in your model.

4-15
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To instruct the software to replace only the Multiport Switch blocks whose
NumInputPorts parameter is 2 and whose zeroIdx parameter is off,
replace the existing replacementTestFunction with the following:

function out = replacementTestFunction(blockH)

Specify the logic that determines when the Simulink Design
Verifier software replaces a block in your model. For example,
restrict replacements to only the blocks whose parameters
specify particular values.

o® o° o o°

o°

out = false;
numInputPorts = eval(get_param(blockH, '‘NumInputPorts'));
zeroldx = get_param(blockH, 'zerolIdx');
if numInputPorts==2 && strcmp(zeroldx, 'off')
out = true;
end

Because replacementTestFunction executes after the model has been
compiled, you can access parameters such as CompiledPortDataTypes or
CompiledPortDimensions from replacementTestFunction

For an example of a replacementTestFunction that accesses these
parameters, open the following file:

matlabroot/toolbox/sldv/sldv/private/blkrep_rule_switch_normal.m

10 Optionally, you can customize postReplacementFunction to specify the

actions the software performs after a block has been replaced.
For an example of a postReplacementFunction, open the following file:

matlabroot/toolbox/sldv/sldv/private/blkrep_rule_selectorIndexVecPort_normal.m

11 Save the edited file and continue to the next section, “Execute Block

Replacements” on page 4-17, to execute your replacement rule.
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Execute Block Replacements

In this section...

“Configure Block Replacements” on page 4-17

“Replace Blocks in a Model” on page 4-18

Configure Block Replacements

You must configure block replacement options before executing block

replacements in your model. To specify block replacement options from the
model window:

1 Open the sldvdemo_param_identification model.

2 Rename this model to my_sldvdemo_param_identification, and save it in
a folder on your MATLAB search path.

3 In the Model Editor, select Analysis > Design Verifier > Options.

The Configuration Parameters dialog box displays the main pane of the
Design Verifier category.

4 In the Configuration Parameters dialog box, select Design
Verifier > Block Replacements.

5 On the Block Replacements pane, select Apply block replacements to
enable block replacements.

Selecting this check box provides access to the List of block replacement
rules (in order of priority) and File path of the output model options.

6 To execute your custom block replacement rule, follow these steps:

a In the List of block replacement rules (in order of priority) box,
delete:

<FactoryDefaultRules>
b Enter:

custom_rule_switch

4-17
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The Simulink Design Verifier software replaces a block in your model only
once. If multiple rules apply to the same block, the software replaces the
block using the rule with the highest priority.

7 In the File path of the output model field, accept the default to create a
model named my_sldvdemo param_identification_replacement. This
model is a copy of the original model and includes the block replacements.

By default, this software creates a model named
$ModelName$_replacement, where $ModelName$ is the name of the model
it is analyzing. To use a different name for the model with the block
replacements, enter the name in this field. You do not need to include a

file extension.
8 Click Apply.

9 Save the my_sldvdemo_param_identification model.

Replace Blocks in a Model

e “Replace Blocks and Analyze Model with the Block Replacements” on page
4-18

e “Perform the Block Replacements Only” on page 4-19

Replace Blocks and Analyze Model with the Block
Replacements

After enabling the Apply block replacements option, you can start a
Simulink Design Verifier analysis that analyzes the model after executing the
block replacements. To trigger block replacements and start the analysis, do
one of the following:

e Select Analysis > Design Verifier > Options, and on the Design
Verifier pane, click Generate Tests.

¢ In the Model Editor, select Analysis > Design Verifier > Generate
Tests > Model.
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Note If your model has unsaved changes, the Simulink Design Verifier
software asks if you want to save the model before executing the block
replacements.

The Simulink Design Verifier software copies your model, replaces blocks in
the copy, without altering the original model, and analyzes the model with
the replacements.

Upon completing its analysis, you can generate a detailed analysis report
that includes information about the block replacements it executed. For
each block replacement, you can follow a link from the report to the block
replacement in the model copy, saved using the name you specified on
the Design Verifier > Block Replacements pane of the Configuration
Parameters dialog box.

Perform the Block Replacements Only

Replacing the blocks in a model before running the analysis can help you debug
the custom block replacement rules. Once the block replacement rules are
working as you want, analyze the model that contains the block replacements.

To perform only the block replacements, without analyzing the model with
the block replacements, at the command line or from a program, use the
sldvblockreplacement function. Set two parameters of the sldvoptions
structure related to replacing blocks, and call sldvblockreplacement as
follows:

opts = sldvoptions;

opts.BlockReplacement = 'on'

opts.BlockReplacementRulesList =
‘custom_rule_switch, <FactoryDefaultRules>';

[status, newmodelH] = sldvblockreplacement(...
‘my_sldvdemo_param_identification', opts);

If you execute block replacements programmatically, in the MATLAB
Command Window, the Simulink Design Verifier software displays a table
that lists available block replacement rules and opens the copy of the model
that contains the block replacements ($Mode1Name$ replacement).
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The table lists all built-in rules and any custom rules that you specified
using the List of block replacement rules (in order of priority) option
(see “Configure Block Replacements” on page 4-17). The table includes the
following information:

Type

Type of rule, either built-in or custom

Registration MATLAB File name

Name of the file that expresses the rule

Block types

BlockType parameter value of the block that the rule replaces

Priority
Priority of execution when multiple rules target the same type of block

for replacement

Active

Flag that indicates whether the rule 1s active (1) or ignored (0)

The output also displays information about the block replacements. For
example, the output for this example indicates that the software used the
custom_rule switch.mrule to replace a Multiport Switch block (of the same
name) at the top level of the model.



Specifying Parameter
Configurations

e “Parameters as Variables in Simulink® Design Verifier™ Analysis” on
page 5-2

e “Define Parameters as Variables” on page 5-3

e “Specify Parameters as Variables for Full Coverage” on page 5-9
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Parameters as Variables in Simulink Design Verifier

Analysis

The Simulink Design Verifier software can treat block parameters in your
model as variables during its analysis. For example, suppose you specify a
variable that is defined in the MATLAB workspace as the value of a block
parameter in your model. You can instruct the Simulink Design Verifier
software to treat that parameter as another input variable in its analysis.
This allows you to

¢ Extend the results of a error detection analysis property proof to consider
the impact of additional parameter values.

¢ Generate comprehensive test cases for situations in which parameter values
must vary to achieve more complete coverage results (for an example, see
“Specify Parameters as Variables for Full Coverage” on page 5-9).

Note When you configure Simulink Design Verifier to treat parameters as
variables in its analysis, you cannot also use the analysis to extend existing
test cases. In Analysis > Design Verifier > Options, if you specify your
model to extend existing test cases with a Data file and apply parameter
configurations with a Parameter configuration file, when you attempt to
perform Simulink Design Verifier analysis, the software reports that your
model is incompatible. This occurs because the existing test cases do not
include corresponding parameter values.
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Define Parameters as Variables

In this section...

“Template for Defining Parameters as Variables” on page 5-3

“Syntax for Defining Parameters” on page 5-3

“Data Types in Parameter Configuration Files” on page 5-7

Template for Defining Parameters as Variables

You define parameter configurations in a MATLAB function. The Simulink
Design Verifier software provides an annotated template that you can use as
a starting point:

matlabroot/toolbox/sldv/sldv/sldv_params_template.m

To create a parameter configuration file, make a copy of the template and
edit the copy. The comments in the template explain the syntax for defining
parameter configurations.

To associate the parameter configuration file with your model before
analyzing the model, in the Configuration Parameters dialog box, on the
Design Verifier > Parameters pane, enter the file name in the Parameter
configuration file field.

Syntax for Defining Parameters

You specify parameter configurations using a structure whose fields share the
same names as the parameters that you treat as input variables.

For example, suppose you want to constrain the Gain and Constant value
parameters, m and b, which appear in the following model:
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[Variables m and b are defined in the MATLAB workspace. .

The PreLoadFcn callback function defines m and b in the MATLAB workspace
when you open the model:

® mis set to 5.

® bisaSimulink.Parameter object of type int8 whose value is set to 5.



Define Parameters as Variables
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- PreLoadFcn™
- PostLoadFcn
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- ContinuefFcn
- StopFcn

- PreSaveFcn
- PostSaveFcn
- CloseFcn

Model pre-load function:

m= 35;

b = Simulink.Parameter;
b.DataType = 'intd';
b.\alue = int8(5);

0K H Cancel H Help Apply

In your parameter configuration file, specify constraints for m and b:

params.b = int8([4 10]);

params.m = {};

This file specifies:

® bis an 8-bit signed integer from 4 to 10. The constraint type must match the
type of the parameter b in the MATLAB workspace, int8, in this example.
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® mis not constrained to any values.

Specify points using the S1dv.Point constructor, which accepts a single value
as its argument. Specify intervals using the Sldv.Interval constructor,
which requires two input arguments, 1.e., a lower bound and an upper bound
for the interval. Optionally, you can provide one of the following strings as

a third input argument that specifies inclusion or exclusion of the interval
endpoints:

e '()' — Defines an open interval.

o '[]' — Defines a closed interval.

e '(]1' — Defines a left-open interval.
e '[)' — Defines a right-open interval.

Note By default, the Simulink Design Verifier software considers an interval
to be closed if you omit its two-character string.

The following example constrains m to 3 and b to any value in the closed
interval [0, 10]:

params.m = Sldv.Point(3);
params.b Sldv.Interval(0, 10);

If the parameters are scalar, you can omit the constructors and instead specify
single values or two-element vectors. For example, you can alternatively
specify the previous example as:

params.m = 3;
params.b [0 10];

Note To indicate no constraint for an input parameter, specify params.m =
{} or params.m = []. The analysis treats this parameter as free input.
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You can specify multiple constraints for a single parameter using a cell
array. In this case, the analysis combines the constraints using a logical
OR operation.

The following example constrains m to either 3 or 5 and constrains b to any
value in the closed interval [0, 10]:

params.m = {3, 5};
params.b = [0 10];

You can specify several sets of parameters by expanding the size of your
structure. For example, the following example uses a 1-by-2 structure to
define two sets of parameters:

params(1).m = {3, 5};
params(1).b [0 10];

params(2).
params(2).

3
1l

{12, 15, Sldv.Interval(50, 60, '()')};
_5;

(on
|

The first parameter set constrains m to either 3 or 5 and constrains b to any
value in the closed interval [0, 10]. The second parameter set constrains m to
either 12, 15, or any value in the open interval (50, 60), and constrains b to 5.

Data Types in Parameter Configuration Files

Consider the following issues related to data types when constraining
parameter values in the parameter configuration file:

* “Parameters Cannot Be Structures” on page 5-7
* “Parameters Converted to Fixed Point in the Model” on page 5-8

e “Parameters Defined as Simulink.Parameter and Referenced by Multiple
Locations” on page 5-8

Parameters Cannot Be Structures

If the data type of a parameter in the MATLAB workspace is struct,
Simulink Design Verifier cannot generate values for that parameter during
the analysis. However, Simulink Design Verifier can generate values for
parameters that are not structs.

5-7
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Parameters Converted to Fixed Point in the Model

If your model references a base workspace parameter whose data type

is auto, single, or double, and the model converts that parameter to a
fixed-point data type, you must define the constraints for that parameter in
the parameter configuration file according to its fixed-point type.

Parameters Defined as Simulink.Parameter and Referenced by
Multiple Locations

For a parameter defined as Simulink.Parameter or an inherited class of
Simulink.Parameter whose data type is auto, if the parameter is referenced
by multiple locations with different data types, Simulink Design Verifier
cannot generate values for that parameter during the analysis.
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Specify Parameters as Variables for Full Coverage

In this section...

“About This Example” on page 5-9

“Construct the Example Model” on page 5-10
“Parameterize the Constant Block” on page 5-11
“Preload the Workspace Variable” on page 5-12
“Specify a Parameter Configuration” on page 5-13
“Analyze the Example Model” on page 5-14

“Simulate Test Cases” on page 5-17

About This Example

This example describes how to create and analyze a simple Simulink model,
for which you generate test cases that achieve decision coverage. However, in
this example, achieving complete decision coverage is possible only when the
Simulink Design Verifier software treats a particular block parameter as a
variable during its analysis. This example explains how to specify parameter
configurations for use with the analysis.

The following workflow guides you through the process of completing this

example.

Task | Description See...

1 Construct the example “Construct the Example Model” on
model. page 5-10

2 Specify a variable as the “Parameterize the Constant Block”
value of a Constant block on page 5-11
parameter.

3 Constrain the value of the “Specify a Parameter Configuration”
variable that the Constant | on page 5-13
block specifies.
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Task | Description See...

4 Generate test cases for your | “Analyze the Example Model” on page
model and interpret the 5-14
results.

5 Simulate the test cases “Simulate Test Cases” on page 5-17
and measure the resulting
decision coverage.

Construct the Example Model

Construct a simple Simulink model to use in this example:

1 Create an empty Simulink model.

2 Copy the following blocks into your empty model window:
¢ From the Sources library:
= Two Inport blocks to initiate the input signals
- A Constant block to control the switch

¢ From the Signal Routing library: A Multiport Switch block to provide
simple logic

¢ From the Sinks library: An Outport block to receive the output signal

3 Double-click the Multiport Switch block to access its dialog box and specify
its Number of data ports option as 2.

4 Connect the blocks so that your model looks like the following.
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5 Select Simulation > Model Configuration Parameters.

6 In the Select tree on the left side of the Configuration Parameters dialog
box, select the Solver node. Under Solver options, set the Type option to
Fixed-step, and then set the Solver option to discrete (no continuous
states).

7 Click OK to apply your changes and close the Configuration Parameters
dialog box.

8 Save your model as ex_defining params_example for use in the next
procedure.

Parameterize the Constant Block

Parameterize the Constant block in your model by specifying a variable as the
value of the Constant block’s Constant value parameter:

1 Double-click the Constant block.

2 In the Constant value box, enter A.

5-11
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3 Click OK to apply your change and close the Constant block parameter
dialog box.

4 Save your model for use in the next step.

Preload the Workspace Variable
Preload the value of the MATLAB workspace variable A referenced by the
Constant block:

1 Select File > Model Properties > Model Properties.
2 Click the Callbacks tab.
3 In the PreLoadFcn, enter:
A = int8(1);
4 Click OK to close the Model Properties dialog box and save your changes.
5 Close your model.

6 Open your model again for use in the next step.

When you open the model, the PreLoadFcn defines a variable A of type
int8 whose value is 1.
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Specify a Parameter Configuration

Create the parameter configuration file so that it constrains the variable A,
and configure the analysis to use this file:

1 In the model window, select Analysis > Design Verifier > Options.

The Simulink Design Verifier software options appear in the Configuration
Parameters dialog box.

2 In the Select tree on the left side of the Configuration Parameters dialog
box, under Design Verifier, select the Parameters node.

3 Under Parameters, select Apply parameters.
Enabling the Apply parameters option provides access to the Parameter
configuration file option; the file name sldv_params_template.m

appears in the text box.

4 Next to the Parameter configuration file box, click the Edit button.

5-13



5 Specifying Parameter Configurations

5-14

The Simulink Design Verifier software opens sldv_params_template.min
the MATLAB Editor.

5 Replace the existing content with the following:

function params = params_example_function
% This function defines a parameter configuration for the
% example model that the documentation discusses.

params.A = int8([1 2]);

This code defines a function params_example function that constrains
the parameter A to the int8 values 1 and 2.

6 Save your changes to the template as params_example function.m in the
same folder as the example model.

7 Close the MATLAB Editor.

8 In the Configuration Parameters dialog box, next to the Parameter
configuration file box, click Browse. Select your saved parameter
configuration file, params_example_function.m.

9 Click OK to apply your change and close the Configuration Parameters
dialog box.

10 Save your model for use in the next step.

Analyze the Example Model

Analyze the model using the parameter configuration file you just created and
generate the analysis report:

1 In the model window, select Analysis > Design Verifier > Generate
Tests > Model.

The Simulink Design Verifier software begins analyzing your model to
generate test cases.

2 When the software completes its analysis, in the log window, select
Generate detailed analysis report.
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The Simulink Design Verifier software displays an HTML report named
ex_defining_params_example_report.html.

Keep the log window open for the next procedure.

3 In the Simulink Design Verifier report Table of Contents, click Test
Cases.

4 Click Test Case 1 to display the subsection for that test case.

Test Case 1

Summary

Length: 0 second (1 sample period)

Objectives |

Satisfied:

Objectives

Step [Time Model Item Objectives

1 0 Multiport Switch integer input value = 1 (output is from input

port 1)
Generated Parameter Values

Parameter Value
A 1

Generated Input Data

Time |0
Step 1
Inl -
In2 -
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This section provides details about Test Case 1 that the Simulink Design
Verifier software generated to satisfy a coverage objective in the model. In
this test case, a value of 1 for parameter A satisfies the objective.

5 Scroll down to the Test Case 2 section in the Test Cases chapter.

Test Case 2
Summary
Length: 0 second (1 sample period)
Objectives |
Satisfied:
Objectives
Step [Time NModel Item Objectives
i i b = #* i
| 0 Multiport Switch integer input value = *,2 (output is from

input port 2)
Generated Parameter Values

Parameter|(Value
A 2

Generated Input Data

Time |0
Step 1
Inl -
In2 -

This section provides details about Test Case 2, which satisfies another
coverage objective in the model. In this test case, a value of 2 for parameter
A satisfies the objective.



Specify Parameters as Variables for Full Coverage

Simulate Test Cases

Simulate the generated test cases and review the coverage report that results
from the simulation:

1 In the Simulink Design Verifier log window, select Create harness model.

The software creates and opens a harness model named
ex_defining_params_example_harness.

2 The block labeled Inputs in the harness model is a Signal Builder block
that contains the test case signals. Double-click the Inputs block to view
the test case signals in the Signal Builder block.
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n Signal Builder (ex_defining_params_example_harness/Inputs) EI@
File Edit Group Signal Axes Help N
SH| s BE oo —~T0|EFQEE > 0 = 5|
Active Group: Test Case 1 'v': @‘_ - E
S
In1
L R e e S Rt
0 : 9
{:|.5_ ___________________ L e e E __________ e e e 4
1 | | | | i | | |
In2 ;
05 __________.__________4__________‘__________L__________.__________d: ____________________________________________
0 Z
T T T
Py | | | | | I | | I I
0 01 0.2 0.3
Left:Point
InZ {shown)
Name: ||n1 T T:
Index: 1 v: Y Yz
ok In1 (#1) [*Min ¥Max ]

3

all
In the Signal Builder dialog box, click the Run all button L)

The Simulink software simulates each of the test cases in succession,
collects coverage data for each simulation, and displays an HTML report of
the combined coverage results at the end of the last simulation.
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4 In the model coverage report, review the Summary section:
Summary

Model Hierarchyv/Complexity:

D1
1. ex defining params example harness 2 100% —
2. ... Test Unit (copied from ex_defining params example) 1 100%

This section summarizes the coverage results for the harness model and its
Test Unit subsystem. Observe that the subsystem achieves 100% decision
coverage.

5 In the Summary section, click the Test Unit subsystem.

The report displays detailed coverage results for the Test Unit subsystem.
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2. SubSystem block "Test Unit (copied from ex defining param..."

Parent: /ex definine params example harness
Metric Coverage (this object) Coverage (Inc.
g ] descendants)
Cyclomatic Complexity 0 1
Decision (D1) NA 100% (2/2) decision outcomes

MultiPortSwitch block "Multiport Switch"

ex defining params example harness/Test Unit (copied from

Parent: ex defining params example)
Metric Coverage

Cyclomatic Complexity 1

Decision (D1) 100% (2/2) decision outcomes

Decisions analyzed:

integer input value 100%
=1 (output is from input port 1) 2/4
= *.2 (output is from input port 2) 2/4

This section reveals that the Multiport Switch block achieves 100% decision
coverage because the test cases exercise each of the switch pathways.
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e “What Is Design Error Detection?” on page 6-2

¢ “Derived Ranges in Design Error Detection” on page 6-3

¢ “Run a Design Error Detection Analysis” on page 6-5

¢ “Detect Dead Logic” on page 6-9
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on page 6-29

¢ “Detect Out of Bound Array Access Errors” on page 6-37



6 Detecting Design Errors

6-2

What Is Design Error Detection?

Design error detection is a Simulink Design Verifier analysis mode that
detects the following types of errors:

Dead logic
Integer or fixed-point data overflow
Division by zero

Intermediate signal values that are outside the specified minimum and
maximum values

Out of bound array access

Before you simulate your model, analyze your model in design error detection
mode to find and diagnose these errors. Design error detection analysis
determines the conditions that cause the error, helping you identify possible
design flaws. Design error detection analysis also computes a range of signal
values that can occur for block outports and Stateflow local data in your model.

After the analysis, you can:

Click individual blocks to view the analysis results for that block.
Create a harness model containing test cases that demonstrate the errors.

Create an analysis report that contains detailed results for the entire model.
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Derived Ranges in Design Error Detection

When you specify minimum and maximum values for a signal or data in a
model, these values define a design range.

During design error detection, the software analyzes the model behavior and
computes the values that can occur during simulation for:

® Block Outports

o Stateflow local data

The range of these values is called a derived range.

The Use specified input minimum and maximum values parameter in
the Configuration Parameters dialog box, on the Design Verifier pane, if
enabled, tells the analysis to consider the design ranges on the model input
ports as constraints when calculating the derived ranges. By default, the Use
specified input minimum and maximum values parameter is enabled.

If Use specified input minimum and maximum values is disabled, the
software does not restrict the signals when computing the derived ranges.

To see how this process works, consider the following model.

double [25.25] double [10.30]
13} | f——»(1 )

In1 Ot
Abs

Y

In this model, the design ranges are:

¢ Inport block: [-25..25]
e Abs block output: [10..30]
Given the design range on the Inport block, the only possible values for the

Abs block output are values from 0 to 25. Therefore, the derived range for
the Abs block is [0..25].
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However, if you disable the Use specified input minimum and maximum
values parameter, the analysis calculates the derived ranges based on
unrestricted values of the input ports of the model. In the preceding

model, the only valid outputs of the Abs block are nonnegative numbers.
Consequently, the derived range for the Abs block is [0..Inf].
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Run a Design Error Detection Analysis

In this section...

“Workflow for Detecting Design Errors” on page 6-5
“Understand the Analysis Results” on page 6-5

“Review the Latest Analysis Results in the Model Explorer” on page 6-8

Workflow for Detecting Design Errors

To analyze your model for design errors, use the following workflow:

1 Verify that your model is compatible with Simulink Design Verifier
software.

2 If you have Stateflow objects in your model, in the Configuration
Parameters dialog box, on the Diagnostics > Stateflow pane, set
Transition shadowing to error.

3 Specify options that control how Simulink Design Verifier detects design
errors in your model.

4 Execute the Simulink Design Verifier analysis.

5 Review the analysis results.

Note If you select design error detection for dead logic, you cannot select any
other type of design error detection. For dead logic detection, Simulink Design
Verifier performs an independent analysis. If you want to detect design errors
for dead logic and any of the other types of design errors, you must perform
design error detection analysis twice.

Understand the Analysis Results

When you run a design error detection analysis, by default, the software
highlights model objects in one of four colors so that the analysis results are
easy to review.
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Model Object
Highlighting
Color

Analysis Results

Green

One of the following:

¢ The analysis did not find overflow or division-by-zero
errors.

¢ The analysis did not find dead logic.

¢ The analysis did not find intermediate or output
signals outside the range of user-specified minimum
and maximum constraints.

¢ The analysis did not find out of bound array access
errors.

Red

One of the following:

¢ The analysis found at least one test case that causes
overflow or division-by-zero errors.

® The analysis found dead logic.

¢ The analysis found intermediate or output signals
outside the range of user-specified minimum and
maximum constraints.

¢ The analysis found at least one test case that causes
an out of bound array access error.

Orange

6-6

For at least one objective, the analysis could not
determine if the model has dead logic, overflow
errors, division-by-zero errors, signals outside the
user-specified range, or out of bound array access
errors. This situation can occur when:

® The analysis times out.

e The software cannot determine if an error occurred
or not. This result is due to:
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Model Obiject Analysis Results
Highlighting
Color
= Automatic stubbing errors; for more information,
see “Handle Incompatibilities with Automatic
Stubbing” on page 2-8.
= Limitations of the analysis engine.
Gray The model object was not part of the analysis.

The Simulink Design Verifier Results window initially displays a summary of
the analysis results, as in the following example.

.

£t
Close results
Design error detection completed normally
6 of 8 objectives proven valid
2 of 8 objectives falsified

Eﬁimulink Design Verifier Results EI@
- B

Results:

* Generate detailed analysis report
* Create harness model

When you click an object in the model, additional details about the results for
that object are displayed in the Simulink Design Verifier Results window.

Tip By default, the Simulink Design Verifier Results window is always the

topmost visible window. To change that setting, click the icon and on the
context menu, clear the check mark next to Always on top.
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Review the Latest Analysis Results in the Model
Explorer

If you close the analysis results to fix the cause of the errors in your model,
you might need to rereview the analysis results. As long as your model

remains open, you can view the results of your most recent analysis results in
the Model Explorer.

After you close your model, you can no longer view any analysis results.

To view the latest results, in the model window, select Analysis > Design
Verifier > Latest Results. The Model Explorer opens with the results
displayed on the right-hand pane.

For any Simulink Design Verifier analysis, from the Model Explorer, you can
perform the following tasks:

e Highlight the analysis results on the model.

® Generate a detailed analysis report.

¢ (Create the harness model, or if the harness model already exists, open it.

Note If no objectives are falsified, you cannot create the harness model.

® View the data file.
® View the log file.
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Detect Dead Logic

In this section...

“Overview of Dead Logic Detection” on page 6-9
“Detect Dead Logic in Example Model” on page 6-9
“Review Analysis Results for Example Model” on page 6-10

“Review Analysis Report for Example Model” on page 6-11

Overview of Dead Logic Detection

During a design error detection analysis, Simulink Design Verifier can detect
dead logic in your model. Logic is considered dead if it is proven through
analysis to stay inactive during execution. Dead logic might be caused by a
design or a requirement error.

To conduct design error detection analysis for dead logic:

1 In the Configuration Parameters dialog box, on the Design
Verifier > Design Error Detection pane, select Dead Logic.

2 Select Analysis > Design Verifier > Detect Design Errors.

Detect Dead Logic in Example Model

This example shows how to analyze the sldvdemo_fuelsys logic_simple
model for dead logic.

1 To open the example model, at the MATLAB command prompt, type:

sldvdemo_fuelsys_logic_simple

2 Select Analysis > Design Verifier > Options.

3 In the Configuration Parameters dialog box, select Design Verifier
> Design Error Detection.

4 On the Design Error Detection pane, enable Dead Logic.
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When you select Dead Logic, the other Design Error Detection analysis
options are inactive.

5 Close the Configuration Parameters dialog box.
6 Select Analysis > Design Verifier > Detect Design Errors > Model.

After the analysis:
® The software highlights the model with the analysis results.

® The Simulink Design Verifier Results dialog box opens and displays a
summary of the analysis.

Review Analysis Results for Example Model

This example shows how to review the analysis results when you detect dead
logic in the sldvdemo_fuelsys logic_simple model.

1 To review the model analysis results, at the top level of the
sldvdemo_fuelsys logic_simple model, open the control logic
Stateflow chart.

® Model objects with active logic are highlighted in green.
® Model objects with dead logic are highlighted in red.

2 In the sldvdemo_fuelsys logic_simple/control logic window, click
the Sens_Failure_Counter.INC transition in the Speed_Sensor_Mode
state.
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Speed_Sensor_Mode \
_'_,_,_,—o—'—'__'_____‘__———._
peed==0 & press < zero_thresh]/
I Sens_Failure_CounterINC
| speed_norm speed_fail
entry: fail_state[SPEED] = 0 entry: fail_state[SPEED] = 1
V' [speed >0
. Sens_Failure_Counter DEC d
.“‘ e S e —— _)

The Simulink Design Verifier Results dialog box displays a summary of the
active and dead logic for the transition.

it - G
Back to summary - Close results
control logic.Speed_Sensor_Mode."[speed==0 & press =

zero_th.."”
Transition: Condition 1, "speed==0"T ACTIVE LOGIC
Transition; Condition 1, "speed==0"F ACTIVE LOGIC

Transition; Condition 2, "press < zero_thresh™ T ACTIVE LOGIC
Transition; Condition 2, "press < zero_thresh™F DEAD LOGIC

Transition: Transition trigger expression F ACTIVE LOGIC
Transition: Transition trigger expression T ACTIVE LOGIC

Review Analysis Report for Example Model

This example shows how to generate an analysis report after you detect dead
logic in the sldvdemo_fuelsys logic_simple model. The analysis report is
an HTML file that provides detailed information about the analysis.

1 In the Simulink Design Verifier Results window, click Back to summary.
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2 Click Generate detailed analysis report.
The software generates a detailed analysis report that opens in a browser.
3 In the analysis report, click Design Error Detection Objectives Status.

For sldvdemo fuelsys logic_simple model, the Design Error
Detection Objectives Status chapter of the report provides detailed
results in two categories:

® Dead Logic — Simulink Design Verifier proved the decision and
condition outcomes listed in the table that cannot occur and are dead
logic.

e Active Logic — Simulink Design Verifier found the decision and
condition outcomes listed in the table that can occur and are active logic.
4 Investigate the analysis results for Sens_Failure_Counter.INC:

¢ In the analysis report, in the Analysis Information chapter, the
Constraints section lists the constraints for control logic/Input
Data "press". The value of press is constrained to values between
0 and 2.

¢ In the Model Explorer window, select Base Workspace > zero_thresh.
The value of zero_thresh is 250.

® With the design constraints, press is always less than zero_thresh.
The logic press < zero_thresh is never false. The false condition for
the transition is never exercised. Therefore, it is dead logic.

5 Close sldvdemo_fuelsys_logic_simple.
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Model Objects That Receive Dead Logic Detection

Model objects that have decision or condition outcomes receive dead logic
detection, as the following table shows. Click a link in the first column to get
more detailed information about the outcomes for specific model objects.

Model Object Receiving Dead | Decision Condition
Logic Detection Outcomes Outcomes
“Abs” on page 6-14 °

“Dead Zone” on page 6-14 ]

“Discrete-Time Integrator” on °

page 6-15

“Enabled Subsystem” on page ° °

6-16

“Enabled and Triggered ° °
Subsystem” on page 6-16

“Fcn” on page 6-17 °

“For Iterator, For Iterator °

Subsystem” on page 6-17

“If, If Action Subsystem” on page | ® °
6-17

“Library-Linked Objects” on page | ® °
6-17

“Logical Operator” on page 6-17 °
“MATLAB Function” on page 6-18 °
“MinMax” on page 6-18

“Model” on page 6-18 °

“Multiport Switch” on page 6-18

“Rate Limiter” on page 6-19

“Relay” on page 6-19

“Saturation” on page 6-20
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Model Object Receiving Dead | Decision Condition
Logic Detection Outcomes Outcomes
“Stateflow Charts” on page 6-20 ° °

“Switch” on page 6-21 °

“SwitchCase, SwitchCase Action | ®
Subsystem” on page 6-21

“Triggered Models” on page 6-21 ° °
“Triggered Subsystem” on page ° °
6-21

“While Iterator, While Iterator °
Subsystem” on page 6-22

Abs

The Abs block has decision outcomes based on:

® Input to the block being less than zero.
¢ Data type of the input signal.

For input to the block being less than zero, there are two decision outcomes:

® Block input is less than zero, indicating a true decision.
¢ Block input is not less than zero, indicating a false decision.
If the input data type to the Abs block is uint8, uint16, or uint32, the

software sets the block output equal to the block input without making a
decision. If the input data type to the Abs block is Boolean, an error occurs.

Dead Zone

The Dead Zone block has decision outcomes based on these parameters:

e Start of dead zone

e End of dead zone
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The Start of dead zone parameter specifies the lower limit of the dead zone.
For the Start of dead zone parameter, there are two decision outcomes:

® Block input is greater than or equal to the lower limit, indicating a true
decision.

¢ Block input is less than the lower limit, indicating a false decision.

The End of dead zone parameter specifies the upper limit of the dead zone.

For the End of dead zone parameter, there are two decision outcomes:

® Block input is greater than the upper limit, indicating a true decision.

® Block input is less than or equal to the upper limit, indicating a false
decision.

Discrete-Time Integrator

The Discrete-Time Integrator block has decision outcomes based on these
parameters:

e External reset

¢ Limit output

If you set External reset to none, the software does not report decision
outcomes. Otherwise, there are two decision outcomes:

® Block output is reset, indicating a true decision.

® Block output is not reset, indicating a false decision.

If you do not select Limit output, the software does not report decision
outcomes. Otherwise, the software reports decision outcomes for the Lower
saturation limit and the Upper saturation limit.

For the Upper saturation limit, there are two decision outcomes:

® Integration result is greater than or equal to the upper limit, indicating
a true decision.
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® Integration result is less than the upper limit, indicating a false decision.
For the Lower saturation limit, there are two decision outcomes:
® Integration result is less than or equal to the lower limit, indicating a true

decision.

® Integration result is greater than the lower limit, indicating a false decision.

Enabled Subsystem

The Enabled Subsystem block has two decision outcomes:

® Block is enabled, indicating a true decision.

® Block is disabled, indicating a false decision.

The Enabled Subsystem block has two condition outcomes only if the enable
input is a vector:

¢ Element of the enable input is true, indicating a true condition.

¢ Element of the enable input is false, indicating a false condition.

Enabled and Triggered Subsystem

The Enabled and Triggered Subsystem block has two decision outcomes:

® Trigger edge occurs while the block is enabled, indicating a true decision.
* Trigger edge does not occur while the block is enabled, or the block is

disabled, indicating a false decision.

The software determines condition outcomes for the enable input and the
trigger input separately.
® For the enable input:
= Input is true, indicating a true condition.
= Input is false, indicating a false condition.
® For the trigger input:

= Trigger edge occurs, indicating a true condition.
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= Trigger edge does not occur, indicating a false condition.

Fcn
The Fen block has two condition outcomes based on input values or arithmetic

expressions that are inputs to Boolean operators in the block:
® Input to a Boolean operator is true, indicating a true condition.

® Input to a Boolean operator is false, indicating a false condition.

For Iterator, For lterator Subsystem
The For Iterator block and For Iterator Subsystem have two decision

outcomes:
® [teration value being at or below the iteration limit, indicated as true.

¢ [teration value being above the iteration limit, indicated as false.

If, If Action Subsystem

The If blocks that causes an If Action Subsystem to execute has:

® Decision outcomes for the if condition and all elseif conditions defined in
the If block.

¢ Condition outcomes if the if condition or any of the elseif conditions
contains a logical expression with multiple conditions.

Library-Linked Objects

Simulink blocks and Stateflow charts that are linked to library objects receive
the same dead logic detection that they would receive if they were not linked
to library objects.

Logical Operator
The Logical Operator block has two condition outcomes:

¢ Input is true, indicating a true condition.

e Input is false, indicating a false condition.
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MATLAB Function

The following MATLAB Function block statements have decision outcomes:

e Function header - Function or sub-function that is executed.

e if - Expression evaluates to true, indicating a true decision. Expression
evaluates to false, indicating a false decision.

® switch - Decision outcomes corresponding to every switch case path,
including the fall-through case.

® for - Loop condition evaluates to true, indicating a true decision. Loop
condition evaluates to false, indicating a false decision.

® while - Loop condition evaluates to true, indicating a true decision. Loop
condition evaluates to false, indicating a false decision.

The following logical conditions have condition outcomes:

e if statement conditions

® while statement conditions

MinMax

The MinMax block has decision outcomes based on passing each input to
the output of the block.

For passing each input to the output of the block, there are two decision
outcomes:
® Input passed to block output, indicating a true decision.

¢ Input not passed to block output, indicating a false decision.

Model

The Model block itself does not have decision or condition outcomes. The
model that the block references receive the decision or condition outcomes.

Multiport Switch

The Multiport Switch block has decision outcomes based on passing each
input, excluding the first control input, to the output of the block.
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For passing each input, excluding the first control input, to the output of the
block, there are two decision outcomes:

¢ Input passed to block output, indicating a true decision.

® Input not passed to block output, indicating a false decision.

Rate Limiter

The Rate Limiter block has decision outcomes based on the Rising slew rate
and Falling slew rate parameters.

For the Rising slew rate, there are two decision outcomes:

® Block input changes more than or equal to the rising rate, indicating a
true decision.

¢ Block input changes less than the rising rate, indicating a false decision.
For the Falling slew rate, there are two decision outcomes:

® Block input changes less than or equal to the falling rate, indicating a
true decision.

¢ Block input changes more than the falling rate, indicating a false decision.

The software does not have Falling slew rate outcomes for a time step when
the Rising slew rate is true.

Relay

The Relay block has decision outcomes based on the Switch on point and
the Switch off point parameters.

For the Switch on point, there are two decision outcomes:

® Block input is greater than or equal to the Switch on point, indicating
a true decision.

® Block input is less than the Switch on point, indicating a false decision.

For the Switch off point, there are two decision outcomes:
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® Block input is less than or equal to the Switch off point, indicating a
true decision.

¢ Block input is greater than the Switch off point, indicating a false
decision.

The software does not have Switch off point decision outcomes for a time
step when the switch on threshold is true.

Saturation

The Saturation block has decision outcomes based on the Lower limit and
Upper limit parameters.

For the Upper limit, there are two decision outcomes:

® Block input is greater than or equal to the upper limit, indicating a true
decision.

® Block input is less than the upper limit, indicating a false decision.
For the Lower limit, there are two decision outcomes:

® Block input is greater than the lower limit, indicating a true decision.

¢ Block input is less than or equal to the lower limit, indicating a false
decision.

The software does not have Lower limit decision outcomes for a time step
when the upper limit is true.

Stateflow Charts
The Stateflow Chart block has decision outcomes:

* Transition decision is evaluated as true, indicating a true decision.

* Transition decision is evaluated as false, indicating a false decision.
The Stateflow Chart block has condition outcomes:

® (Condition is evaluated as true, indicating a true condition.
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® (Condition is evaluated as false, indicating a false condition.

Switch

The Switch block has decision outcomes based on the control input to the
block.

For the control input to the block, there are two decision outcomes:

¢ (Control input evaluates to true, indicating a true decision.

® (Control input evaluates to false, indicating a false decision.

SwitchCase, SwitchCase Action Subsystem

The SwitchCase block and SwitchCase Action Subsystem have two decision
outcomes:

® Block evaluates to true, indicating a true decision.

® Block does not evaluate to true, indicating a false decision.

Triggered Models

The Triggered Models block has two decision outcomes:

e Referenced model is triggered, indicating a true decision.

e Referenced model is not triggered, indicating a false decision.
If the trigger input is a vector, then there are two condition outcomes:

¢ Element of the trigger port is true, indicating a true condition.

¢ Element of the trigger port is false, indicating a false condition.

Triggered Subsystem

The Triggered Subsystem block has two decision outcomes:

® Block is triggered, indicating a true decision.

® Block is not triggered, indicating a false decision.
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If the trigger input is a vector, then there are two condition outcomes:

¢ Element of the trigger edge is true, indicating a true condition.

¢ Element of the trigger edged is false, indicating a false condition.

While Iterator, While Iterator Subsystem

The While Iterator block and While Iterator Subsystem have two decision
outcomes:

® while condition is satisfied, indicating a true decision.

® while condition is not satisfied, indicating a false decision.
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Detect Integer Overflow and Division-by-Zero Errors

In this section...

“About This Example” on page 6-23
“Analyze the Model” on page 6-23
“Review the Analysis Results” on page 6-24

“Limitation of Integer Overflow Detection” on page 6-28

About This Example

The following sections describe how to analyze the
sldvdemo_cruise_control fxp_fixed model for integer overflow and
division-by-zero errors.

Analyze the Model

Open and check model for integer overflow and division-by-zero errors:

1 Open the sldvdemo_cruise_control fxp_ fixed model.
2 Select Analysis > Design Verifier > Options.

3 In the Configuration Parameters dialog box, in the Select tree under
Design Verifier, select the Design Exrror Detection node.

4 On the Design Error Detection pane, select:
¢ Integer overflow
¢ Division by zero
5 In the Configuration Parameters dialog box, on the Diagnostics > Data
Validity pane, set both Signals > Detect overflow and
Parameters > Detect overflow to error.

6 Click OK to save these settings and close the Configuration Parameters
dialog box.

7 Select Analysis > Design Verifier > Detect Design Errors > Model.
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When the analysis is complete:

® The software highlights the model with the analysis results.

® The Simulink Design Verifier Results dialog box opens and displays a
summary of the analysis.

Review the Analysis Results

e “Review the Results on the Model” on page 6-24
e “Review the Harness Model” on page 6-27
e “Review the Analysis Report” on page 6-27

Review the Results on the Model

The derived ranges can help you understand the source of an error by
identifying the possible signal values, as you can see by taking the following
steps:

1 At the top level of the sldvdemo_cruise control fxp_ fixed model, click
the Fixed-Point Controller subsystem.

The Simulink Design Verifier Results window displays the derived range of
possible signal values for the Outports, as calculated by the analysis:

® The values of Outport 1 (throt) range from —2.6101 to 2.6096.
¢ The values of Outport 2 (target) range from 0 to 256.
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P

@ Simulink Design Verifier Results EI@
Fati v &

Back to summary - Close results

sldvdemo_cruise_control_fxp_fixed /Ficed- Point Controller

Derived Ranges:

Outport 1: [-2.6101..2.6096]
Qutport 2; [0,,256]

2 Click the Outport blocks of the sldvdemo_cruise_control fxp fixed
model to see the same signal bound values.

3 Open the Fixed-Point Controller subsystem.

Two objects in this subsystem are outlined in red. The PI Controller
subsystem is outlined in green.

4 Click the Sum block, outlined in red, that provides the error input to the PI
Controller subsystem.

X sfwlf_Ens

error throt -

Pl Controller

This Sum block can produce an overflow error. The analysis found a test

case that can result in a computation where the output of the Sum block
exceeds the range [-128..128].

6-25



6 Detecting Design Errors

.

"4 Simulink Design Verifier Results o= | ]
v 52

#a%
Back to summary - Close results

sldvdemo_cruise_control_fxp_ficed /Fixed-Point Controller/Sum1
Cwverflow ERROR - View test caze

Derived Ranges:
Qutport 1: [-128..128]

5 To more fully understand this error, click the two blocks that provide the
inputs to the Sum block. In the Simulink Design Verifier Results window,
view their derived ranges:

® The third Outport from the Bus block has a range of [0..256].
® The Outport from the Switch block has a range of [0..256].

You can see that the sum operation for these signal ranges can compute a
value that exceeds the range [-128..128] for the Outport of the Sum block.

The analysis reports the overflow error on the Sum block. The analysis
does not propagate this error and assumes that the Sum block output is
within the valid range for any subsequent computations.

6 Click the PI Controller subsystem, outlined in green. None of the blocks
in the PI Controller subsystem can produce overflow or division-by-zero
errors. When the software analyzes the PI Controller subsystem, it ignores

the overflow error from the Sum block and assumes that the inputs to the
subsystem are valid.

Keep the sldvdemo_cruise_control_fxp_fixed model open. In the next

section, you create the harness model to see the test case that generates the
Sum block overflow error.
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Review the Harness Model

To see the test cases that demonstrate the errors, generate the harness model
from the Simulink Design Verifier Results window:

1 In the sldvdemo_cruise_control_fxp_fixed model, open the Fixed-Point
Controller subsystem.

2 Click the Sum block, outlined in red, that provides the error input to the PI
Controller subsystem.

The Simulink Design Verifier Results window displays information that
an overflow error occurred.

3 In the Simulink Design Verifier Results window, click View test case.

The software creates a harness model containing the test case with the
signal values that cause this overflow error.

In the harness model, the Signal Builder dialog box opens, with Test Case
2 displayed.

4 Click the Start simulation button to simulate the model with this test case.

As expected, the simulation fails due to an overflow error at the Sum block
in the Fixed-Point Controller subsystem.

For more information, see “Simulink® Design Verifier™ Harness Models” on
) g

page 13-17.

Review the Analysis Report

To view an HTML report containing detailed information about the analysis
report for the sldvdemo_cruise_control_fxp_fixed model:

1 In the Simulink Design Verifier Results window, to redisplay the results
summary, click Back to summary.

2 Click Generate detailed analysis report.

The software generates a detailed analysis report that opens in a browser.
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For the sldvdemo_cruise control fxp_fixed model, the Design Error
Detection Objectives Status chapter of the report provides detailed results
In two categories:

® Objectives Proven Valid — Model objects that did not produce errors

® Objectives Falsified with Test Cases — Model objects for which test
cases generated errors

For more information, see “Simulink® Design Verifier™ Reports” on page
13-29.

Limitation of Integer Overflow Detection

Design error detection for integer overflow does not detect overflow for
fixed-point types with nonstandard word length, i.e. a word length that is not
8-bit, 16-bit, or 32-bit.
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Check for Specified Intermediate Minimum and Maximum
Signal Values

In this section...

“Overview of Specified Minimum and Maximum Signal Values” on page 6-29
“About This Example” on page 6-30

“Create the Example Model” on page 6-30

“Analyze the Model” on page 6-32

“Review the Analysis Results” on page 6-33

Overview of Specified Minimum and Maximum
Signal Values

During a design error detection analysis, the software checks the specified
minimum and maximum values on intermediate signals throughout the
model and on the output ports. These values define the design ranges.

The analysis checks for specified minimum and maximum values on:

e Simulink block outputs, with the exception of the limitations described in
the next section

® Simulink.Signal objects

e Stateflow data objects

e MATLAB for code generation data objects

® Global data store writes

If the analysis detects that a signal exceeds the design range, the results

identify where in the model the errors occurred. In addition, you can generate

a harness model that contains test cases that demonstrate how the error
occurred.
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Limitations of Checking Specified Minimum and Maximum
Signal Values
If you analyze a model checking if specified minimum and maximum values

are exceeded, the software cannot check minimum and maximum values
specified on:

® Simulink.BusElement objects.

® Any Mux block with an output connected to a Selector block

e Merge block inputs

To work around this limitation, use a Simulink.Signal object on the
Merge block output and specify the range on the Simulink.Signal object.

Note For information about how a Simulink Design Verifier analysis handles
specified minimum and maximum values on input ports, see “Minimum and
Maximum Input Constraints” on page 11-2.

About This Example

In this section, you create and analyze a model that has specified design
minimum and maximum values on:

¢ The input ports

¢ The output ports of two of the intermediate blocks

The design error detection analysis identifies blocks where the output values
exceed the design range. If the analysis detects this error, this example

demonstrates how the analysis uses the specified minimum and maximum
values when continuing the analysis.

Create the Example Model

Create the model for this example:

1 In the model window, select File > New > Model.
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2 From the Simulink Commonly Used Blocks library, add the following

blocks to the model and assign the indicated parameter values.

Block Tab Parameter Value

Inport Signal Minimum 0
Attributes

Inport Signal Maximum 5
Attributes

Gain Main Gain 5

Gain Signal Output 0
Attributes minimum

Gain Signal Output 20
Attributes maximum

Gain Signal Output data int16
Attributes type

Saturation Main Upper limit 25

Saturation Main Lower limit -25

Saturation Signal Output -25
Attributes minimum

Saturation Signal Output 25
Attributes maximum

Outport No changes

3 Connect the four blocks as shown.

Il

4 To display the specified minimum and maximum values in the model

b—bj‘c—h

ain

Saturation

window, select Display > Signals & Ports > Design Ranges.

5 Select Analysis > Design Verifier > Options.
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6 In the Configuration Parameters dialog box, on the Solver pane, under
Solver options:

a Set Type to Fixed-step.

The Simulink Design Verifier software does not support variable-step
solvers.

b Set Solver to discrete (no continuous states).
7 On the Design Verifier pane, set Mode to Design error detection.

8 On the Design Verifier, Design Error Detection pane:

a Select Check specified intermediate minimum and maximum
values.

b Clear the Integer overflow and Division by zero parameters.

In this example, you check only for intermediate minimum and maximum
violations.

9 To save these settings and exit the Configuration Parameters dialog box,
click OK.

10 Save the model and name it ex_interim_minmax.

Analyze the Model

To analyze the example model to identify any intermediate signals that violate
the specified minimum and maximum values, select Analysis > Design
Verifier > Detect Design Errors > Model.

After the analysis 1s complete:

® The software highlights the model with the analysis results.

[0.5] - [0..20] ) [-25.25]
CoO—r oA —CD

In1 Out

>ain Saturation

¢ The Simulink Design Verifier Results dialog box opens and displays a
summary of the analysis.
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.

Eﬁimulink Design Verifier Results EI@
b - B

Cloze results

Design error detection completed normally
1 of 2 objectives proven valid

1 of 2 objectives falsified

Results:

* Generate detailed analysis report
* Create harness model

Review the Analysis Results

¢ “Review Results on the Model” on page 6-33
e “Review the Harness Model” on page 6-35
e “Review the Analysis Report” on page 6-36

Review Results on the Model

In the model window, the Gain block is colored red and the Saturation block is
colored green. This indicates that:

® At least one objective associated with the Gain block was falsified. For this
example, the analysis falsified exactly one objective.

¢ All objectives associated with the Saturation block were satisfied. For this
example, the analysis satisfied exactly one objective.

To understand these results:

1 Click the Gain block.

The Simulink Design Verifier Results window shows that the design range
for the output was [0..20], but the analysis detected an error and generated
a test case that demonstrates that error. Because the design range for the
input block is [0..5], when the input to the Gain block is 5, the output is 25,
which exceeds the specified maximum value on that port.
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The analysis computes and displays the derived range to help you
understand how the design range was exceeded.

P

"4 Simulink Design Verifier Results o= | ]
v 52

Fati
Back to summary - Close results
ex_interim_minmax /Gain
Design Range : [0..20] ERROR - View test case

Derived Ranges:
Qutport 1: [0..25]

When the software detects an error, the analysis proceeds, but constrains
the signal to the tightest intersection of the design range and the derived
range, which for the Gain block output in this example is [0..20].

2 Click the Saturation block.

The Simulink Design Verifier Results window shows that the output of the
Saturation block never exceeded the design range [-25..25]. The input to

the Saturation block never exceeded [0..20], which is the derived range that
the analysis propagated from the Gain block.

P

¢ Simulink Design Verifier Results =R <=
i - &

Back to summary - Close results
ex_interim_minmax/Saturation
Design Range : [-25..25] VALID

Derived Ranges:
Qutport 1; [0,,20]
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Review the Harness Model

When the analysis completes, you can create a harness model contains the
test cases that result in errors.

For the example model, view the test case that caused the design range error
in the Gain block:

1 After the analysis completes and the model is highlighted, click the Gain
block.

2 In the Simulink Design Verifier Results window, click View test case.

The software creates a harness model named ex_interim_minmax_harness
and opens the Signal Builder block in the harness model that contains
the test case.

In the Signal Builder block, one test case, whose signal value is 5, caused
the output of the Gain block to be 25, which exceeds the specified maximum
of 20.

3 Before you simulate this test case, in the Configuration Parameters dialog
box, on the Diagnostics > Data Validity pane, set Simulation range
checking to warning or error.

Setting this parameter specifies the diagnostic action to take if Simulink
detects signals that exceed specified minimum or maximum values during
simulation.

¢ If you specify warning, the simulation displays a warning message
and continues.

¢ If you specify error, the simulation displays an error message and stops.

4 Click OK to save your change and close the Configuration Parameters
dialog box.

5 In the Signal Builder block window, click Start simulation to simulate
the model with this test case.
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As expected, in the MATLAB window, the simulation displays a warning
or error that the output value of the Gain block exceeds the specified
maximum.

Review the Analysis Report

You can also generate an HTML report containing detailed information about
the analysis report for the ex_interim_minmax model. To create this report,
in the Simulink Design Verifier Results window, click Generate detailed
analysis report. The analysis report opens in a browser.

In the analysis report, the Design Error Detection Objectives Status
chapter of the report provides detailed results in two categories:

® Objectives Proven Valid — The output values for the Saturation block
are always within the design range.

® Objectives Falsified with Test Cases — The output values for the Gain
block violated the design range.
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Detect Out of Bound Array Access Errors

In this section...

“Design Error Detection for Out of Bound Array Access” on page 6-37
“Detect Out of Bound Array Access in Example Model” on page 6-38

“Limitations of Support for Out of Bound Array Access Design Error
Detection” on page 6-44

Design Error Detection for Out of Bound Array Access

Simulink Design Verifier design error detection analysis detects out of bound
array access errors in your model. In simulation, when your model attempts
to access an array element using an invalid index, an out of bound array
access error occurs.

To detect out of bound array access errors in your model:

1 In the Simulink Editor, select Analysis > Design Verifier > Options.

The Configuration Parameters dialog box opens to the Design Verifier
pane.

2 Under Analysis options, from the Mode list, select Design error
detection.

3 In the Select tree, under Design Verifier, select Design Error
Detection.

4 Select Out of bound array access.
5 Click OK.

6 In the Simulink Editor, select Analysis > Design Verifier > Detect
Design Errors > Model.

The Simulink Design Verifier log window opens, showing the progress
of the analysis.

When the analysis is complete:
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® The software highlights the model with the analysis results.

® The Simulink Design Verifier Results dialog box opens and displays an
analysis summary.

Detect Out of Bound Array Access in Example Model

This example shows how to detect out of bound array access errors in the
sldvdemo_array bounds example model.

1 At the MATLAB command prompt, type:

sldvdemo_array_bounds

The example model opens.
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Simulink Design Verifier
Design Error Detection for Out of Bound Array Access

¥
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This example shows you how to statically detect out of bound array errors using Simulink Design Verifier.

This model contains emrors that result from using 1-based indices in a 0-based Stateflow array.

Run
(double-click)

Run Simulink Design Verifier

View Options
{double-click)

View Simulink Design Verifier Options

More Information
{double-click)

View Documentation

Using input signal values, the ComputeIndex MATLAB Function block
determines a range of indices with minimum minIdx and maximum
maxIdx. The ArrayOp_Matlab, ArrayOp_MAL, and ArrayOp_SF blocks
use the set of integer indices between minIdx and maxIdx to access array
elements and perform array operations.
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In this example model, the analysis options are configured for out of bound
array access error detection. To view these options, double-click the View
Simulink Design Verifier Options button.

2 Start the design error detection analysis by double-clicking the Run
Simulink Design Verifier button.

The Simulink Design Verifier log window opens, displaying the progress
of the analysis.

When the analysis is complete, the example model is highlighted with
the analysis results.

o 1
[1zed]
I — R ) ¥ —p-
fun Out1
P rvane | dox
[12] ArrayCp Matlab

i dbe
.
[12ad] for maneldz

£ omputelnd ex
s DIMPULEINDE

O3

3 View the analysis results inside the chart by double-clicking the
ArrayOp_SF Chart block, highlighted in red.
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sldvdemu_arra}r_lﬂnunds » []ArrayOp_SF

(Diff A
en:

y = u[maxldx] - u[minldx];

\. y,

4 See detailed analysis results for the Diff state in the Simulink Design
Verifier Results window by selecting the Diff state. That state is
highlighted in red.

.- =

*ﬁﬁimul’ink Design Verifier Results || B | (]
o ~ B3

Back to summary - Close results
ArrayOp_SF.Diff

Array bounds: u ERROR - View test case
Array bounds: u ERROR - View test case
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Simulink Design Verifier detected index out of bound errors for array u
in state Diff.

Click the first View test case link.

Simulink Design Verifier creates and opens a harness model that contains
test cases, or input signal groups, that demonstrate out of bound array
access errors.

In the Signal Builder dialog box, click Start simulation to simulate the
harness model with Test Case 1.

The simulation stops just before entering the state Diff. The Stateflow
Debugger opens. The following error is shown:

Runtime error: Index into array out of range
Model Name: sldvdemo_array_bounds_harness
Block Name: sldvdemo_array_bounds_harness/...
Test Unit (copied from sldvdemo_array_bounds) /ArrayOp_SF
Attempted to access 4 element of data u(#188 (0:3:0))...
The valid index range is 0 to 3

Keep the Stateflow Debugger open at this breakpoint.

7 In the sldvdemo_array_bounds_harness model, hold your cursor over the

Diff state to see the data values at this simulation breakpoint.
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Diff
en:

y = u[maxldx] - u[minldx];

Data used by Diff:
maxldx = 1
minldx = 4

Il =

Using Test Case 1 input signal values, the Computelndex MATLAB
Function block determines the range of array indices to be 1:4. One-based
indexing is consistent with MATLAB syntax, so these indices are valid for
the ArrayOp_Matlab MATLAB Function block and the ArrayOp_MAL
Stateflow chart.

The ArrayOp_SF Stateflow chart uses C as the action language, which
does not support one-based indexing. 1:4 is not a valid index range for
array access in that chart. The valid index range for array access in
that chart is 0:3, as the error message reported. When either maxIdx or

minIdx evaluates to 4, an out of bound array access error occurs in the
ArrayOp_SF Chart block.
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For more information on zero-based indexing support, see “Differences
Between MATLAB and C as Action Language Syntax”.

Limitations of Support for Out of Bound Array Access
Design Error Detection

Inf Index Values

Design error detection does not support indexing by Inf. If your model
attempts to access an array using an index value that evaluates to Inf, design
error detection does not report an out of bound array access error, but in
simulation, an out of bound array access error occurs.

Index Vector Block with Scalar Data Input

Out of bound array access design error detection does not support Index
Vector blocks with scalar data inputs. If your model includes an Index Vector
block that specifies a scalar data input instead of a vector data input and the
control input causes an out of bounds array access, design error detection does
not report an error, but an error occurs in simulation.
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® “What Is Test Case Generation?” on page 7-2
* “Workflow for Test Case Generation” on page 7-4
® “Generate Test Cases for Model Decision Coverage” on page 7-5

® “Generate Test Cases for a Subsystem” on page 7-23
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What Is Test Case Generation?

The Simulink Design Verifier software can generate test cases that satisfy
coverage objectives for your model, including:

¢ Decision coverage

¢ Condition coverage

® Modified condition and decision coverage (MC/DC)

Test cases help you confirm model performance by demonstrating how its
blocks execute in different modes. When generating test cases, the software

performs a formal analysis of your model. After completing the analysis, the
software offers several ways for you to review the results.

Test Case Blocks

The Simulink Design Verifier software provides two blocks for customizing
test cases for your Simulink models:

¢ The Test Objective block defines the values of a signal that a test case
must satisfy.

¢ The Test Condition block constrains the values of a signal during analysis.

Test Case Functions

The Simulink Design Verifier software provides two MATLAB functions to
customize test cases for a Simulink model or Stateflow chart. You can use
these functions in a MATLAB Function block. Both functions are active in
generated code and in Simulink Design Verifier.

® sldv.test — Specifies a test objective

® sldv.condition — Specifies a test condition
These functions:

¢ [dentify mathematical relationships for testing in a form that can be more
natural than using block parameters.



What Is Test Case Generation?

® Support specifying multiple objectives, assumptions, or conditions without
complicating the model.

® Provide access to the power of MATLAB.
® Support separation of verification and model design.

For an example of how to use these functions, see the sldv.test or
sldv.condition reference page.

Note Simulink Design Verifier blocks and functions are saved with a model.
If you open the model on a MATLAB installation that does not have a
Simulink Design Verifier license, you can see the blocks and functions, but
they do not produce results.
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Workflow for Test Case Generation

To generate test cases for your model, use the following workflow.

Task

Description

For an example, see

1

Verify that your model is
compatible for use with the
Simulink Design Verifier
software.

“Check Compatibility of the
Example Model” on page 7-6

If you have Stateflow

objects in your model,

in the Configuration
Parameters dialog box, on
the Diagnostics > Stateflow
pane, set Transition
shadowing to error.

Optionally, instrument your
model with blocks or MATLAB
functions that specify test
objectives and test conditions.

“Customize Test Generation”
on page 7-18

Specify options that control
how Simulink Design Verifier
generates test cases for your
model.

“Configure Test Generation
Options” on page 7-8

Execute the Simulink Design
Verifier analysis.

“Analyze the Example Model”
on page 7-8 and “Reanalyze the
Example Model” on page 7-20

Review the analysis results.

“Review Analysis Results” on
page 7-9
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Generate Test Cases for Model Decision Coverage

In this section...

“Construct the Example Model” on page 7-5

“Check Compatibility of the Example Model” on page 7-6
“Configure Test Generation Options” on page 7-8
“Analyze the Example Model” on page 7-8

“Review Analysis Results” on page 7-9

“Customize Test Generation” on page 7-18

“Reanalyze the Example Model” on page 7-20

“Analyze Contradictory Models” on page 7-22

Construct the Example Model

Construct a model to use in this example:

1 Create a new Simulink model.

2 Copy the following blocks into your empty model window:

* From the Sources library, an Inport block to initiate the input signal
whose value the Simulink Design Verifier software controls

® From the Sources library, two Constant blocks to serve as Switch block
data inputs

®* From the Signal Routing library, a Switch block to provide simple logic

* From the Sinks library, an Outport block to receive the output signal

3 In your model, double-click one of the Constant blocks and specify its
Constant value parameter as 2.

4 Connect the blocks so that your model appears similar to the following
diagram.
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1

Constant
RN R
C r—> -
Il - Dutl
™—n
Switch
2
Constant1

5 In the model window, select Simulation > Model Configuration
Parameters.

6 On the left side of the Configuration Parameters dialog box, in the Select
tree, click the Solver category. On the right side, under Solver options:

e Set the Type option to Fixed-step.

® Set the Solver option to Discrete (no continuous states).

The Simulink Design Verifier can analyze only models that use a fixed-step
solver.
7 Click OK to save your changes and close the Configuration Parameters

dialog box.

8 Save your model with the name ex_generate_test_cases_example.

Check Compatibility of the Example Model

Every time Simulink Design Verifier analyzes a model, before the analysis
begins, the software performs a compatibility check. If your model is not
compatible, the software cannot analyze it.

You can also make sure that your model is compatible with Simulink Design
Verifier software before you start the analysis:

1 Open the ex_generate_test_cases_example model.
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2 In the model window, select Analysis > Design Verifier > Check
Compatibility > Model.

The Simulink Design Verifier software displays the log window, which
states whether or not your model is compatible for analysis.

The model you just created is compatible.

Simulink Design Verifier log: ex_generate_test_cases_example @

09-May-2012 12:42:58

Checking compatibility of model 'ex_generate_test_cases_example'
Compiling model... done

Checking compatibility... done

'ex_generate_test_cases_example' is compatible with Simulink
Design Verifier.

| Save Log || Close

What If a Model Is Partially Compatible?

If the compatibility check indicates that your model is partially compatible,
your model contains at least one object that the Simulink Design Verifier
software does not support. You can analyze a partially compatible model,
but, by default, the unsupported objects are stubbed out. The results of the
analysis might be incomplete.
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For detailed information about automatic stubbing, see “Handle
Incompatibilities with Automatic Stubbing” on page 2-8.

Configure Test Generation Options

Configure the Simulink Design Verifier software to generate test cases that
achieve 100% decision coverage for the ex_generate test cases_example
model:

1 Open the ex_generate test cases_example model.
2 In the model window, select Analysis > Design Verifier > Options.

3 On the left side of the Configuration Parameters dialog box, in the Select
tree, click the Design Verifier category. Under Analysis options, set the
Mode option to Test generation.

4 On the left side of the Configuration Parameters dialog box, in the Select
tree, click the Test Generation category.

5 On the Test Generation pane, set the Model coverage objectives
parameter to Decision.

For this example, the analysis generates test cases that record only
decision coverage.

Note The Test suite optimization parameter is set by default to
CombinedObjectives. If you want to generate fewer but longer test cases,
select LongTestcases for the Test suite optimization parameter.

6 Click OK to save your changes and close the Configuration Parameters
dialog box.

7 Save the ex_generate_test cases_example model.

Analyze the Example Model

To analyze the ex_generate test cases_example model, in the model
window, select Analysis > Design Verifier > Generate Tests > Model.
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The Simulink Design Verifier software begins analyzing your model to
generate test cases.

During the analysis, the log window shows the progress of the analysis. It
displays information such as the number of test objectives processed and
which objectives are satisfied.

Review Analysis Results

When the software completes its analysis, the log window displays the
following options for reviewing the results:
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Simulink Design Verifier log: ex_generate_test_cases_example @

Progress |
Objectives processed 2/2

Satisfied 2

Falsified 0

Elapsed time 0:01

Test generation completed normally.
All 2 objectives satisfied.

Results:

* Highlight analysis results on model

s View detailed analysis report

* Open harness model

* Simulate tests and produce a model coverage report

Data saved in: ex_generate test cases example sldvdata.mat

in folder: 5:
\Adocimatlab'dochsrc\toolboxdsldviugiautomation'sldv cutputiex g
enerate test cases example

View Log H Clase

The following sections describe how you can review the analysis results:

“Review Analysis Results on the Model” on page 7-11
“Review Detailed Analysis Report” on page 7-13
“Review Harness Model” on page 7-14

“Simulate Tests and Produce a Model Coverage Report” on page 7-15
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e “View sldvData File” on page 7-17
¢ “Review Analysis Results in the Model Explorer” on page 7-17

Review Analysis Results on the Model
Highlight the analysis results on the example model:

1 In the log window for the ex_generate_test_cases_example analysis,
click Highlight analysis results on model.

Constant —
L _B.
CO— D
In1 Ot
*—
2
Constantl

The Switch block is outlined in green, which indicates that the Switch
block has test cases that satisfy its test objectives.

The Simulink Design Verifier Results window appears. As you click objects
in the model, this window changes to display detailed analysis results for
that object.
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P

"4 Simulink Design Verifier Results o= | ]
) v 52

Cloze results
Test generation completed normalky
Al 2 objectives satisfied,

Results:
* iew detailed analysis report

* Open harness model
* Simulate tests and produce a model coverage report

Tip By default, the Simulink Design Verifier Results window is always
the topmost visible window. To allow the window to move behind other
window, click B8 and clear Always on top.

2 Click the highlighted Switch block.

The Simulink Design Verifier Results window indicates that the analysis
generated test cases for both test objectives:

® trigger >= threshold
® trigger < threshold

i

@ Simulink Design Verifier Results = ECH ==
3 v 69

Back to summary - Close results
ex_generate_test_cases_example/Switch

trigger >= threshold false {outputis from 3rd  SATISFIED - View test case
input port)

trigger »= threshold true (output is from 1st  SATISFIED - View test case
input port)
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For more information about highlighted analysis results on a model, see
“Highlighted Results on the Model” on page 13-2.

Review Detailed Analysis Report
Create a detailed HTML analysis report:

1 In the Simulink Design Verifier log window, click Generate detailed
analysis report.

The HTML report opens in a browser window.

2 The report includes the following Table of Contents. Click a hyperlink to
navigate to a section in the report.

Table of Contents

1. Summary
Analysis Information

Test Objectives Status
Model ltems
Test Cases

L | [l [ P2

3 In the Table of Contents, click Summary to display the report’s Summary
chapter.

The Summary chapter lists information about the model and the status
of the objectives—satisfied or not.

4 In the Table of Contents, click Analysis Information to display the
Analysis Information chapter.

The Analysis Information chapter provides information about:
® The model that you analyzed
® The options that you specified for the analysis

® Approximations the software performed during the analysis

5 In the Table of Contents, click Test Objectives Status to display the
report’s Test Objectives Status chapter.
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This table indicates that the analysis satisfied both test objectives
associated with the Switch block in the ex_generate_test_cases_example
model, for which it generated two test cases.

6 Under the table Test Case column, click 2 to display the Test Case 2
section.

This section provides details about a test case that the analysis generated to
achieve an objective in your model. This test case achieves test objective 1,
when the Switch block passes its third input to its output port. Specifically,
the software determines that a value of —1 for the Switch block control
signal causes the block to pass its third input as the block output.

For more information about the HTML reports, see “Simulink® Design
Verifier™ Reports” on page 13-29.

Review Harness Model

To create a harness model with test cases that satisfy the test objectives
in your model, in the Simulink Design Verifier log window, click Create
harness model.

The software creates a harness model named
ex_generate test cases_example_harness.

Size Type
Test Case 1
% Int Int outif——»( 1)
L] Out1
Inputs Test Unit [copied from ex_gensrate test cases_sxample)
b—.
DoC
Teat

Test Casze Explanation

The Signal Builder block named Inputs contains the test cases. Double-click
the Inputs block to see the test cases. From the Signal Builder block, you can
simulate the model using the test cases and produce a model coverage report,
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as described in “Simulate Tests and Produce a Model Coverage Report” on
page 7-15.

For more information about the harness model, see “Simulink® Design
Verifier™ Harness Models” on page 13-17.

If the Analysis Generates Many Test Cases. If you have a large model,
the analysis might produce a harness model that contains a large number

of test cases.

To perform a more efficient analysis and create easier-to-review results that
are combined into a smaller number of longer test cases:

1 Set the Test suite optimization parameter to LongTestcases.
2 Rerun the analysis.

In the LongTestcases optimization, the analysis generates fewer but longer
test cases that each satisfy multiple test objectives.

Simulate Tests and Produce a Model Coverage Report
To simulate the harness model using the generated test cases in the harness
model:

1 In the harness model, double-click the Inputs block to open the Signal
Builder dialog box.
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n Signal Builder (ex_generate_test_cases_example_harness/Inputs) E@
File Edit Group Signal Axes  Help N
SH $BR|oo| —~J0EFRER > 0 o0 45|
Active Grou (1] Test Case 1 vi @ . | ™ E
[ - m i i
In1 ' ' ' H ' : ' : !
7] RSSO OSSN S — SRS N R —
e —_H I - L
e e
L .
0 i
)71 IS S— — — S— S— — R SE— A— j
.S L SOy SO SR
) S S SO S SRS N R —
Nl - — L,
1 i i i i i i i i i i
0 0.02 0.04 0.06 0.08 0.1 0.12 0.14 0.16 0.18 0.2
Time (sec)
LLeft Point Right: Point Inl {shown) -
Name: |n1 T: T:
Index: 1 v: ¥: ¥:
ok In1 (#1) [ YMin ¥Max ]
Il
.'a

2 In the Signal Builder dialog box, click the Run all button A

The software simulates the harness model using both test cases, collects
model coverage information, and displays a coverage report. The coverage
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report indicates that the test cases record 100% decision coverage for the
ex_generate_test cases_example model.

You can also simulate the model without creating a harness model. In the
Simulink Design Verifier log window, click Simulate tests and produce
a model coverage report.

For more information about model coverage, see “Top-Level Model Coverage
Report” in the Simulink Verification and Validation documentation.

View sldvData File

The Simulink Design Verifier data file is a MAT-file that contains a structure
named sldvData. This structure stores all the data that the analysis gathers
and produces during the analysis. Although the software displays the same
data graphically in the harness model and report, you can use the data file to
conduct your own analysis or to generate a custom report.

To view the data file, click the data file name in the log window, in this
example, ex_generate_test_cases_example_sldvdata.mat. When you click
the file name, a copy of the sldvData object is instantiated in the MATLAB
workspace so that you can review and manipulate the data.

For more information about Simulink Design Verifier data files, see
“Simulink® Design Verifier™ Data Files” on page 13-9.

Review Analysis Results in the Model Explorer

As long as your model remains open, you can view the results of your most
recent Simulink Design Verifier analysis in the Model Explorer.

In the model window, select Analysis > Design Verifier > Latest Results.
The Model Explorer opens, and the results of the latest Simulink Design

Verifier analysis appear in the right-hand pane.

For any Simulink Design Verifier analysis, from the Model Explorer, you can
perform the following tasks.
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Task For more information

Highlight the analysis results on the | “Highlighted Results on the Model”

model. on page 13-2

Generate a detailed analysis report. | “Simulink® Design Verifier™
Reports” on page 13-29

Create the harness model, or if the | “Simulink® Design Verifier™

harness model already exists, open | Harness Models” on page 13-17

it.

If no test cases were generated
during the analysis, this option is
not available.

View the data file. “Simulink® Design Verifier™ Data
Files” on page 13-9

View the log file. “Simulink® Design Verifier™ Log
Files” on page 13-56

After you close your model, you can no longer view analysis results.

Customize Test Generation

Customize the test-generation analysis by using the Test Condition block to
constrain signals in your model to certain values during the analysis.

1 In the MATLAB Command Window, enter sldvlib to display the Simulink
Design Verifier library.

2 Open the Objectives and Constraints sublibrary.

3 Copy the Test Condition block to your model by dragging it from the
Simulink Design Verifier library to your model window.

4 In the model window, insert the Test Condition block between the Inport
and Switch blocks.

7-18



Generate Test Cases for Model Decision Coverage

1
Constant
true -h:.—\_
CO—O— —CD
In1 - Dutl
*™—n
Switch
2
Constant1

5 Double-click the Test Condition block to access its attributes.

The Test Condition block parameters dialog box opens.

6 In the Values box, enter [-0.1, 0.1]. When generating test cases for this
model, the analysis constrains the signal values, entering the Switch block

control port to the specified range.
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Function Elock Parameters: Test Condition @
Design Verifier Test Condition (mask) (link)

Constrains signal values in Simulink Design Verifier test cases. The
"Values' parameter constrains the block input signal. Two element
vectors specify intervals. Cell arrays specify lists. The signal must
satisfy at least one of the values or intervals at every time step.
Example Values:

true

{[01], 2, [4 5], 6}

{Sldv.Interval(-2, -1), Sldv.Foint(0), Sldv.Interval(0, 1, ()", 1}

Parameters

Enable

Type ITest Condition -

Values
[-0.1, 0.1]
Display values
Fass through style (show Outport)

OK H Cancel H Help Apply

7 Click OK to save your changes and close the Test Condition block
parameters dialog box.

8 Save your model as ex_generate_test cases_with_tc_block and keep
it open.

Reanalyze the Example Model

Analyze the ex_generate_test cases with_tc_block model with the
Test Condition block. To observe how the Test Condition block affects test
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generation, compare the result of this analysis to the result that you obtained
in “Analyze the Example Model” on page 7-8.

In the model window, select Analysis > Design Verifier > Generate
Tests > Model.

The Simulink Design Verifier software displays a log window and begins
analyzing your model to generate test cases. When the software completes
the analysis, the log window displays the options for reviewing the results.

In the Simulink Design Verifier log window, click Generate detailed
analysis report.

To begin reviewing the report, in the Table of Contents, click Summary.

The Summary chapter indicates that the Simulink Design Verifier software
satisfied two test objectives in the model.

In the Table of Contents, click Analysis Information. Scroll to the
bottom of this chapter, to the Constraints section.

This section lists the Test Condition block that you added to constrain the
value of the Switch block control signal to the interval [-0.1, 0.1].

In the Table of Contents, click Test Objectives Status.

This table indicates that the Simulink Design Verifier software satisfied
both test objectives associated with the Switch block in your model, for
which it generated two test cases.

6 Under the table Test Case column, click 1.

This section provides details about a test case that the software generated
to achieve an objective in your model. This test case achieves test objective
1, when the Switch block passes its third input to its output port. Although
the Test Condition block restricts the domain of input signals to the
interval [-0.1, 0.1], the software determines that a value of —0.1 for the
Switch block control signal satisfies this objective.

7 To confirm that the test case achieves 100% decision coverage, open the

harness model.
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8 Double-click the Inputs block to open the Signal Builder dialog box.

all
9 In the Signal Builder dialog box, click the Run all button - .

The Simulink software simulates the harness model using both test cases,
collects model coverage information, and displays a coverage report. The
Summary section of the report indicates that the Simulink Design Verifier
software generated test cases that achieve complete decision coverage for
your example model.

Analyze Contradictory Models

If the analysis produces the error The model is contradictory in its
current configuration, the software detected a contradiction in your model
and cannot analyze the model.

You might have a contradiction if your model has Test Objective blocks with
incorrect parameters. For example, a contradiction can be an objective that
states that a signal must be between 0 and 5 when the signal is the constant
10.

If the software detects a contradiction, all previous results are invalidated
and the software reports that some of the objectives cannot be satisfied.
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Generate Test Cases for a Subsystem

If you have a large model, you can generate test cases for subsystems in the
model and review the analysis in smaller, manageable reports. The workflow
for generating test cases for a subsystem 1is:

1 Open the model that contains the subsystem.
2 Make the subsystem atomic.

3 Run the Simulink Design Verifier software using the Generate Tests for
Subsystem option.

4 Review the results.

The tutorial in “Analyze a Subsystem” on page 1-27 describes how to analyze
the Controller subsystem in the Cruise Control Test Generation model.
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Extending Existing Test
Cases

e “When to Extend Existing Test Cases” on page 8-2

¢ “Common Workflow for Extending Existing Test Cases” on page 8-4
¢ “Extend Test Cases for Model with Temporal Logic” on page 8-5

¢ “Extend Test Cases for Closed-Loop System” on page 8-13

¢ “Extend Test Cases for Modified Model” on page 8-20
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When to Extend Existing Test Cases

The Simulink Design Verifier software can analyze your model using
previously generated test cases that you specify. You can use this feature
in the following situations:

® You encounter delays trying to analyze your model, or you see incomplete
results. This can happen if your model has any of the following
characteristics:

= Temporal logic
= Large counters
= Model objects that are difficult to test due to complex or nonlinear logic

Analyzing the model and considering the existing test cases allows you to
focus the analysis on those parts of the model that are difficult to analyze.

You can combine the generated test cases to create a complete test suite
for the full model.

For an example of extending existing test cases for a model that uses
temporal logic, see “Extend Test Cases for Model with Temporal Logic”
on page 8-5.

® You have a closed-loop simulation model that uses a Model block to include
the controller. First, log the data from the Model block and then analyze
the model referenced by the Model block. Using this technique, the test
cases for the controller can realistically reflect the continuous time behavior
expected in the closed-loop system.

For an example of extending existing test cases for a closed-loop system,
see “Extend Test Cases for Closed-Loop System” on page 8-13.

® You change an existing model for which you have already generated test
cases . In this situation, you can reanalyze the model, omitting the analysis
results from the original version of the model. The combined test cases give
you a complete test suite for the new model.

For an example of extending existing test cases for modified models, see
“Extend Test Cases for Modified Model” on page 8-20.
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Note When you configure Simulink Design Verifier to treat parameters as
variables in its analysis, you cannot also use the analysis to extend existing
test cases. In Analysis > Design Verifier > Options, if you specify your
model to extend existing test cases with a Data file and apply parameter
configurations with a Parameter configuration file, when you attempt to
perform Simulink Design Verifier analysis, the software reports that your
model is incompatible. This occurs because the existing test cases do not
include corresponding parameter values.
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Common Workflow for Extending Existing Test Cases

Use the following workflow for extending existing test cases during a
test-generation analysis:

Create the starting test cases.

® Log the starting test cases.

Extend the existing test cases during test-generation analysis.

Verify that you have created a complete test suite.

The examples in this category use some or all of these tasks when extending
existing test cases during analysis.
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Extend Test Cases for Model with Temporal Logic

In this section...

“Create Starting Test Case” on page 8-5
“Log Starting Test Case” on page 8-8
“Extend Existing Test Cases” on page 8-9

“Verify Analysis Results” on page 8-12

Create Starting Test Case

This example uses the sldvdemo_sbr_extend_design model. This model
includes a Stateflow chart SBR that uses temporal logic. The transition from
the KEY_OFF state to the KEY_ON state occurs after the Stateflow chart has
been simulated 500 times. To test this transition requires a test case with
500 time steps.

In this example, you create a test case that forces the transition to KEY_ON by
setting the KEY input to 1 for the duration of the test case. You simulate the
model using this test case, satisfying the objectives for the KEY_OFF/KEY_ON
transition. Then you analyze the model, ignoring the objectives already
satisfied by the test case you create.

1 Open the example model:

sldvdemo_sbr_extend_design

2 Open the SBR Stateflow chart to see the KEY_OFF/KEY_ON transition.

KEY_OFF
SeatBeltlcon=0;

[afteria00 ticky] | o .
JIKEY==1]

¥

(ﬁ:EY_ON

3 Create a model reference harness model:
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[~, harnessModelFilePath] = ...
sldvmakeharness('sldvdemo_sbr_extend_design',[]1,[],true);
The harness model, sldvdemo_sbr_extend_design_harness, includes:

® A Model block named Test Unit that references the original model,
sldvdemo_sbr_extend_design.

sidwderno_sbr_extend_design

- Inputs SeatBeltlcon |-

Te sk Lnit

¢ A Signal Builder block named Inputs that contains the test-case inputs
to the model referenced in the Model block.

Test 1

Ral ane Inputs.Spead f—
"""~ Inputs.SeatBeltFasten
_l— Inputs KEY —

Irpds
Initially, the Signal Builder block contains only the default test case,
with all three inputs set to 0.

® A DocBlock block named Test Case Explanation that documents the
test case.

=
[elala

Taxt
Test Case Explanation

Initially, the Test Case Explanation block does not have any content for
the default test case.
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4 sldvmakeharness returns the path to the harness model file in
harnessModelFilePath. Extract the name of the harness model file into
harnessModel, for later use:

[~, harnessModel] = fileparts(harnessModelFilePath);

In order to analyze the KEY_OFF to KEY_ON state transition, create a test case
that makes the transition to the KEY_ON state in 500 time steps:

1 Open the Signal Builder dialog box for the harness model.
2 Select Axes > Change Time Range.

3 The Signal Builder’s time range determines the span of time over which its
output is explicitly defined. In the Set the total time range dialog box, set
the Max time field to 5 seconds, creating 500 time steps of 0.01 seconds
duration each.

4 Set the KEY input to 1 for the duration of this starting test case, forcing the
transition to the KEY_ON state. Selecting the Inputs.KEY signal requires
two clicks. First, click the signal so that dots appear at both ends of the
signal.

O E— L L L L L L L L L |

Inputs KEY ' ' : : ' ' :

1 i i i i i i i i i |

0 0.5 1 1.5 2 2.5 3 35 4 4.5 ]
Time (sec)

5 Click the Inputs.KEY signal again. The Signal Builder thickens the signal
to indicate that it is selected.
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_1 I_ | | | | | | | | |

Inputs KEY ' ' ' ' ' ' ' '
1 i i i i | | i | | |
0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5
Time (sec)
6 At the bottom of the Signal Builder dialog box, under Left Point, enter
1 for Y.
7 Press Enter to apply the change.
The Inputs.KEY signal is set to 1 for the duration of the test case.
Y ————————
Inputs KEY : ' ' ' ' ' | | :
1 Z : : : : : : Z Z :
0 I I I I I I I | | i
0 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5
Time (sec)

8 Close the Signal Builder dialog box.

Log Starting Test Case

The next step is to log the starting test case that you created. You can then
specify that the Simulink Design Verifier software ignore the objectives
satisfied by that test case when performing an analysis.

The sldvlogsignals function records the test case data in a MAT-file that
contains an sldvData structure. This structure stores all the data that the

software gathers and produces during the analysis.

To log the starting test cases:
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1 Save the name of the Model block in the harness model that references the
sldvdemo_sbr_extend_design model:

[~, modelBlock] = find_mdlrefs(harnessModel, false);

2 Simulate the model referenced by the Model block using the new test case,
and log the input signals in the workspace variable 1loggeddata:

loggeddata = sldvlogsignals(modelBlock{1});

3 Save the logged data in a MAT-file named existingtestcase.mat:

save('existingtestcase.mat', 'loggeddata');

You will specify this file when you analyze the
sldvdemo_sbr_extend design model.

Extend Existing Test Cases

You can now analyze the sldvdemo_sbr_extend design model and specify
that the analysis extend the test cases already satisfied. The analysis uses
the existing test-case data as a starting point, and does not try to generate
test cases for the KEY_OFF to KEY_ON transition in the SBR Stateflow chart.

Specify the starting test case and analyze the model:

1 In the model window for sldvdemo sbr_extend _design, select
Analysis > Design Verifier > Options.

2 In the Configuration Parameters dialog box, on the Select pane, under
Design Verifier, select Test Generation.

3 On the Test Generation pane, under Existing test cases, select Extend
existing test cases.

4 In the Data file field, enter the name of the MAT-file that contains the
logged data:

existingtestcase.mat

5 Clear Ignore objectives satisfied by existing test cases.
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When you clear this option, the software includes the starting test case
in the final test suite. You will see that the complete test suite achieves
100% model coverage.

6 To close the Configuration Parameters dialog box, click OK.

7 Save the sldvdemo_sbr_extend_design model on the MATLAB path with
the name sldvdemo_sbr_extend_design_test.

8 In the Model Editor, select Analysis > Design Verifier > Generate
Tests > Model.

The log window first lists the objectives that the starting test case satisfied.
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Simulink Design Verifier Results Summary: sldvdemo_sbr_exten... @

Progress I

Objectives processed 23/37

m

Satisfied 23
Falsified 0
Elancad tima n-20 i

13-Jun-2013 15:05:09

Starting test generation for model
'sldvdemo_sbr_extend_design_test'

Compiling model... done

Translating model... done
'sldvdemo_sbr_extend_design_test' is compatible with
Simulink Design Verifier.

m

Loading initial test data...
Generating tests...

SATISFIED

SBR

Chart: Substate executed State "KEY_OFF"
Analysis Time = 00:00:01

SATISFIED

SBR."[after(500,tick)]"

Transition: Transition trigger expression F
Analysis Time = 00:00:01

Highlight | |  Stop

The log window then lists the objectives generated beyond the starting
test case.
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Verify Analysis Results

To make sure that this analysis creates a complete test suite, generate the
harness model so you can simulate the model with the generated test cases:

1 In the log window, click Create harness model.

2 In the harness model sldvdemo_sbr_extend design_test harness, open
the Signal Builder block named Inputs.

3 To simulate the model using all the test cases, click the Run all and

..all
produce coverage button .

When the simulation is complete, the model coverage report is displayed.

4 View the coverage information for the sldvdemo_sbr_extend_design_test
model to see that the complete test suite achieves 100% coverage.

Summary
Madel Hierarchy/Complexity: Test 1
Iy
1. sldvdeme sbr extend gssign test 21 100%  —
2. ...5BR 20 100%
3. SF: SER 12 100% EE——
4o SF: KEY ON 13 100% EE——
B SF: 5B UNFASTEM 8 100% S
8 .. SF: HIGH SFEED 4 100% -
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Extend Test Cases for Closed-Loop System

In this section...

“Log Starting Test Case” on page 8-13

“Extend Existing Test Cases” on page 8-16

Suppose that you have a model with a closed-loop controller in a model
referenced by a Model block. You do not record 100% coverage for the
referenced model. Extending existing test cases can help you achieve
100% coverage. The Simulink Design Verifier software adds time steps to
the existing test cases when analyzing the controller implemented by the
referenced model. The test cases that result from the analysis realistically
reflect the continuous time behavior expected in the closed-loop controller.

A closed-loop controller passes instructions to the controlled system and
receives information from the environment as the control instructions
execute. The controller can adapt and change its instructions as it receives
this information.

Log Starting Test Case

This example uses the sldemo_mdlref_basic model. The CounterA Model
block references the model sldemo_mdlref counter. When you simulate the
parent model, sldemo_mdlref_basic, and collect coverage, you record only
75% coverage for sldemo_mdlref_counter. Log the data from the simulation
and extend those test cases to achieve 100% coverage for the referenced model.

1 Open the example model:

sldemo_mdlref_basic

2 In the Simulink Editor, select Analysis > Coverage > Settings.
The Coverage Settings dialog box opens.

3 In the Coverage Settings dialog box, select Coverage for referenced
models.
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Note that the analysis records coverage only for referenced models with
Simulation mode set to Normal. In sldemo_mdlref basic, the CounterC
Model block has Simulation mode set to Accelerator, so you cannot
record coverage for it.

4 Under Coverage metrics, select Decision, Condition, and MCDC to
record decision, condition, and modified condition/decision coverage.

5 Click OK.
6 Simulate the model.

When the simulation completes, the generated coverage report opens in a
browser window. The report shows the following coverage results for the
referenced model:

® Condition: 50% (2/4) condition outcomes
® Decision: 25% (1/4) decision outcomes

e MCDC: 0% (0/2) conditions reversed the outcome
The coverage results are also highlighted in the referenced model,
sldemo_mdlref_counter. You can select individual model objects to view

specific coverage results in the Coverage dialog box, as shown in the
following screenshot.
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7 To log the input signals for the CounterA Model block in
sldemo_mdlref basic during simulation, at the MATLAB command
prompt, enter the following code:

logged_data = sldvlogsignals('sldemo_mdlref_basic/CounterA');

8 Save the logged data in a MAT-file named existingtestcase.mat:

save('existingtestcase.mat', 'logged_data');

When you analyze the model referenced in CounterA
(sldemo_mdlref counter) to extend existing test cases, you
specify this MAT-file.

Extend Existing Test Cases

Analyze the sldemo_mdfref _counter model, specifying that the analysis
extend the test cases already satisfied:

1 To open the sldemo_mdfref counter model, in the sldemo_mdlref basic
model, double-click the CounterA Model block.

2 In the Simulink Editor, select Analysis > Design Verifier > Options.

3 In the Configuration Parameters dialog box, on the Select pane, under
Design Verifier, select Test Generation.

4 On the Test Generation pane, in the Model coverage objectives box,
select MCDC.

5 Under Existing test cases, select Extend existing test cases.

6 In the Data file field, specify the name of the MAT-file that contains the
logged data, in this case, existingtestcase.mat.

7 Clear Ignore objectives satisfied by existing test cases.

When you clear this option, the software includes the test cases recorded in
the file existingtestcase.mat in the final test suite.

8 Click OK.
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9 In the Simulink Editor, select Analysis > Design Verifier > Generate
Tests > Model.

The analysis first loads the objectives satisfied by the logged test cases.
Then it adds extra time steps to those test cases and tries to satisfy any
missing objectives. When the analysis completes, the Simulink Design
Verifier log window opens and indicates that all 12 objectives are satisfied.

10 To view the analysis results on the model, in the Simulink Design Verifier
log window, select Highlight analysis results on model.

The Simulink Design Verifier results are highlighted in the referenced
model, sldemo_mdlref counter. You can select individual model objects
to view specific analysis results in the Simulink Design Verifier Results
dialog box, as shown in the following screenshot.
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o

'Pi sldermo_mdlref_counter ™
File Edit View Display

i)

Diagram  Simulation  Analysis Code Tools  Help

| sldemo_mdiref _counter
) E' sldemo_mdlref_counter bl
o
[upper]
upper
3] upper
—+
koiwer m
upper
==
+ -
& A input
input i S
—™ AnD limit
_H_
upper i
»= > i \"1
| flowe>—>1— |
PrEMOUS DUtput 1_
Z
Frevious Cutput
9| Simulink Design Verifier Results
) - @
» Back to summary - Close results
Ready sldemo_mdiref_counter/Switch

logical trigger input false (output is from 3rd  SATISFIED - Yiew test case

8-18

input port)
logical trigger input true (output is from 1st SATISFIED - View test case
input port)




Extend Test Cases for Closed-Loop System

11 To verify the results of the analysis and review the generated test cases,
in the Simulink Design Verifier log window, select Generate detailed
analysis report.

12 To collect model coverage using the extended test suite, in the Simulink

Design Verifier log window, select Simulate tests and produce a model
coverage report.

When the simulation completes, the generated coverage report opens in a
browser window. The report now shows the following coverage results for
the referenced model sldemo_mdlref_counter:

¢ Condition: 100% (4/4) condition outcomes
® Decision: 100% (4/4) decision outcomes

e MCDC: 100% (2/2) conditions reversed the outcome
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Extend Test Cases for Modified Model

In this section...

“Create Starting Test Cases” on page 8-20

“Extend Existing Test Cases” on page 8-21

Suppose that you have a model that you have already analyzed using the
Simulink Design Verifier software, and you modify the model. The original
test suite may not record 100% coverage for the modified model. Reanalyze
the modified model to make sure that it satisfies all the new test objectives.
Instead of reanalyzing the entire model, you focus the new analysis on just the
modified part of the model. In this way, you leverage the test cases created for
the original model, extending them to satisfy any new objectives.

This example uses the sldvdemo_cruise_control model. You analyze the
model and generate test cases. Then you analyze a modified version of
that model, sldvdemo_cruise_control_mod, extending the test cases from
the original analysis. The analysis returns a complete test suite for the
new model.

Create Starting Test Cases

Analyze the sldvdemo_cruise_control model and generate test cases that
achieve 100% coverage.

1 Open the example model:

sldvdemo_cruise_control

2 To start a Simulink Design Verifier analysis for the
sldvdemo_cruise_control model, double-click the Run Simulink Design
Verifier block:

Run
(double-click)

Run Simulink Design Verifier
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The analysis satisfies 34 test objectives for the sldvdemo cruise control
model. The software stores the resulting data file in a subfolder of the
MATLAB Current Folder:

sldv_output\sldvdemo_cruise_control\sldvdemo_cruise_control_sldvdata.mat

In the next section, when you analyze the modified model, this data file
specifies the starting test cases that you extend.

3 Close the sldvdemo_cruise_control model and all the files created by the
analysis. If asked, do not save any changes you made to the model.

Extend Existing Test Cases

The sldvdemo_cruise_control_mod model is a modified version of
sldvdemo_cruise_control. The Controller subsystem contains a Saturation
block that specifies that the target speed cannot exceed 70.

Open the modified model and analyze it, extending the test cases that you
generated when analyzing the sldvdemo_cruise_control model:

1 Open the example model, the modified version of
sldvdemo_cruise_control:

sldvdemo_cruise_control_mod

2 Double-click the Controller subsystem to see the change to the original
model, a Saturation block that specifies the maximum speed:

:‘l_\ Ta_[

*— Saturation

3 Close the Controller subsystem.

4 Select Analysis > Design Verifier > Options.
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5 In the Configuration Parameters dialog box, on the Select pane, under
Design Verifier , select Test Generation.

6 On the Test Generation pane, under Existing test cases, select Extend
existing test cases.

7 In the Data file field, click Browse and navigate to the MAT-file created
in the MATLAB Current Folder when analyzing the original model:

sldv_output\sldvdemo_cruise_control\sldvdemo_cruise_control_sldvdata.mat

8 Clear Ignore objectives satisfied by existing test cases.

When you clear this option, the analysis includes the test cases recorded in
the file sldvdemo_cruise control sldvdata.mat in the final test suite.

9 Click Apply to save these settings.

10 To open the main Design Verifier pane, on the Select pane, click Design
Verifier.

11 To start the analysis, click Generate Tests.

The analysis first loads the 34 objectives satisfied by the initial test cases.
Then it adds extra time steps to those test cases and tries to satisfy any
missing objectives.

12 In the log window, click Generate detailed analysis report.

The analysis satisfied a total of 38 satisfied objectives for the
sldvdemo_cruise control mod model. The analysis satisfied four
additional objectives that correspond to the Saturation block.
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Objectives Satisfied

Simulink Design Verifier found test cases that exercise these test objectives,

Test

#  [Type Model ltem Description Case

logical trigger input
1 |Decision |Controller/Switch false (output is from 3
Srd input port)

logical trigger input

2 |Decision  |ControllerSwitchl true {output is from 1st |1
input port)

3 |Decision |Controller/Saturation input = lower limit F il

4 |Decision  |Controller/Saturation input = lower limit T 3

5 |Decision  |Controller/Saturation input == upper limit F |1

£ |Decision |Controller/Saturation input == upper limit T 10
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Achieving Test Cases for
Missing Model Coverage

® “Generating Test Cases for Missing Coverage Data” on page 9-2

® “Achieve Missing Coverage in Referenced Model” on page 9-3

* “Missing Coverage in Subsystems and Model Blocks” on page 9-8

® “Achieve Missing Coverage in Closed-Loop Simulation Model” on page 9-9

® “Modified Condition and Decision Coverage in Simulink® Design Verifier™”
on page 9-13



9 Achieving Test Cases for Missing Model Coverage

Generating Test Cases for Missing Coverage Data

If you simulate your model and record coverage data, but your model does
not achieve 100% coverage, the Simulink Design Verifier software can find
test cases that achieve the missing coverage. The software targets the
test-generation analysis for the part of the model that is missing coverage,
ignoring the model coverage data that was recorded during simulation.

The following examples describe how to focus the test-generation analysis on
a part of the model that did not achieve 100% coverage:

® “Achieve Missing Coverage in Referenced Model” on page 9-3

® “Achieve Missing Coverage in Closed-Loop Simulation Model” on page 9-9
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Achieve Missing Coverage in Referenced Model

In this section...

“Record Coverage Data for Example Model” on page 9-3
“Find Test Cases for the Missing Coverage” on page 9-5
“Achieve Missing Coverage” on page 9-6

“Verify 100% Model Coverage” on page 9-6

This example model uses a referenced model that does not achieve full
coverage. When you run a test-generation analysis on the referenced model
and combine it with previously recorded coverage data, you can achieve 100%
coverage for the referenced model.

Record Coverage Data for Example Model

Simulate the example model, recording Condition, Decision, and MCDC
coverage.

1 Open the example model:

sldemo_mdlref_basic

The Model blocks CounterA, CounterB, and CounterC reference the model
sldemo_mdlref_counter.

2 In the Simulink Editor, select Analysis > Coverage > Settings.
The Coverage Settings dialog box opens to the Coverage tab.

3 On the Coverage tab, set the following options:
¢ Select Coverage for referenced models.

¢ (Click Select Models. In the Select Models for Coverage Analysis
dialog box, select the check boxes for the referenced model,
sldemo_mdlref_counter. Click OK.

Check boxes for sldemo_mdlref_counter appear twice, corresponding to
CounterA and CounterB. Coverage cannot be enabled for CounterC since
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it specifies the Accelerator simulation mode in its model reference
parameters.

® Specify which types of coverage to record during simulation. Under
Coverage metrics, select:

= Decision
= Condition

- MCDC

4 Click the Results tab. Set the following options:

® Select Save last run in workspace variable to save the collected
coverage data from the most recent simulation run in a variable in the
MATLAB workspace.

¢ In the cvdata object name field, enter covdata_original to specify a
unique name for the coverage data workspace variable.

5 Click the Reporting tab. Set the following options:

¢ Select Generate HTML report to specify that the simulation create a
coverage report.

e Select Last run to specify that the coverage report show data from the
most recent simulation run.

6 Click OK.

7 Start the simulation of the sldemo_mdlref_basic model to record the
coverage data.

After the simulation, the coverage report opens. The report indicates
that the following coverage is achieved for the referenced model
sldemo_mdlref_counter:

® Decision: 25%
¢ Condition: 50%
e MCDC: 0%

The simulation saves the coverage data in the MATLAB workspace variable
covdata_original, a cvdata object that contains the coverage data.
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8 Save the coverage data in a file on the MATLAB path:

cvsave('existingcov',covdata_original);
Keep the model open as you continue through this example.

Find Test Cases for the Missing Coverage

To achieve 100% coverage for the sldemo_mdlref counter model, run a
test-generation analysis that uses the existing coverage data.

1 Open the referenced model using the following command:
open_system('sldemo_mdlref_counter');

2 Create an sldvoptions object:
opts = sldvoptions;

When you create the sldvoptions object, you need to specify:

e That the analysis ignore satisfied coverage data.

® The file name containing the satisfied coverage data (existingcov.cvt)

Enter the following commands to specify these options:

opts.IgnoreCovSatisfied = 'on';
opts.CoverageDataFile = 'existingcov.cvt';

3 Analyze the referenced model, sldemo_mdlref_counter, using the
specified options:

[status, fileNames] = sldvrun('sldemo_mdlref_counter',opts,true);

The Simulink Design Verifier analysis satisfies five objectives and creates

one test case for the referenced model.

The next section simulates the referenced model, sldemo_mdlref_counter,
using the test case that the analysis created.
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Achieve Missing Coverage

To achieve the missing coverage for the referenced model,
sldemo_mdlref_counter, simulate the model using the test case from the
Simulink Design Verifier analysis.

1 Open the referenced model using the following command:

open_system('sldemo_mdlref_counter');

2 Create a cvtest object for the simulation and specify to record Decision,
Condition, and MCDC coverage.

cvt = cvtest('sldemo_mdlref_counter');
cvt.settings.decision = 1;
cvt.settings.condition = 1;
cvt.settings.mcdc = 1;

3 Specify to record coverage and set the name of the cvtest object.

runOpts = sldvruntestopts;
runOpts.coverageEnabled
runOpts.coverageSetting

true;
cvt;

4 Simulate the model using the cvtest object, cvt, and the test case, as
defined in fileNames.DataFile. Save the recorded coverage data in the
workspace variable covdata_missing.

[~, covdata_missing] = sldvruntest('sldemo_mdlref_counter', fileNames.DataFile, runOpts);

Verify 100% Model Coverage

You saved the coverage data from the simulation of the top-level model,
sldemo_mdlref basic in the workspace variable covdata original.
To create a report that combines the coverage data from the top-level
model with the missing coverage data from the referenced model,
sldemo_mdlref counter, enter the following command:

cvhtml('Coverage Summary', covdata_original, covdata_missing);

The report shows that by analyzing the referenced model and using those
results to record coverage, you can achieve 100% decision, condition, and
MCDC coverage.
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Summary
Meodel Hierarchy/Complexity: Test 1 Test 2 Total

D1 (o} MCDC D1 C1 MCDC D1 Cl MCDC
1. sldemo_mdlref counter 325% m 50% m— 0% 75% w— 100% — (% 100% 100% 100%
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Missing Coverage in Subsystems and Model Blocks

If your model has a Subsystem block that does not achieve full coverage, you
can convert it to model referenced in a Model block. “Convert a Subsystem
to a Referenced Model” describes how to convert a subsystem to a referenced
model. You can then follow the steps described in “Achieve Missing Coverage
in Referenced Model” on page 9-3.

However, some subsystems cannot be converted to Model blocks. To

test a subsystem to see if it can be converted to a Model block, use the
Simulink.SubSystem.convertToModelReference function. If that function
cannot convert the subsystem, an error message explains why the conversion
failed.

In addition, you may have a Stateflow chart or a MATLAB Function block
that does not achieve full coverage. Stateflow charts and MATLAB Function
blocks cannot be converted to referenced models.

For situations when you cannot use a Model block, follow steps similar to
the steps described in the following section, “Achieve Missing Coverage in
Closed-Loop Simulation Model” on page 9-9.
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Achieve Missing Coverage in Closed-Loop Simulation
Model

In this section...

“Record Coverage Data for the Model” on page 9-9
“Find Test Cases for Missing Coverage” on page 9-11

If you have a subsystem or a Stateflow chart that does not achieve 100%
coverage, and you do not want to convert the subsystem or chart to a Model
block, this example can help you achieve full coverage.

The example uses a closed-loop controller model. A closed-loop controller
passes instructions to the controlled system and receives information from
the environment as the control instructions are executed. The controller can
adapt and change its instructions as it receives this information.

The sldvdemo_autotrans model is a closed-loop simulation model. The
ShiftLogic Stateflow chart represents the controller part of this model.
Test cases designed in the ManeuversGUI Signal Builder block drive the
closed-loop simulation.

Record Coverage Data for the Model

To simulate the model, recording Condition, Decision, and MCDC coverage
for the ShiftLogic controller:

1 Open the example model:

sldvdemo_autotrans

2 In the Simulink Editor, select Analysis > Coverage > Settings.
The Coverage Settings dialog box opens to the Coverage tab.

3 Select Coverage for this model: sldvdemo_autotrans.

4 Click Select Subsystem.

5 In the Subsystem Selection dialog box, select ShiftLogic and click OK.
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6 Under Coverage metrics, select the types of coverage that you want the
simulation to record:

® Decision
¢ Condition
e MCDC

7 Clear the other coverage metrics if they are checked.

8 Click the Results tab.

9 In the cvdata object name field, enter covdata_original controller to
specify a unique name for the coverage data workspace variable.

10 Click the Reporting tab.
11 Select Generate HTML report.

12 Click OK.

13 Start the simulation of the sldvdemo_autotrans model to record the
coverage data.

After the simulation, the coverage report opens. The report indicates that
the following coverage is achieved for the ShiftLogic Stateflow chart:

® Decision: 87% (27/31) decision outcomes

¢ Condition: 67% (8/12) condition outcomes

e MCDC: 33% (2/6) conditions reversed the outcome

The simulation saves the coverage data in the MATLAB workspace
variable covdata_original controller, a cvtest object that contains
the coverage data.

14 Save the coverage data in a file on the MATLAB path:

cvsave('existingcov',covdata_original_controller);
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Find Test Cases for Missing Coverage

To find the missing coverage for the ShiftLogic chart, run a subsystem
analysis on that block. Use this technique to focus your analysis on an
individual part of the model.

To achieve 100% coverage for the ShiftLogic controller, run a test-generation
analysis that uses the existing coverage data.

To analyze the ShiftLogic chart, the model must use a fixed-step solver.
Select Simulation > Model Configuration Parameters and on the
Solver pane:

* For Type, select Fixed-step.

¢ For Solver, select discrete (no continuous steps).
Click OK.
Right-click the ShiftLogic block and select Design Verifier > Options.

In the Configuration Parameters dialog box, under the Select tree, choose
the Design Verifier node. Under Analysis options in the Mode field,
select Test generation.

Under the Design Verifier node, select Test Generation. Under
Existing coverage data, select Ignore objectives satisfied in existing
coverage data.

In the Coverage data file field, enter the name of the file containing the
coverage data that you recorded during simulation:

existingcov.cvt

Click Apply to save these settings.
Under the Select tree, click Design Verifier.
On the main Design Verifier pane, click Generate Tests.

The analysis extracts the Stateflow chart into a new model named
ShiftLogicO. The analysis analyzes the new model, ignoring the coverage
objectives previously satisfied and recorded in the existingcov.cvt file.
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10 When the test-generation analysis is complete, in the Simulink Design

Verifier log window, select Simulate tests and produce a model
coverage report.

The report indicates that the following coverage is achieved for the
ShiftLogic chart in simulation with the test cases generated by Simulink
Design Verifier:

® Decision: 84% (26/31) decision outcomes
® Condition: 83% (10/12) condition outcomes
e MCDC: 67% (4/6) conditions reversed the outcome

The Simulink Design Verifier report lists six test cases for the extracted
model that satisfy the objectives not covered in the existingcov.cvt file.

Note The Simulink Design Verifier report indicates that two coverage
objectives in the Stateflow chart ShiftLogic are proven unsatisfiable. Since
the ShiftLogic chart updates at every time step, the implicit event tick is
never false. The analysis cannot satisfy condition or MCDC coverage for
either instance of the temporal event after (TWAIT, tick).

after(TWAIT, tick) is semantically equivalent to

Event == tick && temporalCount(tick) >= TWAIT

If you move after (TWAIT, tick) into the condition, as in

[after (TWAIT, tick) && speed < down_th]

the Simulink Design Verifier software determines that tick is always true,
so it only tests the temporalCount (tick) >= TWAIT part of after (TWAIT,
tick). The analysis is able to find test objectives that satisfy Condition
and MCDC coverage for after (TWAIT, tick).




Modified Condition and Decision Coverage in Simulink® Design Verifier™

Modified Condition and Decision Coverage in Simulink
Design Verifier

There is a difference between the definition of modified condition and decision
coverage (MCDC) for model coverage analysis in Simulink Verification

and Validation and for test case generation analysis in Simulink Design
Verifier. This difference can be seen in analysis results for logical expressions
containing a mixture of AND and OR operators, as in the Stateflow transition
shown below.

AN [(A&&B) | C]

)

O 2®
fout =07} fout =1;}

A

J

(}'-'- .

Given that A, B, and C are each separate inputs, there are five possible ways
to evaluate the condition on the Stateflow transition, shown in the following

table.
A B c (A & B)
Il c
1 F X F F
2 F X T T
3 T F F F
4 T F T T
5 T T X T

Satisfying MCDC for a Boolean variable requires a pair of condition
evaluations, showing that a change in that variable alone changes the
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evaluation of the entire expression. In this example, MCDC can be satisfied
for C with either the pair 1, 2 or the pair 3, 4. In both of those cases, the
value of the expression changed because the value of C changed, while all
other variable values stayed the same.

Each pair has a different set of values for A and B which are held constant,
but each pair contains one evaluation where C and out are true and one
evaluation where C and out are false. To satisfy MCDC for C, Simulink Design
Verifier test generation analysis accepts any pair containing one evaluation of
true values and one evaluation of false values for C and out; in this example,
1t accepts not only pair 1, 2 and pair 3, 4 but also pair 1, 4 and pair 2, 3.
Simulink Verification and Validation model coverage analysis uses a strict
form of MCDC that is only satisfied by pair 1, 2 or by pair 3, 4.

The above example assumes that A, B, and C are all separate inputs. When
input A is constrained to be the same value as C, as in the model below, only a
subset of condition evaluations are possible.

¥
-

[js
§

h
E]

This subset of condition evaluations for the Stateflow transition is shown
in the following table.

A B c (A && B)
[l ¢
F x F F
4 T F T T
T T X T
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Evaluations 2 and 3 are no longer possible, so neither pair 1, 2 nor pair 3, 4
is possible. As a result, MCDC for C can no longer be satisfied in Simulink
Verification and Validation model coverage analysis. Since pair 1, 4 is still
possible, however, Simulink Design Verifier test generation analysis reports
that MCDC for C is satisfiable.

The complexity of MCDC analysis for logical expressions with a mixture of
AND and OR operators causes this difference between results from Simulink
Verification and Validation and Simulink Design Verifier. Using the
IndividualObjectives strategy for test generation analysis in Simulink
Design Verifier can minimize this effect.
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Verifying Model
Components

e “What Is Component Verification?” on page 10-2
® “Functions for Component Verification” on page 10-4

e “Verify a Component for Code Generation” on page 10-6
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What Is Component Verification?

In this section...

“Component Verification Approaches” on page 10-2

“Simulink® Design Verifier™ Tools for Component Verification” on page
10-2

Component Verification Approaches

Component verification lets you test a design component in your model using
either of the following approaches:

e Within the context of the model that contains the component —
Using systematic simulation of closed-loop controllers requires that you
verify components within a control system model. Doing so lets you test
the control algorithms with your model. This approach is called system
analysis.

¢ As standalone components — For a high level of confidence in the
component algorithm, verify the component in isolation from the rest of the
system. This approach is called component analysis.

Verifying standalone components provides three advantages:

= You can use analysis to focus on portions of the design that you cannot
test because of the physical limitations of the system being controlled.

= You can use this approach for open-loop simulations to test the plant
model without feedback control.

= You can use this approach when the model is unavailable or when
you need to simulate a control system model in accelerated mode for
performance reasons.

Simulink Design Verifier Tools for Component
Verification

By isolating the component to verify, and using tools that the Simulink
Design Verifier software provides, you create test cases that let you expand
the scope of the testing for large models. This expanded testing helps you
accomplish the following:




What Is Component Verification?

® Achieve 100% model coverage — If certain model components do not record
100% coverage, the top-level model cannot achieve 100% coverage. By
verifying these components individually, you can create test cases that
fully specify the component interface, allowing the component to record
100% coverage.

® Debug the component — To verify that each model component satisfies the
specified design requirements, you can create test cases that verify that
specific components perform as designed.

® Test the robustness of the component — To verify that a component handles
unexpected inputs and calculations properly, you can create test cases that
generate data. Then, test the error-handling capabilities in the component.
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Functions for Component Verification

The Simulink Design Verifier software provides several functions that
facilitate the tasks associated with component verification.

Function

Task

sldvlogsignals

Simulate a Simulink model and log input signals to
a Model block in the model. If you modify the test
cases in the Signal Builder harness model, use this
approach for logging input signals to the harness
model itself.

sldvmakeharness

Create a harness model for a component, using
logged input signals if specified, or using the
default signals.

For more information about harness models, see
“Simulink® Design Verifier™ Harness Models” on
page 13-17.

sldvmergeharness

Merge test cases from several harness models into
a single harness model.

sldvextract

Extract an atomic subsystem or atomic subchart
into a new model.

sldvruntest

Simulate a model, executing the specified test cases
to record model coverage and outport values.

sldvruncgvtest

Invoke the Code Generation Verification (CGV)
API, and execute the specified test cases on the
generated code for the model.

Note To execute a model in different modes of
execution, use the CGV API to verify the numerical
equivalence of results. For more information about
the CGV API, see “Programmatic Code Generation
Verification”.
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Component verification functions do not support the following Simulink
features:

e Variable-step solvers for sldvruntest
e Component interfaces that contain:

Complex signals

Variable-size signals

= Array of buses

Multiword fixed-point data types
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Verify a Component for Code Generation

In this section...

“About the Example Model” on page 10-6
“Prepare the Component for Verification” on page 10-8
“Record Coverage for the Component” on page 10-9

“Use Simulink® Design Verifier™ Software to Record Additional Coverage”
on page 10-10

“Combine the Harness Models” on page 10-12
“Execute the Component in Simulation Mode” on page 10-13

“Execute the Component in Software-in-the-Loop (SIL) Mode” on page 10-14

About the Example Model

This example uses the slvnvdemo_powerwindow model to show how to verify
a component in the context of the model that contains that component.

As you work through this example, you use the Simulink Design Verifier
component verification functions to create test cases and measure coverage
for a referenced model. In addition, you can execute the referenced model in
both simulation mode and Software-in-the-Loop (SIL) mode using the Code
Generation Verification (CGV) APL.

Note You must have the following product licenses to run this example:

e Stateflow
e Embedded Coder®

e Simulink Coder™

The component that you verify is a Model block named control.
This component resides inside the power_window_control system
subsystem in the top level of the slvnvdemo_powerwindow model. The
power_window_control_system subsystem is shown below.
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Prepare the Component for Verification

To verify the referenced model slvnvdemo_powerwindow_controller, create
a harness model that contains the input signals that simulate the controller
in the plant model:

1 Open the slvnvdemo_powerwindow example model and the referenced
model:

slvnvdemo_powerwindow;
slvnvdemo_powerwindow_controller;

2 Open the power_window_control_system subsystem in the example model.

Note The Model block named control in the power_window_control_system
subsystem references the component that you verify during this example,
slvnvdemo_powerwindow_controller
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3 Simulate the Model block that references the
slvnvdemo_powerwindow_controller model and log the input signals
to the Model block:

loggedSignalsPlant = ...
sldvlogsignals(...
"slvnvdemo_powerwindow/power_window_control_system/control');

sldvlogsignals stores the logged signals in loggedSignalsPlant.
4 Generate a harness model with the logged signals:

harnessModelFilePath = ...
sldvmakeharness('slvnvdemo_powerwindow_controller',
loggedSignalsPlant);

sldvmakeharness creates and opens a harness model named
slvnvdemo_powerwindow_controller_harness. The Signal Builder block
contains one test case containing the logged signals.

Note For more information about harness models, see “Simulink® Design
Verifier™ Harness Models” on page 13-17.

5 For use later in this example, save the name of the harness model:
[~,harnessModel] = fileparts(harnessModelFilePath);
6 Leave all windows open for the next part of this example.

Next, you will record coverage for the slvnvdemo_powerwindow controller
model.

Record Coverage for the Component

Model coverage is a measure of how thoroughly a test case tests a model, and
the percentage of pathways that a test case exercises. To record coverage for
the slvnvdemo_powerwindow_controller model:

1 Create a default options object, required by the sldvruntest function:
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runOpts = sldvruntestopts;

2 Specify to simulate the model, and record coverage:
runOpts.coverageEnabled = true;

3 Simulate the referenced model and record coverage:

[~, covDataFromLoggedSignals] = ...
sldvruntest('slvnvdemo_powerwindow_controller',...
loggedSignalsPlant, runOpts);

4 Display the HTML coverage report:
cvhtml('Coverage with Test Cases', covDataFromLoggedSignals);

The slvnvdemo_powerwindow controller model achieved:
® Decision coverage: 40%
e (Condition coverage: 35%

e MCDC coverage: 10%

Note For more information about decision coverage, condition coverage,
and MCDC coverage, see “Types of Model Coverage” in the Simulink
Verification and Validation documentation.

Because you did not achieve 100% coverage for the
slvnvdemo_powerwindow_controller model, next, you will analyze the
model to record additional coverage and create additional test cases.

Use Simulink Design Verifier Software to Record
Additional Coverage

You can use the Simulink Design Verifier software to analyze the
slvnvdemo_powerwindow_controller model and collect coverage. You can
specify that the analysis ignore any previously satisfied objectives and record
additional coverage.

To record additional coverage for the model:
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1 Save the coverage data that you recorded for the logged signals in a file:
cvsave('existingCovFromLoggedSignal',covDataFromLoggedSignals);
2 Create a default options object for the analysis:
opts = sldvoptions;

3 Specify that the analysis ignore objectives that you satisfied when you
logged the signals to the Model block:

opts.IgnoreCovSatisfied = 'on';
4 Specify the name of the file that contains the satisfied objectives data:

opts.CoverageDataFile = 'existingCovFromLoggedSignal.cvt';

5 Specify that the analysis not display unsatisfiable objectives in the
Simulink Diagnostics Viewer:

opts.DisplayUnsatisfiableObjectives = 'off';
For this example, the focus is on satisfying as many objectives as possible.

6 Specify that the analysis create long test cases that satisfy several
objectives:

opts.TestSuiteOptimization = 'LongTestcases';

Creating a smaller number of test cases each of which satisfies multiple
test objectives saves time when you execute the generated code in the next
section.

7 Specify to create a harness model that references the component using a
Model block:

opts.saveHarnessModel = 'on';
opts.ModelReferenceHarness = 'on';

The harness model that you created from the logged signals in “Prepare
the Component for Verification” on page 10-8 uses a Model block that
references the slvnvdemo_powerwindow_controller model. The harness
model that the analysis creates must also use a Model block that references
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slvnvdemo_powerwindow_controller. You can append the test case data
to the first harness model, creating a single test suite.

Analyze the model using the Simulink Design Verifier software:

[status, fileNames] = ...
sldvrun('slvnvdemo_powerwindow_controller',
opts, true);

The analysis creates and opens a harness model
slvnvdemo_powerwindow_controller_harness. The Signal Builder block
contains one long test case that satisfies 82 test objectives.

You can combine this test case with the test case that you created in
“Prepare the Component for Verification” on page 10-8, to record additional
coverage for the slvnvdemo_powerwindow_controller model.

Save the name of the new harness model and open it:

[~, newHarnessModel] = fileparts(fileNames.HarnessModel);
open_system(newHarnessModel) ;

Next, you will combine the two harness models to create a single test suite.

Combine the Harness Models

You created two harness models when you:

® Logged the signals to the control Model block that references the

slvnvdemo_powerwindow_controller model.

® Analyzed the slvnvdemo_powerwindow_controller model.

If you combine the test cases in both harness models, you can record coverage
that gets you closer to achieving 100% coverage:

1 Combine the harness models by appending the most recent test cases to

the test cases for the logged signals:

sldvmergeharness(harnessModel, newHarnessModel);
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The Signal Builder block in the
slvnvdemo_powerwindow_controller_harness model now contains
both test cases.

2 Log the signals to the harness model:

loggedSignalsMergedHarness = sldvlogsignals(harnessModel);

3 Use the combined test cases to record coverage for the
slvnvdemo_powerwindow_controller harness model. First, configure
the options object for sldvruntest:

runOpts = sldvruntestopts;
runOpts.coverageEnabled = true;

4 Simulate the model and record and display the coverage data:

[~, covDataFromMergedSignals] = ...
sldvruntest('slvnvdemo_powerwindow_controller',
loggedSignalsMergedHarness, runOpts);
cvhtml('Coverage with Merged Test Cases',
covDataFromMergedSignals);

The slvnvdemo_powerwindow_controller model now achieves:
® Decision coverage: 100%

¢ Condition coverage: 80%

e MCDC coverage: 60%

Execute the Component in Simulation Mode

To verify that the generated code for the model produces the same results
as simulating the model, use the Code Generation Verification (CGV) API
methods.

Note To execute a model in different modes of execution, use the CGV API to
verify the numerical equivalence of results. For more information about the
CGV API, see “Programmatic Code Generation Verification” in the Embedded
Coder documentation.
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When you perform this procedure, the simulation compiles and executes the
model code using both test cases.

1 Create a default options object for sldvruncgvtest:

runcgvopts = sldvruntestopts('cgv');

2 Specify to execute the model in simulation mode:

runcgvopts.cgvConn = 'sim';

3 Execute the slvnv_powerwindow controller model using the two test
cases and the runcgvopts object:

cgvSim = sldvruncgvtest('slvnvdemo_powerwindow_controller',
loggedSignalsMergedHarness,
runcgvopts);

These steps save the results in the workspace variable cgvSim.

Next, you will execute the same model with the same test cases in
Software-in-the-Loop (SIL) mode and compare the results from both
simulations.

For more information about Normal simulation mode, see “Execute the
Model” in the Embedded Coder documentation.

Execute the Component in Software-in-the-Loop (SIL)
Mode

When you execute a model in Software-in-the-Loop (SIL) mode, the simulation
compiles and executes the generated code on your host computer.

In this section, you execute the slvnvdemo_powerwindow_controller model
in SIL mode and compare the results to the previous section, when you

executed the model in simulation mode.

1 Specify to execute the model in SIL mode:

runcgvopts.cgvConn = 'sil';
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2 Execute the slvnv_powerwindow controller model using the two test
cases and the runcgvopts object:

cgvSil = sldvruncgvtest('slvnvdemo_powerwindow_controller',
loggedSignalsMergedHarness,
runcgvopts);

The workspace variable cgvSil contains the results of the SIL mode
execution.

3 Compare the results in cgvSil to the results in cgvSim, created from the
simulation mode execution. Use the cgv.CGV.compare method to compare
the results from the two simulations:

for i=1:length(loggedSignalsMergedHarness.TestCases)
simout = cgvSim.getOutputData(i);
silout = cgvSil.getOutputData(i);
[matchNames, ~, mismatchNames, ~ ] =
cgv.CGV.compare(simout, silout);
end

4 Display the results of the comparison in the MATLAB Command Window:
fprintf ([ '\nTest Case(%d):"'
'%d Signals match, %d Signals mismatch\r'],...
i, length(matchNames), length(mismatchNames));

As expected, the results of the two simulations match.

For more information about Software-in-the-Loop (SIL) simulations, see
“What are SIL and PIL Simulations?” in the Embedded Coder documentation.
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Considering Specified
Minimum and Maximum
Values for Inputs During
Analysis

¢ “Minimum and Maximum Input Constraints” on page 11-2
¢ “Specify Minimum and Maximum Values for Inport Blocks” on page 11-4

® “Specified Minimum and Maximum Input Values in sldvData Fields” on
page 11-5

¢ “Specify Minimum and Maximum Values for Simulink.Signal Objects”
on page 11-7

® “Specify Minimum and Maximum Values for Stateflow Data Objects” on
page 11-8

o “Specify Minimum and Maximum Values for Subsystems” on page 11-10

e “Specify Minimum and Maximum Values for Global Data Stores” on page
11-12
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Minimum and Maximum Input Constraints

In this section...

“Simulink® Design Verifier™ Support for Specified Input Minimum and
Maximum Values” on page 11-2

“Limitations of Simulink® Design Verifier™ Support for Specified Minimum
and Maximum Values” on page 11-3

When creating a model, you can specify minimum and maximum values on
input ports to mimic environmental constraints as part of your design. The
Simulink Design Verifier analysis can automatically consider these values

as constraints for:

® Design error detection
® Test case generation

® Property proving

Specifying minimum and maximum input values is similar to the way you use
the Test Condition block or the sldv.condition function to constrain signals
during test case generation or the Proof Assumption block or the s1dv.assume
function to constrain signals during property proving. The Test Condition and
Proof Assumption blocks capture the analysis constraints. The Simulink
Design Verifier software can also consider the design constraints captured

in the Inport block minimum and maximum parameters as constraints for
analysis.

Note For more information about signal values, see “Signal Values” in the
Simulink documentation.

Simulink Design Verifier Support for Specified Input
Minimum and Maximum Values

By default, the Simulink Design Verifier software considers any minimum
and maximum input values specified for Inport blocks in your model. To
enable this capability:



Minimum and Maximum Input Constraints

1 In the model window, select Analysis > Design Verifier > Options.

2 On the Design Verifier pane, select the Use specified input minimum
and maximum values parameter.

3 After the analysis completes, to view the design minimum and maximum
constraints for your model, click Generate detailed analysis reports.

The constraints are listed in the Analysis Information chapter of the
Simulink Design Verifier report.

Limitations of Simulink Design Verifier Support for
Specified Minimum and Maximum Values

Simulink Design Verifier support for specified minimum and maximum
values has the following limitations:

¢ The analysis considers specified minimum and maximum values on
root-level Inport blocks only. The analysis ignores any minimum and
maximum values specified on other Simulink blocks.

¢ The analysis does not consider specified minimum and maximum values
on bus objects. The analysis ignores any minimum and maximum values
specified on Simulink bus objects.
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Specify Minimum and Maximum Values for Inport Blocks

You can specify the output minimum and maximum values on Inport blocks
in the Block Parameter dialog box, on the Signal Attributes tab. Set the
following parameters:

¢ Minimum

e Maximum
The following example model restricts the signals from two Inport blocks:

¢ Inputl block: Minimum: 1, Maximum: 5

¢ Input2 block: Minimum: —1, Maximum: 1

Input i

A Compare

n.9 To Zero >

o
- Out1
Logical

D p =0 Operator

Input2:

P Compare

s To Zeroi

When you analyze this model using the Simulink Design Verifier software,
the analysis uses the minimum and maximum values as constraints. The
analysis produces the following results:

¢ The output from Inputl is never less than 0, so the first input to the Logical
Operator block is never false. The objective that the first input to the
Logical Operator equals false is therefore unsatisfiable.

® The Logical Operator block cannot achieve 100% MCDC coverage because
the condition where the first input is false never occurs.

The detailed analysis report indicates the values it used as constraints for
Inputl and Input2.
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Specified Minimum and Maximum Input Values in
sldvData Fields

When you analyze a model, the Simulink Design Verifier software generates
a data file when it completes its analysis. The data file is a MAT-file that
contains an sldvData structure. The sldvData structure stores all the data
that the software gathers and produces during the analysis. You can use the
data file to customize your own analysis or to generate a custom report.
If your model contains specified minimum and maximum values on the input
ports, the sldvData structure contains information about those values. For
example, after analyzing the ex_minmax_on_inports model in “Specify
Minimum and Maximum Values for Inport Blocks” on page 11-4, the data file
contains the following values:
® For the Inputl block:
sldvData.Constraints.DesignMinMax (1) .value{1}.low

ans =

sldvData.Constraints.DesignMinMax (1) .value{1}.high
ans =
5

® For the Input2 block:

sldvData.Constraints.DesignMinMax(2).value{1}.low
ans =

-1
sldvData.Constraints.DesignMinMax(2).value{1}.high

ans =
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Specify Minimum and Maximum Values for
Simulink.Signal Objects

Using the Model Explorer, in the model workspace, you can specify minimum
and maximum values on Simulink.Signal objects associated with input
signals.

The following example model uses the Simulink.Signal objects associated
with the input signals a and b to restrict the signal values:

® Signal a: Minimum: 1, Maximum: 5

e Signal b: Minimum: -1, Maximum: 1

D -

a

Input1_sig -
0. m OR ——(1)
Out1 _si

When you analyze this model, the results are the same as if you specified the
minimum and maximum values on the input ports.

Specifying Signal Ranges on Inport Blocks and Signals If you specify
ranges on the Inport blocks and on the signals, the analysis considers the
tightest range. For example, if you specify a range of 4..12 on an input port

and a range of 1..8 on the signal from the input port, the analysis considers
the range 4..8.
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Specify Minimum and Maximum Values for Stateflow
Data Objects

Using the Model Explorer, you can specify ranges on data objects that are
directly connected to the root-level input ports for a Stateflow chart.

In the following example model, the Stateflow chart named Chart has a data
object x whose range you specified as 0 < x < 10. In this chart, x must be
greater than 15 to trigger the transition from low to high.

xhasrange 0< x < 10

The value of x must fall between 0 and 10, so the transition condition [x >
15] is never true. The transition from low to high never occurs. Because
the high state is never entered, the transition condition [x < 15] is never
tested, and the transition from high to low never occurs; the chart is always
in the low state.

When you analyze this model, the following objectives are proven
unsatisfiable:

® The high state is never entered.
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® The transition condition [x > 15] is always false, never true.

® The condition [Xx < 15] is never tested, so it is never true or false.

The analysis report indicates the values it used as constraints for x: [0, 10].
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Specify Minimum and Maximum Values for Subsystems

11-10

The Simulink Design Verifier software considers specified input minimum
and maximum values as constraints only at the top level of a model. You can
specify minimum and maximum values on Input ports on subsystems, but
when you analyze the top-level model, the software ignores those values.

However, when you perform the subsystem analysis, the software considers
specified minimum and maximum values on the input ports of the subsystem.

For example, consider the following model, and its subsystem.

T r— 7|-C p =i ssouth—»(1 )
oz

0. m Subsystem

In Subsystem, the specified minimum and maximum values for input port
SSIn are —10 and 10, respectively. The lower and upper limits for the
Saturation block are —15 and 15, respectively.

Cor——F—C
55N o — S50ut
£10,10] aturation

-1510 18

If you right-click Subsystem in the top-level model and select Generate Tests
for Subsystem, the analysis considers the specified minimum and maximum
values as constraints on the SSIn port.

Constraints

Design Min Max Constraints

Name Design Min Max Constraint
S3In [-10, 10]
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The analysis identifies two unsatisfiable objectives:

® input > lower limit F: The input is always greater than the lower limit on
the Saturation block (—15).

® input >= upper limit T: The input is never greater than or equal to the
upper limit (15).

If you analyze the model that contains Subsystem, the analysis does not
consider the values specified on the input port SSIn in the subsystem. The
analysis considers only the root-level input ports at the respective level of
the hierarchy for analysis.
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Specify Minimum and Maximum Values for Global Data

Stores

11-12

A data store is a repository to which you can write data and from which you
can read data, without having to connect an input or output signal directly to
the data store. You create a data store using a Data Store Memory block or
a Simulink.Signal object. You can specify minimum and maximum values
for any data store.

As described in “Extract Subsystems for Analysis” on page 14-17, during
subsystem analysis, the Simulink Design Verifier software creates a new
input port to mimic the execution context for a global data store. If the data
store has specified minimum and maximum values, those values are assigned
as minimum and maximum values on the new input port. The input minimum
and maximum values are used as subsystem-level analysis constraints.

In the following example model, data store A has a minimum value of 0 and a
maximum value of 10.

A o>
Data Store Cutt
Memory Subsystemn

The atomic subsystem reads from the data store and checks to see if the input
is less than 0. The Compare To Zero block outputs 1 if the input is less than 0,
and outputs 0 if the input is greater than or equal to 0. The Test Objective
block checks to see if the output is ever 1.

{13
] <o bO—
Cutl
Data Store Compare
Fead To Zero
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If you right-click Subsystem in the top-level model and select Generate
Tests for Subsystem, the analysis considers the constraints for data store A
to be [0, 10].

The analysis does not satisfy the objective specified in the Test Objective
block. The input is always greater than or equal to 0, so the output from the
Compare To Zero block is always 0.
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* “What Is Property Proving?” on page 12-2

* “Workflow for Proving Model Properties” on page 12-4

® “Prove Properties in a Model” on page 12-5

® “Prove System-Level Properties Using Verification Model” on page 12-26
® “Prove Properties in a Subsystem” on page 12-31

¢ “Model Requirements” on page 12-32
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What Is Property Proving?

A property is a requirement that you model in Simulink or Stateflow, or using
MATLAB Function blocks. A property can be a simple requirement, such as a
signal in your model that must attain a particular value or range of values
during simulation.

A property can also be a requirement on the model that involves a number
of input and output signals modeled as a logical expression that needs to be
proved.

The Simulink Design Verifier software performs a formal analysis of your
model to prove or disprove the specified properties. After completing the
analysis, the software offers several ways for you to review the results:

e Highlighted on the model

® A harness model with test cases

e A detailed HTML report

Proof Blocks

The Simulink Design Verifier software provides two blocks so you can specify
property proofs in your Simulink models:

¢ Proof Objective — Define the values of a signal to prove

® Proof Assumption — Constrain the values of a signal during a proof

Note Blocks from the Model Verification library in the Simulink software
behave like Proof Objective blocks during Simulink Design Verifier proofs.
You can use Assertion blocks and other Model Verification blocks to specify
properties of your model. For more information about these blocks, see “Model
Verification” in the Simulink documentation.
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Proof Functions

The Simulink Design Verifier software provides two Stateflow and MATLAB
for code generation functions to specify property proving for a Simulink model
or Stateflow chart:

® sldv.prove — Specifies a proof objective

® sldv.assume — Specifies a proof assumption
These functions:
¢ Identify mathematical relationships for proving properties in a form that

can be more natural than using block parameters

® Support specifying multiple objectives, assumptions, or conditions without
complicating the model.

¢ Provide access to the power of MATLAB.

® Support separation of verification and model design.

For an example of how to use these proof functions, see the sldv.prove
reference page.

Note Simulink Design Verifier blocks and functions are saved with a model.
If you open the model on a MATLAB installation that does not have a
Simulink Design Verifier license, you can see the blocks and functions, but
they do not produce results.

12-3



12 Proving Properties of a Model

Workflow for Proving Model Properties

To prove properties of your design model, use the following workflow:

1 Determine the verification objectives for your design model, e.g., based on
your requirements specifications.

2 Instrument your design model to specify proof objectives and proof
assumptions.

¢ For simple properties, instrument your model with blocks or MATLAB
functions that specify the proof objectives.

¢ For system-level properties, construct a verification model that contains
a Model block that references the design model and define the properties
on the design model interface using the same inputs and outputs.

3 Define analysis constraints using the Proof Assumption block or
sldv.assume. These constraints apply to all enabled proof objectives.

Note The proof assumptions are applied to all enabled proof objectives.
Make sure that you do not specify any contradictory assumptions because
that might invalidate the entire analysis.

4 Specify options that control how Simulink Design Verifier proves the
properties of your model.

5 Execute the Simulink Design Verifier analysis and review the results.

For an exercise that demonstrates this workflow, see “Prove Properties in a
Model” on page 12-5.
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Prove Properties in a Model

In this section...

“About This Example” on page 12-5

“Construct Example Model” on page 12-6

“Check Compatibility of Example Model” on page 12-7
“Instrument Example Model” on page 12-8
“Configure Property-Proving Options” on page 12-9
“Analyze Example Model” on page 12-10

“Review Analysis Results” on page 12-10
“Customize Example Proof” on page 12-20
“Reanalyze Example Model” on page 12-21
“Review Results of Second Analysis” on page 12-21
“Analyze Contradictory Models” on page 12-24

“Prove Properties in a Large Model” on page 12-25

About This Example

The following sections describe a Simulink model, for which you prove

a property that you specify using a Proof Objective block. This example
demonstrates the property-proving capabilities of the Simulink Design

Verifier software.

In this example, you perform the following tasks.

Task | Description See...

1 Construct the example “Construct Example Model” on page
model. 12-6

2 Verify that your model “Check Compatibility of Example
is compatible with the Model” on page 12-7
Simulink Design Verifier
software.
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Task | Description See...

3 Add a Proof Objective block | “Instrument Example Model” on page
to your model to prepare for | 12-8
its proof.

4 Configure the Simulink “Configure Property-Proving Options”
Design Verifier software to | on page 12-9
prove properties.

5 Prove a property of your “Analyze Example Model” on page
model. 12-10

6 Review the analysis results. | “Review Analysis Results” on page

12-10

7 Add proof assumptions to “Customize Example Proof” on page
specify analysis constraints. | 12-20

8 Prove a property of the “Reanalyze Example Model” on page

customized model and
interpret the results.

12-21

Construct Example Model

Construct a Simulink model to use in this example:

1 Create an empty Simulink model.

2 Copy the following blocks into your empty model window:

¢ From the Sources library, an Inport block to initiate the input signal
whose value the Simulink Design Verifier software controls

¢ From the Logic and Bit Operations library, a Compare To Zero block to
provide simple logic

® From the Sinks library, an Outport block to receive the output signal

3 Connect these blocks such so your model appears similar to the following
model:
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In Gt
C ompare
To Zero

4 In the model window, select Simulation > Model Configuration
Parameters.

5 On the left side of the Configuration Parameters dialog box, in the Select
tree, click the Solver category. On the right side, under Solver options:

e Set the Type option to Fixed-step.

® Set the Solver option to Discrete (no continuous states).

The Simulink Design Verifier can analyze only models that use a fixed-step
solver.

6 Click OK to save your changes and close the Configuration Parameters
dialog box.

7 Save your model with the name ex_property proving_example basic.

Check Compatibility of Example Model

Every time Simulink Design Verifier software analyzes a model, before the
analysis begins, the software performs a compatibility check. If your model
is not compatible, the software cannot analyze it.

You can also make sure you model is compatible with the Simulink Design
Verifier software before you start the analysis:

1 Open the ex_property proving_example basic model.

2 In the model window, select Analysis > Design Verifier > Check
Compatibility > Model.

The Simulink Design Verifier software displays the log window, which
states whether or not your model is compatible.

The model you just created is compatible.
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Simulink Design Verifier log: ex_property_proving_example_basic @

21-May-2012 16:10:25

Checking compatibility of model
'ex_property_proving_example_basic'

Compiling model... done

Checking compatibility... done
'ex_property_proving_example_basic' is compatible with Simulink
Design Verifier.

| Save Log || Clase

What If a Model Is Partially Compatible?

If the compatibility check indicates that your model is partially compatible,
your model contains at least one object that the Simulink Design Verifier
software does not support. You can analyze a partially compatible model, but,
by default, unsupported objects are stubbed out. The results of the analysis
may be incomplete. For detailed information about automatic stubbing, see
“Handle Incompatibilities with Automatic Stubbing” on page 2-8.

Instrument Example Model

Prepare your example model so that you can prove its properties with the
Simulink Design Verifier software. Specifically, instrument the model by
adding and configuring a Proof Objective block:

1 In the MATLAB Command Window, enter sldvlib.
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The Simulink Design Verifier library appears.
2 Open the Objectives and Constraints sublibrary.

3 Copy the Proof Objective block to your model and insert it between the
Compare To Zero and Outport blocks.

4 In your model, double-click the Proof Objective block.
The Proof Objective block parameters dialog box opens.
5 In the Values box, enter 1.

The Simulink Design Verifier software will attempt to prove that the
signal output by the Compare To Zero block always attains this value for
any signals that it receives.

6 Click OK to apply your changes and close the Proof Objective block
parameters dialog box.

CO—=}—o->m

In1 Out1
C ompare

To Zero

7 Save your model and keep it open.

Configure Property-Proving Options

Configure the Simulink Design Verifier software to prove properties of the
ex_property_proving_example_basic model that you instrumented:

1 Open the ex_property_proving _example_ basic model.

2 In your Simulink model window, select Analysis > Design
Verifier > Options.

3 On the left side of the Configuration Parameters dialog box, in the Select
tree, select the Design Verifier category. Under Analysis options on the
right side, set the Mode parameter to Property proving.
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4 Click OK to apply your changes and close the Configuration Parameters
dialog box.

Note On the Property Proving pane, you can optionally specify values
for other parameters that control how the Simulink Design Verifier
software proves properties of your model. For more information, see
“Design Verifier Pane: Property Proving” on page 15-41.

5 Save the ex_property _proving example basic model.

Analyze Example Model

To analyze the ex_property _proving example basic model, in the model
window, select Analysis > Design Verifier > Prove Properties > Model.
The Simulink Design Verifier software begins a property-proving analysis.

During the analysis, the log window shows the progress of the analysis. It
displays information such as the number of objectives processed and which
objectives were satisfied or falsified.

To terminate the analysis at any time, in the log window, click Stop.

Review Analysis Results

When the analysis is complete, the log window displays the following options
for reviewing the results:

Highlight the analysis results on the model

Generate a detailed HTML analysis report

Create a harness model with test cases

Simulate the test cases created by the model and produce a model coverage
report

You can also view the Simulink Design Verifier data file. For detailed
information about the data file, see “Simulink® Design Verifier™ Data Files”
on page 13-9.
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The following sections describe how you can review the analysis results:

¢ “Review Results on Model” on page 12-11

¢ “Review Detailed Analysis Report” on page 12-13

¢ “Review Harness Model” on page 12-16

® “Simulate Model with Counterexample” on page 12-18

e “Review Analysis Results in the Model Explorer” on page 12-19

Review Results on Model
You can review the analysis results at a glance by viewing the blocks that are

highlighted in the model window. The highlighting can have four colors:
® Green — The analysis proved all the proof objectives valid.

¢ Red — The analysis disproved a proof objective and generated a
counterexample that falsified that objective.

® Orange — The analysis disproved a proof objective, but it could not
generate a counterexample or the proof objective remained undecided. This
result occurs due to:

= A proof objective on a signal whose value the software cannot control, for
example, a Constant block

A proof objective that depends on nonlinear computation
A proof objective that creates an arithmetic error, such as division by zero

Automatic stubbing being enabled, and the analysis encountering an
unsupported block whose operation it does not understand but that the
analysis requires to generate the counterexample

The analysis timing out

Limitations of the analysis engine

® Gray — The model object was not part of the analysis.
Highlight the analysis results on the example model:

1 In the log window for the ex_property proving_example basic analysis,
click Highlight analysis results on model.
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1
<0
In1 Cut
Compare
To Zero

The Proof Objective block is highlighted in red, which indicates that a proof
objective was falsified with a counterexample.

The Simulink Design Verifier Results window appears.

P

= = Y
Close results

Property proving completed normally
Al 1 objectives falsified,

@ Simulink Design Verifier Results EI@
- W

Results:

* iew detailed analysis report
* Open harness model

As you click objects in the model, this window changes to display detailed
analysis results for that object.
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.

E Simulink Design Verifier Results EI@
Fati w AW
Back to summary - Close results
ex_property_proving_esxample/Proof Objective
Objective: 1 ERROR - View counterexample

Tip By default, the Simulink Design Verifier Results window is always
the topmost visible window. To allow the window to move behind other
window, click B8 and clear Always on top.

2 Click the highlighted Proof Objective block.

The Simulink Design Verifier Results window indicates that the proof
objective that the output signal from the Compare to Zero was not 1 was
disproved with a counterexample.

Review Detailed Analysis Report
To create a detailed HTML analysis report:

1 In the Simulink Design Verifier log window, click Generate detailed
analysis report.

The HTML report opens in a browser window.

2 The report includes the following Table of Contents. Click a hyperlink to
navigate to particular section in the report.
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Table of Contents

1. Summary

2. Analysis Infarmation
3. Proof Objectives Status

4. Properties

3 In the Table of Contents, click Summary.

Chapter 1. Summary

Analysis Information

hodel: ex_property_proving_example
Made: FropertyPraving

otatus: Completed normally

Analysis Time: Os

Objectives Status

Number of Objectives: 1
Objectives Falsified with Counterexamples: 1

The Summary provides an overview of the analysis results, and it indicates
that the Simulink Design Verifier software identified a counterexample
that falsifies an objective in your model.

4 Scroll back to the top of the browser window. In the Table of Contents,
click Proof Objectives Status.
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Objectives Falsified with Counterexamples

#: [Type lModel ltem Description Counterexample
Custom

1 Proof Froof Objective  |Objective: 1 1
Ohbjective

The Objectives Falsified with Counterexamples table lists the proof
objectives that the Simulink Design Verifier software disproved using a
counterexample that it generated. You can locate the objective in your
model window by clicking Proof Objective; the software highlights the
corresponding Proof Objective block in your model window.

5 In the Objectives Falsified with Counterexamples table, under the
Counterexample column, click 1.

Proof Objective

Summary

bodel lterm: Proof Ohjective
Property:  Objective; 1
Status: Falsified

Counter Example

Time |0
Step
InT 11

—

This section displays information about proof objective 1 and provides
details about the counterexample that the Simulink Design Verifier
software generated to disprove that objective. In this counterexample, a
signal value of 99 falsifies the objective that you specified using the Proof
Objective block. That 1s, 99 is not less than or equal to 0, which causes the
Compare To Zero block to return O (false) instead of 1 (true).
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Review Harness Model

Create a harness model with counterexamples that falsify the proof objectives
in your model:

1 In the Simulink Design Verifier log window, click Create harness model.

The software creates a harness model named
ex_property_proving_example_basic_harness.

Size Type
Counterexample 1
% In In1 outif——»( 1)
] Out1
Inputs Test Unit {copied from ex_property_proving_example)
Il-.
DoC
Teaxt

Test Case Explanation

The harness model contains the following items:

¢ Signal Builder block named Inputs — A group of signals that falsify
proof objectives.

® Subsystem block named Test Unit — A copy of your model.

® DocBlock named Test Case Explanation — A textual description of the
counterexamples that the analysis generates.

¢ A Size-Type block — A subsystem that transmits signals from the Inputs
block to the Test Unit block. This block verifies that the size and data
type of the signals are consistent with the Test Unit block.

2 Double-click the Inputs block.
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n Signal Builder (ex_property_proving_example_harness/Inputs) E@
File Edit Group Signal Axes  Help N
SH $BR|oo| —~J0EFRER > 0 o0 45|
Active Group: | Counterexample 1 v: @ . | ™ -
g - e
In1 . : . : : | : | :
1.8F--------- R RROE e T Tt
e Ll i —S,
L A TR S S e
T B .
1 ¢
7 ISR S — — S— S— — S— SE— A— j
3 .S L SOy SOOI SRR
(7] SRS S SFSON SES S — SRS N R —
R A e B L
0 i i i i i i i i i j
0 0.02 0.04 0.06 0.08 0.1 0.12 0.14 0.16 0.18 0.2
Time (sec)
Left Point Right Point Inl [shown) ~
Name: |n1 T: T:
Index: 1 v: Y: Y:
ok In1 (#1) [ YMin ¥Max ]

The input signal 1 causes the output of the Compare to Zero block to be 0.
This counterexample violates the proof objective that specifies that the
output of the Compare to Zero block be 1.
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Simulate Model with Counterexample

Simulate the harness model to observe the counterexample that falsifies the
proof objective in your model:

1 In the ex_property_proving example_basic model window, select
View > Library Browser

2 From the Sinks library, copy a Scope block into your harness model
window. The Scope block allows you to see the value of the signal output by
the Compare To Zero block in your model.

3 In your harness model window, connect the output signal of the Test Unit
subsystem to the Scope block.

Size Type
Counterexample 1
% In In‘ Out1 e 1)
L] Out1
Inputs Test Unit {copied from ex_property_proving_esamgdle)
Ib_
ooC
Teaxt
Test Case Explanation o |

Scope
4 In your harness model window, select Simulation > Run to begin the
simulation.
The Simulink software simulates the harness model.

5 In your harness model window, double-click the Scope block to open its
display window.
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B scope fo o)
AN LIE R

The Scope block displays the value of the signal output by the Compare To
Zero block in your model. In this example, the Compare To Zero block
returns 0 (false) throughout the simulation, which falsifies the proof
objective that the output of the Compare to Zero block be 1 (true). The
counterexample that the Signal Builder block supplies falsifies the proof
objective.

Review Analysis Results in the Model Explorer

As long as your model remains open, you can view the results of your most
recent Simulink Design Verifier analysis results in the Model Explorer.

In the Simulink Editor, select Analysis > Design Verifier > Latest
Results. The Model Explorer opens, and the results of the latest Simulink

Design Verifier analysis appear in the right-hand pane.

For any Simulink Design Verifier analysis, from the Model Explorer, you can
perform the following tasks.
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Task

For more information

Highlight the analysis results on the
model.

“Highlighted Results on the Model”
on page 13-2

Generate a detailed analysis report.

“Simulink® Design Verifier™
Reports” on page 13-29

Create the harness model, or if the
harness model already exists, open
it.

If no counterexamples were created
during the analysis, this option is
not available.

“Simulink® Design Verifier™
Harness Models” on page 13-17

View the data file.

“Simulink® Design Verifier™ Data
Files” on page 13-9

View the log file.

“Simulink® Design Verifier™ Log
Files” on page 13-56

After you close your model, you can no longer view the analysis results.

Customize Example Proof

Modify the simple Simulink model whose proof objective the Simulink Design
Verifier software disproved in the previous task. Specifically, customize the
proof by adding and configuring a Proof Assumption block:

1 In the MATLAB Command Window, type sldvlib.

The Simulink Design Verifier library opens.

2 Open the Objectives and Constraints sublibrary.

3 Copy the Proof Assumption block to your model.

4 In your model window, insert the Proof Assumption block between the

Inport and Compare To Zero blocks.

5 In your model, double-click the Proof Assumption block to access its

attributes.
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The Proof Assumption block parameter dialog box opens.

6 In the Values box, enter [-1, 0]. When proving properties of this
model, the Simulink Design Verifier software constrains the signal values
entering the Compare To Zero block to the specified range. If the input to
the Compare to Zero block is always within this range, the output of the
Compare to Zero block will always be 1.

7 Click Apply and then OK to apply your changes and close the Proof
Assumption block parameter dialog box.

1.0 1

-0 < -0+

In1 Out1
Compare

To Zero

8 Save the ex_property_proving_example_basic model and keep it open.

Reanalyze Example Model
Analyze the model that you modified to see how the Proof Assumption block
affects the property-proving analysis.

In the ex_property_proving_example_basic model window, select
Analysis > Design Verifier > Prove Properties > Model.

When the analysis is complete, the log window displays the options. There is
no option to create a harness model, because the analysis satisfied all proof
objectives in your model, so there are no counterexamples.

Review Results of Second Analysis
Review the results of the second analysis:

e “Review Results on the Model” on page 12-22
® “Review Analysis Report” on page 12-22
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Review Results on the Model
Highlight the model to see the analysis results:

1 Click Highlight analysis results on model.

The Proof Objective is now highlighted in green.

[1.0]
— =0 —
Im Cut
Compare
To Zero

2 Click the Proof Objective block.

The Simulink Design Verifier Results window shows that the proof
objective that states that the signal be 1 is valid.

-

E Simulink Design Verifier Results EI@
aivy - W

Back to summary - Close results
ex_property_proving_example_with_pa_block/Proof Objective
Objective; 1 VALID

Review Analysis Report
Review the analysis results in the detailed report:

1 Click Generate detailed analysis report.
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2 In the Table of Contents, click Summary.

Chapter 1. Summary

Analysis Information

Madel: ex_property_proving_example_basic
Mode: FropertyProving

Status: Completed normally

Analysis Time: Os

Objectives Status

Number of Objectives:
Cbjectives Proven Valid:

The Summary chapter indicates that the Simulink Design Verifier software
proved a proof objective in the model.

3 The Constraints section lists the analysis constraint you specified in the

Proof Assumption block.

Constraints

Analysis Constraints

Name

Analysis Constraint

Assumption

[-1.0]

4 Scroll back to the top of the browser window. In the Table of Contents,
click Proof Objectives Status.

12-23



12 Proving Properties of a Model

12-24

Objectives Proven Valid

# Type Model ltem Description Counterexample
1 PI".:'Df. Froof Objective |Ohjective: 1 n'a
ohjective

The Objectives Proven Valid table lists the proof objectives that the
Simulink Design Verifier software proved to be valid.

5 Scroll down to view the Properties chapter or go to the top of the browser
window and in the Table of Contents, click Properties.

Proof Objective

Summary

Maodel ltem: Proof Ohjective
Property:  Objective: 1
Status Proven valid

The Proof Objective summary indicates that the Simulink Design Verifier
software proved an objective that you specified in your model. The Proof
Assumption block restricts the domain of the input signals to the interval
[-1, 0]. Therefore, the software proves that this interval does not contain
values that are greater than zero, thereby satisfying the proof objective.

Analyze Contradictory Models

If the analysis produces the error The model is contradictory in its
current configuration, the software detected a contradiction in your model
and it cannot analyze the model. You can have a contradiction if your model
has Proof Assumption blocks with incorrect parameters. For example, an
assumption could state that a signal must be between 0 and 5 when the
signal i1s constant 10.
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If the software detects a contradiction, all previous results are invalidated
and the software reports that all the properties are falsified.

Prove Properties in a Large Model

A thorough proof of your model requires that the Simulink Design Verifier
software search through all reachable configurations of your model—even the
ones that are reached only after long time delays. The computation time and
memory required to search a model completely often make an exhaustive
proof impractical.

“Prove Properties in Large Models” on page 14-28 gives detailed information
about strategies you can use to improve the performance of a property-proving
analysis of a large model.
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Prove System-Level Properties Using Verification Model

12-26

In this section...

“When to Use a Verification Model for Property Proving” on page 12-26
“About this Example” on page 12-26

“Understand the Verification Model” on page 12-27

“Prove the Properties of the Design Model” on page 12-27

“Fix the Verification Model” on page 12-29

When to Use a Verification Model for Property
Proving

If your model has system-wide properties that affect the behavior of the
model, you might want to prove the properties without changing the design
model. To do this, you create a verification model that includes:

® Model block that references the design model

¢ One or more verification subsystems that define the properties and any
required constraints

About this Example

The design model sldvdemo_sbr_design models the logic for a seat belt
reminder light. If the ignition is turned on, the seat belts are unfastened, and
the car exceeds a certain speed, the seat belt reminder light turns on.

The sldvdemo_sbr_verification model is a verification model that defines
some constraints and verifies the properties in the sldvdemo_sbr_design
model. The Model block in the verification model references the design model,
so that the verification logic exists only in the verification model.

The sldvdemo_sbr_verification model contains a property that is falsified,
because a constraint is disabled. In the sldvdemo_sbl verification_fixed
model, the constraint is enabled and all the properties are proven valid.
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Understand the Verification Model

Take these steps to understand how the verification model works:

1 Open the verification model:

sldvdemo_sbr_verification

The Design Model block is a Model block that references
sldvdemo_sbr_design. The SBR Stateflow chart in the design model
assumes that the KEY input is initially O.

2 Open the Safety Properties subsystem that specifies the properties of the
design model that you want to prove.

This subsystem contains a MATLAB Function block called MATLAB
Property. The code in this block specifies the property that the seat belt
reminder should be on when the ignition is on, the seat belt is not fastened,
and the speed is less than 15:

3 Close the Safety Properties subsystem.
4 Open the Input Constraints subsystem.

This subsystem defines the following constraints:
® The key can have three positions: 0, 1, 2
¢ The speed is constrained to fall between 10 and 30.

® The key must start at 0 and can only change by one increment at a time.
For example, the key can change from 0 to 1 or 1 to 2, but not from 0 to
2. In this verification model, this constraint is not enabled.

5 Close the Input Constraints subsystem, but keep the
sldvdemo_sbr_verification model open.

Prove the Properties of the Design Model

Analyze the sldvdemo_sbr_verification model to prove the properties:

1 In the sldvdemo_sbr_verification model window, to start the analysis,
double-click the Run button to start the analysis.
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When the analysis completes, the Simulink Design Verifier log window
indicates that one objective was falsified.

2 To see which objective was falsified, click Highlight analysis results
on model.

The Safety Properties subsystem is highlighted in red.

3 Open the Safety Properties subsystem and click the MATLAB Property
block.

The Simulink Design Verifier Results window indicates that the statement

sldv.prove(implies(activeCond,SeatBeltIcon))

was false during at least one time step.

.

E Simulink Design Verifier Results EI@
i - &

Back to summary - Close results
sldvdemo_sbr_wverification/Safety Properties/MATLAB Property
sldv, prove (implies(activeCond,SeatBeltlcon)) ERROR - View
counterexample

4 Click View counterexample to see the signal values that violated this
property.

The Signal Builder block opens with the counterexample. The KEY input
was initially 2, which is invalid.

To validate the property specified in the Safety Properties subsystem, you
have to make sure that the initial value of KEY is 0.
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Fix the Verification Model

The Input Constraints subsystem in the verification model contained three
constraints. The third constraint, which requires that the initial value of KEY
be 0, and that KEY can only change in increments of 1, is disabled.

{intBe0),intS{1),imtS{2)}

fi{[10 30] fecdt{0 16 2))

| [Speed] -

int3([-1 1]}

| =

Y

| [Key] — —
il

To see how this property is validated when you enable the third constraint:
1 In the sldvdemo_sbr_verification model, click Open Fixed Model.
The sldvdemo_sbr_verification_fixed verification model opens.

2 Open the Input Constraints subsystem.

This third constraint is now enabled so that KEY has an initial value of
0 and changes in increments of 1.

3 Close the Input Constraints subsystem.

4 In the sldvdemo_sbr_verification_fixed model, to start the analysis,
double-click the Run block.
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The analysis proves the validity of the property.
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Prove Properties in a Subsystem

If you have a large model, you can prove the properties of a subsystem in the
model and review the analyses in smaller, manageable reports. The workflow

for proving properties in a subsystem is:
1 Open the model that contains the subsystem.

2 Make the subsystem atomic.

3 Run the Simulink Design Verifier software using the Prove Properties of
Subsystem option.

4 Review the results.

The tutorial in “Analyze a Subsystem” on page 1-27 explains how to generate
test cases for the Controller subsystem in the Cruise Control Test Generation
model. The steps for proving properties are similar to those for generating
test cases, except that you select the Prove Properties of Subsystem option
instead of the Generate Tests for Subsystem option.
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Model Requirements

The Simulink Design Verifier block library includes a sublibrary Example
Properties. The Example Properties sublibrary includes:

* “Basic Properties” on page 12-32 — Four examples that demonstrate how
to prove basic properties.

e “Temporal Properties” on page 12-36 — Four examples that demonstrate
how to define temporal properties on Boolean signals

The workflow for using these examples in your model is:

1 Copy these examples into your Verification Subsystem block.
2 Adapt them, if required, for the specific properties that you want to prove.

3 Run the Simulink Design Verifier analysis to prove that the assertions in
these examples never fail.

4 If the assertion fails, the software creates a counterexample that causes the
assertion to fail and then generates a harness model.

5 On the harness model, execute the counterexample to confirm that the
assertion fails with that counterexample.

Basic Properties
To view the Basic Properties examples:

1 Open the Simulink Design Verifier block library. Type:
sldvlib
2 Double-click the Examples sublibrary.
3 Double-click the Basic Properties block that contains the examples.

The sections that follow describe each example in the Block Properties
sublibrary in detail.
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Conditions that Trigger a Result

The Simulink Design Verifier Implies block allows you to test for conditions
that trigger a result. This example specifies that if condition A is true, result B
must always be true.

e NN BN

res ult Assertion
Implies

Implies operation describes conditions that should trigger a resul.

Increasing or Decreasing Signals
The two examples in this section specify that a signal is either:

¢ Always increasing or staying constant

® Always decreasing or staying constant
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-
> 1
incress ing = Assertion
delayi g
-
D S SN R BN
decressing = Assertiond
delayd gte

Increasing and decreasing operations describe signals that
should increase or decrease.

Exclusivity Operation

This example describes four conditions that should not be true at the same
time.
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moded =0 > z Rl — ::|
(11— Logic Sumi check 1

modeT Value] Azsertiond

Exclusivity operation describes conditions that should
never be true at same time.

Conditions with One True Element
This example specifies that only one of the four input signals can be true.
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:

modeq

—

Logic Sumn chedk

Aszsertiont
moded Value

?

Mutual exclusivity operation describes conditions that should
have exactly ane true element.

Temporal Properties
To view the Temporal Properties examples:

1 Open the Simulink Design Verifier block library. Type:
sldvlib
2 Double-click the Temporal Properties sublibrary.
3 Double-click the Temporal Properties block that contains the examples.

The sections that follow describe each example in the Temporal Properties
sublibrary in detail.

Synchronize the Output with the Input

When the input In1 equals ACTIVE, the input In2 is set to INACTIVE after
five time steps.
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Whenewver In1 becomes ACTNE, then In2 shall become INACTWNE after a delay of 5 steps.

|

(s )—» b
n - Ot —|_'
ACTIVE J -

In2 J—D
INACTIVE

A=»BF—

¥

Make a Signal Inactive After a Delay

In this example, after five consecutive time steps where the SENSOR_HIGH
input is true, the CMD signal becomes true. CMD is true as long as SENSOR_HIGH
is true, unless the block is reset by the MANUAL_RESET signal.

After Sensor is detected at HIGH for 5 consecutive steps, Cmd becomes and stays true for
the remaining duraticn of the 5ensor value HIGH unless manual reset is detected.

j

D
3 Out
SENSD:._HICH L™ —|_> e
(2 ) =i R

h J
0

MANUAL RESET A==B

Extend a True Signal

In this example, after the input becomes true, the output becomes true for the
number of time steps specified in the Detector block, in this case, 5. The input
remains true for 5 time steps as well.
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Whenever In becomes true, it shall stay true for the following 5 steps as well.

i T
" —— Owp E true

¥

¥

Test the Input Against a Specified Threshold

When the input In3 equals ON and the input In4 is less than the constant
THRESHOLD, In3 is set to OFF within five time steps.

Whenever In3 is ON and Ind is less that THRESHIOLD, then In3 shall become OFF within 5 steps.

Ind
THRESHOLD » > I =
> AMND . Ot
L e
n 1T
ON _ | E——

R

o |®
g
i
lv Yy
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Reviewing the Results

e “Highlighted Results on the Model” on page 13-2

® “Simulink® Design Verifier™ Data Files” on page 13-9

® “Simulink® Design Verifier™ Harness Models” on page 13-17
e “Export Test Cases to SystemTest” on page 13-26

* “Simulink® Design Verifier™ Reports” on page 13-29

® “Simulink® Design Verifier™ Log Files” on page 13-56

¢ “Review Analysis Results” on page 13-58
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Highlighted

13-2

Results on the Model

In this section...

“Results Review with Model Highlighting” on page 13-2
“Simulink® Design Verifier™ Results Inspector” on page 13-2
“Enable Highlighted Results on a Model” on page 13-3
“Green Highlighting on Model” on page 13-5

“Red Highlighting on Model” on page 13-6

“Orange Highlighting on Model” on page 13-6

“Gray Highlighting on Model” on page 13-8

Results Review with Model Highlighting

When you analyze a model using the Simulink Design Verifier software, you
can highlight the analyzed model objects in one of four colors:

* Green

® Red

® Orange

* Gray

Model highlighting allows you to review the analysis results at a glance by
viewing the objects that are highlighted in the Simulink Editor.

Simulink Design Verifier Results Inspector

When a model is highlighted, you can click an object for which the analysis
recorded results. When you click the object, the Simulink Design Verifier
Results Inspector displays the detailed analysis results for that object.

The Results Inspector does not display detailed results for Stateflow state
transition tables, but analysis data for state transition tables is included in
Simulink Design Verifier reports, data files, and log files.
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Enable Highlighted Results on a Model

For test case generation or property proving analysis, to enable results
highlighting on the model after analysis is complete, do one of the following:

¢ Before the analysis, in the Configuration Parameters dialog box, on the
Design Verifier > Results pane, select Display the results of the
analysis on the model.

e After the analysis, in the Simulink Design Verifier log window, select
Highlight analysis results on model.

For design error detection analysis, results highlighting on the model after
analysis is complete is enabled by default.

For all analysis types, you can also highlight results on the model during
analysis. To do this, in the Results Summary window, click Highlight.
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L ]

Sirnulink Design Verifier Results Summary: sldvdemo_fuelsys_logic | 2 |

Progress I

Objectives processed 118/133

m

Satisfied 115
Falsified 3
Elancad tima n-4g 3

27-Jun-2013 16:39:29

Starting test generation for model 'sldvdemao_fuelsys_logic'
Compiling model... done

Translating model... done

‘sldvdemo_fuelsys_logic' is compatible with Simulink Design
Verifier.

enerating tests...

SATISFIED

control
logic.Fueling_Mode.Running.Low_Emissions."[in{02.normal}]"
Transition: Transition trigger expression F

Analysis Time = 00:00:40

| Highlight | |  Stop
L’

In the Simulink Editor, results highlighting appears on the model. Model
objects that the analysis has not yet processed display in orange.
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The Results Inspector also opens, displaying the elapsed time of the analysis
and a summary of status for analysis objectives.

.

a4

Close results

Results:

%Simulink Design Verifier Results Inspector EI@

Test generation in progress. The time elapsed is 0:46
115 of 133 objectives satisfied

3 of 133 objectives proven unsatisfiable

15 of 133 ohjectives undecided

* Generate detailed analysis report

~ i

Green Highlighting on Model

Objects that are highlighted in green have the following meaning for each

type of analysis.

Analysis mode

Green highlighting means...

Design error
detection

One of the following:

¢ The analysis did not find overflow or
division-by-zero errors.

¢ The analysis did not find dead logic

¢ The analysis did not find intermediate or output
signals outside the range of user-specified
minimum and maximum constraints.

¢ The analysis did not find out of bound array access
errors.

Test-case
generation

The analysis found test cases that satisfy the test
objectives.

Property proving

The analysis proved all the proof objectives valid.
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Red Highlighting on Model

Objects that are highlighted in red have the following meaning, depending
on the analysis type.

Analysis mode Red highlighting means...

Design error One of the following:

detection

¢ The analysis found at least one test case that
causes overflow or division-by-zero errors.

® The analysis found dead logic.

¢ The analysis found intermediate or output signals
outside the range of user-specified minimum and
maximum constraints.

¢ The analysis found at least one test case that
causes an out of bound array access error.

Test-case The analysis could not satisfy certain test objectives.
generation
Property proving The analysis disproved a proof objective and generated

a counterexample that falsified that objective.

Orange Highlighting on Model

Objects that are highlighted in orange have the following meaning, depending
on the analysis type.

Analysis mode Orange highlighting means...
Design error For the highlighted model object, the analysis did not
detection decide at least one design error detection objective.

This situation can occur when:

¢ The analysis is still in progress.
¢ The analysis times out.

¢ The analysis cannot decide a design error detection
objective because of division by zero or nonlinear
computation.
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Analysis mode

Orange highlighting means...

The software cannot decide a design error
detection objective because of stubbing. For more
information, see “Handle Incompatibilities with
Automatic Stubbing” on page 2-8.

The software cannot decide a design error
detection objective because of limitations of the
analysis engine. For example, if the analysis
encounters an unbounded while loop, it performs
an approximation. For information about this
approximation, see “While Loops” on page 2-18.

Test-case
generation

For the highlighted model object, the analysis did not
decide at least one test objective. This situation can
occur when:

The analysis is still in progress.
The analysis times out.

The analysis cannot decide a test objective because
of division by zero or nonlinear computation.

The software cannot decide a test objective because
of stubbing. For more information, see “Handle
Incompatibilities with Automatic Stubbing” on
page 2-8.

The software cannot decide a test objective because
of limitations of the analysis engine. For example,
if the analysis encounters an unbounded while loop,
it performs an approximation. For information

about this approximation, see “While Loops” on
naoce 2-18

Property proving

For the highlighted model object, the analysis did not
decide at least one proof objective. This situation can
occur when:

The analysis is still in progress.

The analysis times out.
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Analysis mode Orange highlighting means...

® A proof objective exists on a signal whose value the

software cannot control, for example, a Constant
block.

¢ The analysis cannot decide a proof objective because
of division by zero or nonlinear computation.

¢ The software cannot decide a proof objective
because of stubbing. For more information,
see “Handle Incompatibilities with Automatic
Stubbing” on page 2-8.

¢ The software cannot decide a proof objective
because of limitations of the analysis engine. For
example, if the analysis encounters an unbounded
while loop, it performs an approximation. For
information about this approximation, see “While
Loops” on page 2-18.

Gray Highlighting on Model

Objects that are highlighted in gray have the following meaning.

Analysis mode Gray highlighting means...

® Design error The model object was not part of the analysis.
detection

e Test-case
generation

® Property proving
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Simulink Design Verifier Data Files

In this section...

“Data File Generation” on page 13-9

“Contents of sldvData Structure” on page 13-9
“Model Information Fields in sldvData” on page 13-10
“Simulate Models with Data Files” on page 13-15
“Load Results from Data Files” on page 13-16

Data File Generation

When you enable the Save test data to file parameter (see “Design Verifier
Pane: Results” on page 15-47), the Simulink Design Verifier software
generates a data file when it completes its analysis. The data file is a MAT-file
that contains a structure named sldvData. This structure stores all the data
the software gathers and produces during the analysis. Although the software
displays the same data graphically in the harness model and report, you can
use the data file to conduct your own analysis or to generate a custom report.

By default, the Save test data to file parameter is enabled.

Contents of sldvData Structure

When the Simulink Design Verifier software completes its analysis, it
produces a MAT-file that contains a structure named sldvData. To explore
the contents of the sldvData structure:

1 Generate test cases for the sldvdemo_flipflop model:

sldvdemo_flipflop;
sldvrun('sldvdemo_flipflop');

2 To load the data file, at the MATLAB prompt, enter the following command:

load('sldv_output\sldvdemo_flipflop\sldvdemo_flipflop_sldvdata.mat')
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The MATLAB software loads the sldvData structure into its workspace.
This structure contains the Simulink Design Verifier analysis results of the
sldvdemo_flipflop model.

3 Enter sldvData at the MATLAB command line to display the field names
that constitute the structure:

sldvData =

ModelInformation: [1x1 struct]
AnalysisInformation: [1x1 struct]
ModelObjects: [1x2 struct]
Constraints: []
Objectives: [1x12 struct]
TestCases: [1x4 struct]
Version: '2.1'

Model Information Fields in sldvData
The following sections describe the fields in the sldvData structure:

¢ “Modellnformation Field” on page 13-10

¢ “AnalysisInformation Field” on page 13-11

¢ “ModelObjects Field” on page 13-12

® “Constraints Field” on page 13-13

® “Objectives Field” on page 13-13

® “TestCases Field / CounterExamples Field” on page 13-14
® “Version Field” on page 13-15

Modelinformation Field

In the sldvData structure, the ModelInformation field contains information
about the model you analyzed. The following table describes each subfield of
the ModelInformation field.
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Subfield Name

Description

Name String that specifies the model name.

Version String that specifies the model number.

Author String that specifies the user name.

TimeStamp String that specifies the last date and time the model
was updated.

SubsystemPath String that represents the full path name of the
subsystem (if any) that was analyzed.

ExtractedModel String that represents the name of the model extracted
(if any) to analyze the subsystem (if any) specified in
SubsystemPath.

ReplacementModel | String that specifies the name of the model (if any)

that contains the block replacements.

Analysisinformation Field

In the sldvData structure, the AnalysisInformation field lists settings of
particular analysis options and related information. The following table
describes each subfield of the AnalysisInformation field.

Subfield Name | Description

Status String that specifies the completion status of the
Simulink Design Verifier analysis.

AnalysisTime Double that specifies the length of the analysis in
seconds.

Options Deep copy of the Simulink Design Verifier options
object used during the analysis.

InputPortInfo Cell array of structures that specifies information
about each Inport block in the top-level system.

OutputPortInfo Cell array of structures that specifies information
about each Outport block in the top-level system.

SampleTimes For internal use only.

Parameters For internal use only.
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Subfield Name

Description

AbstractedBlocks

For internal use only.

Approximations

A structure that describes the approximations
performed during the analysis. For more information
about approximations, see “Approximations” on page
2-16.

ReplacementInfo

For internal use only.

ModelObjects Field

In the sldvData structure, the ModelObjects field lists the model items and
their associated objectives. The following table describes each subfield of the

ModelObjects field.

Subfield Name

Description

descr

String that specifies the full path to a model object,
including objects in a Stateflow chart.

typeDesc

String that specifies the block type of the model object.

slPath

String that specifies the full path to a Simulink model
object.

sfObjType

String that specifies the type of a Stateflow object,
e.g., S for state and T for transition.

sfObjNum

Integer that represents the unique identifier of a
Stateflow object.

sid

For internal use only.

designSid

For internal use only.

replacementSid

For internal use only.

objectives

Vector of integers that represents the indices of
objectives associated with a model object.
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Constraints Field

In the sldvData structure, the Constraints field lists information about
specified minimum and maximum values (if any) on input ports in your
model. The following table describes the subfield of the Constraints field.

Subfield Name

Description

DesignMinMax

Cell array of structures that include
the name and minimum and
maximum values for each input port
for which values are specified.

Objectives Field

In the sldvData structure, the Objectives field lists information about
each objective, such as its type, status, and description. The following table
describes each subfield of the Objectives field.

Subfield Name

Description

type String that specifies the type of an objective.

status String that specifies the status of an objective.

descr String that specifies the description of an objective.

label String that specifies the label of an objective.

outcomeValue Integer that specifies an objective’s outcome.

coveragePointIdx | Integer that represents the index of a coverage point
with which an objective is associated.

linkInfo For internal use only.

range For internal use only.

modelObjectIdx Integer that represents the index of a model object
with which an objective is associated.

analysistime Integer that represents the analysis time for an object.

testCaselIdx Integer that represents the index of a test case or

counterexample that addresses an objective.
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TestCases Field / CounterExamples Field

In the sldvData structure, this field can have two names, depending on the
type of check:

¢ [f you set the Mode parameter to Design error detection, the
CounterExamples field lists information about each test case that results
in an integer overflow or division-by-zero error.

¢ [f you set the Mode parameter to Test generation, the TestCases field
lists information about each test case, such as its signal values and the
test objectives it achieves.

¢ [fyou set the Mode parameter to Property proving, the CounterExamples
field lists information about each counterexample and the proof objective it
falsifies.

The following table describes each subfield of the TestCases /
CounterExamples field.

Subfield Name Description

timeValues Vector that specifies the time values associated with
signals in a test case or counterexample.

dataValues Cell array that specifies the data values associated
with signals in a test case or counterexample.

paramValues Structure that specifies the parameter values
associated with a test case or counterexample. Its
fields include:

name — String that specifies the name of a parameter.

value — Number that specifies the value of a
parameter.

noEffect — Logical value that specifies whether a
parameter’s value affects an objective.

stepValues Vector that specifies the number of time steps that
comprise signals in a test case or counterexample.
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Subfield Name

Description

objectives

Structure that specifies objectives that a test case or a
counterexample addresses. Its fields include:

objectiveldx — Integer that represents the
index of an objective that a test case achieves or a
counterexample falsifies.

atTime — Time value at which either a test case
achieves an objective or a counterexample falsifies an
objective.

atStep — Time step at which either a test case
achieves an objective or a counterexample falsifies an
objective.

dataNoEffect Cell array of logical vectors that specifies whether a
signal’s data values affect an objective. The vector
uses 1 to indicate that a signal’s data value does not
affect an objective; otherwise, it uses 0.

expectedOutput Cell array of vectors that specifies the output values

that result from simulating the model using the

test case signals. Each cell represents the output
values associated with a different Outport block in
the top-level system. This subfield is populated if you
select Include expected output values.

Version Field

In the sldvData structure, the Version field is a string that specifies the
version of the Simulink Design Verifier software that analyzed the model.

Simulate Models with Data Files

The sldvruntest function simulates a model using test cases or
counterexamples that reside in a Simulink Design Verifier data file:

1 Simulate the sldvdemo flipflop model and generate test cases:

sldvdemo_flipflop
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13-16

2 Save the location of the data file generated after analyzing the model:

sldvDataFile = 'sldv_output\sldvdemo_flipflop\sldvdemo_flipflop_sldvdata.mat'

3 Use the sldvruntest function to simulate the sldvdemo flipflop model
using test case 2 in the data file:

[ outdata ] = sldvruntest('sldvdemo_flipflop', sldvDataFile, 2)

The output from sldvruntest is an array of Simulink.SimulationOutput
objects.

4 Examine the output data from the first test case using the methods of the
Simulink.SimulationOutput object:

tout_sldvruntest = outData(1).find('tout_sldvruntest');
xout_sldvruntest outData(1).find('xout_sldvruntest');
yout_sldvruntest = outData(1).find('yout_sldvruntest');
logsout_sldvruntest = outbata(1).find('logsout_sldvruntest');

Load Results from Data Files

You can load previous analysis results for a model from a data file. For more
information, see “Load Previous Results” on page 13-58 and sldvloadresults.
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Simulink Design Verifier Harness Models

In this section...

“Harness Model Generation” on page 13-17

“Create a Harness Model” on page 13-17

“Anatomy of a Harness Model” on page 13-18
“Configuration of the Harness Model” on page 13-22

“Simulate the Harness Model” on page 13-23

Harness Model Generation

During or after a Simulink Design Verifier analysis, you can create a harness
model.

The contents of the harness model depend on the value of the Mode
parameter, set in the Configuration Parameters dialog box on the Design
Verifier pane:

® Design error detection — The harness model contains test cases that
result in errors during simulation.

e Test generation — The harness model contains test cases that achieve
test objectives.

® Property proving — The harness model contains counterexamples that
falsify proof objectives.

By default, the Save test harness as model parameter is disabled.

Note The Simulink Design Verifier software can generate a harness model
only when the top level of the system you are analyzing contains an Inport
block.

Create a Harness Model
To create a harness model before or after the analysis, do one of the following:

13-17



1 3 Reviewing the Results

® Before the analysis, in the Configuration Parameters dialog box, on the
Design Verifier > Results pane, select Save test harness as model.

e After the analysis, in the Simulink Design Verifier log window, select
Create harness model.

Anatomy of a Harness Model
The Simulink Design Verifier software produces a harness model that looks

like this:
SizeType
Test Case 1 =nzble =nzble
braks braks thrat > ':I)
==t st throt
v
NG inc
target
dec e | dar tangst
spesd (=
Inputs Test Unit {copied from sldvdeme_cruise_control)
Ih_
DoC
Text

Test Case Explanation

The harness model contains the following items:

® Inputs — This Signal Builder block contains signals that comprise the
test cases or counterexamples that the Simulink Design Verifier software
generated. The Signal Builder block contains signals only for input signals
that are used in the model. If an input signal has no effect on the output of
the model, that signal is not included in the Signal Builder block.

Double-click the Inputs block to open the Signal Builder dialog box and
view its signals. Each signal group represents a unique test case or
counterexample. In the Signal Builder dialog box, select a tab to view the
signals associated with a particular test case or counterexample.
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The following Signal Builder block shows the signals for Test Case 7
after Simulink Design Verifier performs test generation analysis on the
sldvdemo_cruise_control model with the default options.

n Signal Builder (sldvdemo_cruise_control_harness/Inputs) *

File Edit Group Signal Axes Help N

BEH| SRR oo — TN FREE > 1= Fa]| R
Active Group: Test Case 7 - @‘_ E E
o oTTTTTTTTTTT Co T . Voot v T e a3
enable i : : : ; i I
1 » T T T T g "
"? | | | | | | |
brake
1 | i i i i i i
............... L
set : i i i i
R R R pomTemmemeenes peomtomeomeses R Y 3
b a a a S j
1 - T : L L R a
inc : : : ' i :
L e pommrnnennes pornememeenes R R 3
| S— I P b N b I—

' | | |

brake {shown)

Hame: enable T T~ set {shown)

- inec {shown)

Index: 1 - e f- dec {shown)
' speed {shown) -

Click to select point or segment, Shift+click to add points

enable (#1) [ ¥ Min ¥Max ]

If you select the LongTestcases option of the Test suite optimization
parameter, the analysis creates fewer, longer test cases. For example, if
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you select the LongTestcases option for the sldvdemo _cruise control
model, the analysis produces one long test case instead of nine shorter
test cases. The following Signal Builder dialog box shows the signals for
the long test case.

n Signal Builder (sldvdemo_cruise_control_harness/Inputs) EI@
File Edit Group Signal Axes Help N
BH| B8 oo I 0 |EFRER o n w4l
Acthne{;rqup: Test Case 1 'v': @‘_ - -
1v—¢--a—b-- r—t—t—t—t—t— —t—t— ’ —t—t
enable : . , : ,
0.5F-r----- 5 e yTTTTTTTTTTTT e yTTTTTTTTTTTT GTTTTTTTTTTTTT T
ob- bbb b b e e .
1------ -- s S R T ELTT T reeeeE ; -
US___b_r_a_k_e___________ ________ N o :
o—L..L 1. : :
1 ; -- B R |
se : ,
(IR SR EEEREEEETEREE EEE R R e e e RRREEEEEED
) S A ) O S
1 - -- ' R e R L L
inc '
05F--------mf--ef--- ERRR bl el fREEEEEE L EEEEEEEEEE R
) S L ---- S S D
- - R R EEE R
1 T S A S A N A—
ol ... S
100 _EI ----------- P T
spee ' :
O  RREEEEEEES EEEE R R,
0 : I
i 0.05 01
Time (sec)
Lefi Point Right Point
brake {shown)
Hame: enatle iF: [ set {shown)
. ine {shown)
Index: 1 - e f- dec {shown)
' speed {shown) -
ok enable (#1) [ ¥ Min ¥Max ]

13-20



Simulink® Design Verifier™ Harness Models

Note For more information about the Signal Builder dialog box, see
“Signal Groups” in the Simulink documentation.

Size-Type — This Subsystem block transmits signals from the Inputs
block to the Test Unit block. It verifies that the size and data type of the of
the signals are consistent with the Test Unit block.

Test Unit — This Subsystem block contains a copy of the original model
that the Simulink Design Verifier software analyzed.

If you select the Reference input model in generated harness on the
Design Verifier > Results pane, the Test Unit is a Model block that
references the model you are analyzing, not a subsystem.

Test Case Explanation — This DocBlock block documents the test cases
or counterexamples that the Simulink Design Verifier software generates.
Double-click the Test Case Explanation block to view a description of each
test case or counterexample. The block lists either the test objectives that
each test case achieves (as in the next graphic) or the proof objectives that
each counterexample falsifies.
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1

2

3

4

5

L]

7

8

5 1.
10 2.
11 3.

1.

Test Case 1 (1 Cbjectives
Parameter values:

Controller/Switch2 - logical trigger

Test Case 2 (3 Cbjectives
Parameter values:

Controller/Logical Operator - Logic:
Controller/Logical Cperator - Logic:

input false (output is from 3rd input port) @ T=0.00

input port 1 F @ T=0.00
MCDC expression for ocutput with input port 1 F @ T=0.00

Controller/PI Controller - enable logical wvalue F @ T=0.00

23 Test Case 3 (3 Cbjectives

14 Parameter values:

15 |
16 1. Controller/Logical Operatorl - Logic: input port 1 T @ T=0.00 3
17 2. Controller/Logical Operator - Logic: input port 2 F @ T=0.00

g 3. Controller/Logical Cperator - Logic: MCDC expression for output with input port 2 F @ T=0.00

d |

20 Test Case 4 (1 Cbjectives)|

iy

Parameter

Parameter

WK R R R RS RY R KRS
(SR = YRS R N

1. Controller/Switch3 - logical trigger input true (output is from 1st input port) @ T=0.00

Test Case 5 (7 Objectives)

values:

values:

1. Controller/Switchl - logical trigger input false (output is from 3rd input port) @ T=0.00
2. Controller/Logical Operator2 - Logic: input port 1 F @ T=0.00 |
3. Controller/Logical Operator2 - Logic: input port 2 F @ T=0.00
31 4. Controller/Logical Operator2 - Logic: MCDC expression for output with input port 1 F @ T=0.00
2 5. Controller/Logical Cperator2 - Logic: MCDC expression for output with input port 2 F @ T=0.00
33 6. Controller/Logical Operator - Logic: input port 3 F @ T=0.00
34 7. Controller/Logical Operator - Logic: MCDC expression for output withl input port 3 F @ T=0.00
35
36 TIest Case 6 (2 Objectives
37 Parameter values:
g
39 1. Controller/Logical Operator2 - Logic: input port 2 T @ T=0.01
40 2. Controller/Logical Cperator2 - Logic: MCDC expression for output with input port 2 T @ T=0.01
41
2 Test Case 7 (1 Cbijectiwves
43 Parameter values:
a4
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Configuration of the Harness Model

After the Simulink Design Verifier software generates the harness model,
it has the following settings:

¢ The harness model start time is always 0. If the original model uses a
nonzero start time, the software ignores this and uses 0 for the simulation
start time for test cases and counterexamples.
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® The harness model stop time always equals the stop time of the longest test
case in the Signal Builder dialog box.

® By default, the software enables coverage reporting for harness models that
contain test cases. Although it enables coverage reporting with particular
options selected, you can customize the settings to meet your needs. For
more information, see “Customize Requirements Report” in the Simulink
Verification and Validation documentation.

® By default, if you select Ignore objective based on filter and provide
a coverage filter file for the Test Unit, the coverage filter file also applies
to the harness model. The coverage objective filter parameters are in the
Configuration Parameters dialog box, on the Test Generation pane.

Simulate the Harness Model

The harness model enables you to simulate a copy of your original model
using the test cases or counterexamples that the Simulink Design Verifier
software generates. Using the harness model, you can simulate:

* A counterexample

® A single test case, for which the Simulink Verification and Validation
software collects and displays model coverage information

e All test cases, for which the Simulink Verification and Validation software
collects and displays cumulative model coverage information

Note If you analyze a model that simulates with sample time warnings,
when you simulate the harness model, the warnings may be reported as
errors, causing the simulation to fail.

To simulate a single test case or counterexample:
1 In the harness model, double-click the Inputs block.
The Signal Builder dialog box appears.

2 In the Signal Builder dialog box, select the tab associated with a particular
test case or counterexample.
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The Signal Builder dialog box displays the signals that comprise the
selected test case or counterexample.

3 In the Signal Builder dialog box, click the Start simulation button ﬂ

The Simulink software simulates the harness model using the signals
associated with the selected test case or counterexample. When simulating
a test case, the Simulink Verification and Validation software collects
model coverage information and displays a coverage report.

To simulate all test cases and measure their combined model coverage:

1 In the harness model, double-click the Inputs block.

The Signal Builder dialog box appears.

all
2 In the Signal Builder dialog box, click the Run all button |

The Simulink software simulates the harness model using all test cases,
while the Simulink Verification and Validation software collects model
coverage information and displays a coverage report.

When you click Run all, the software simulates all the test cases using
the stop time for the harness model. The stop time equals the stop time
for the longest test case, so you may accumulate additional coverage when
you simulate the shorter test cases.

If the Test Unit in the harness model is a subsystem, the values of the

Simulink simulation optimization parameters on the Configuration
Parameters dialog box may impact your coverage results.
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Note The simulation optimization parameters are on the following
Configuration Parameters dialog box panes:

* Optimization pane

e Optimization > Signals and Parameters pane

* Optimization > Stateflow pane

See “Simulating with Signal Groups” in the Simulink documentation for more
information about simulating models containing Signal Builder blocks.
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Export Test Cases to SystemTest

If you have installed the SystemTest™ software with your MATLAB
application, you can specify that the Simulink Design Verifier software create
a SystemTest TEST-file when it analyzes a model. Creating a TEST-file
allows you to configure and collect model coverage results and run the test
cases from inside the SystemTest environment.

Note The option to create a SystemTest TEST-file is only available
in test-generation mode; you cannot create this file when running a
property-proving analysis.

In addition, if you have a model with a large number of inputs, this feature
eliminates the overhead of creating the harness model. However, you can
create both a harness model and a TEST-file in the same analysis.

To create a TEST-file for the sldvdemo_cruise_control model, perform
these steps:

1 Type sldvdemo _cruise_control at the MATLAB command prompt to
open the Cruise Control Test Generation model.

2 Select Analysis > Design Verifier > Options to open the Configuration
Parameters dialog box.

3 In the Select pane, under Design Verifier, select Results.

4 On the Results pane, under SystemTest options, select Save test
harness as SystemTest TEST-file (will reference saved data file).

SystemTest options

/| Save test harness as SystemTest TEST-file (will reference saved data file)

SystemTest file name: tModelMame$_harness
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5 If you prefer a file name other than the default, specify the SystemTest

file name.

6 Under Data File options, verify that Save test data to file is selected.
You must select this option to generate a TEST-file.

Data file options
V| Save test data to file

Data file name: $ModelName$ sldvdata

7 If you do not need the Simulink Design Verifier harness model in addition
to the TEST-file, under Harness model options, clear Save text

harness as model.
Harness model options
Save test harness as model
8 Click Apply and OK to save the changes and exit the Configuration
Parameters dialog box.

9 Double-click the Run block in the sldvdemo_cruise_control model to
start the analysis.

When the analysis completes, the SystemTest desktop opens the TEST-file,
which, for this example, is saved as

matlabroot\sldvdemo_output\sldv_cruise_control\sldvdemo_cruise_control_harness.test
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In the Test Browser pane, the 8 iterations in Main Test (8 Iterations)

correspond to the 8 test cases that the Simulink Design Verifier software

generates and describes in the Test Case Explanation block of the harness
model.

For information about running Simulink Design Verifier test cases using the
SystemTest software, see “Create a Simulink Design Verifier Test Vector”
in the SystemTest documentation.
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Simulink Design Verifier Reports

In this section...

“Simulink® Design Verifier™ Report Generation” on page 13-29
“Create Analysis Reports” on page 13-29

“Front Matter” on page 13-30

“Summary Chapter” on page 13-30

“Analysis Information Chapter” on page 13-30

“Derived Ranges Chapter” on page 13-35

“Objectives Status Chapters” on page 13-36

“Model Items Chapter” on page 13-44

“Design Errors Chapter” on page 13-45

“Test Cases Chapter” on page 13-48

“Properties Chapter” on page 13-53

Simulink Design Verifier Report Generation

After an analysis, the Simulink Design Verifier software can generate an
HTML report that contains detailed information about the analysis results.

In addition, the analysis report contains hyperlinks that allow you to:

e Navigate to a specific part of the report

e Navigate to the object in your Simulink model for which the analysis
recorded results

Create Analysis Reports

To create a detailed analysis report before or after the analysis, do one of
the following:

¢ Before the analysis, in the Configuration Parameters dialog box, on the
Design Verifier > Report pane, select Generate report of the results.
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e After the analysis, in the Simulink Design Verifier log window, select
Generate detailed analysis results.

Front Matter

The report begins with two sections:

e “Title” on page 13-30
® “Table of Contents” on page 13-30

Title

The title section lists the following information:

® Model or subsystem name the Simulink Design Verifier software analyzed
¢ User name associated with the current MATLAB session

® Date and time that the Simulink Design Verifier software generated the
report

Table of Contents

The table of contents follows the title section. Clicking items in the table of
contents allows you to navigate quickly to particular chapters in the report.

Summary Chapter
The Summary chapter of the HTML report lists the following information:

® Name of the model
® Analysis mode
® Analysis status

e Status of objectives analyzed

Analysis Information Chapter

The Analysis Information chapter of the HTML report includes the
following sections:
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e “Model Information” on page 13-31

® “Analysis Options” on page 13-31

e “Unsupported Blocks” on page 13-32

e “Constraints” on page 13-33

¢ “Block Replacements Summary” on page 13-34

® “Approximations” on page 13-35

Model Information

The Model Information section provides the following information about the
current version of the model:

¢ Path and file name of the model that the Simulink Design Verifier software
analyzed

® Model version

® Date and time that the model was last saved

e Name of the person who last saved the model

Analysis Options
The Analysis Options section provides information about the Simulink Design
Verifier analysis settings.

The Analysis Options section lists the parameters that affected the Simulink

Design Verifier analysis. If you enabled coverage filtering, the name of the
filter file is included in this section.
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Analysis Options

Mode: TestGeneration

Test Suite Optimization: CombinedObjectives
Maximum Testcase Steps: 500 time steps

Test Conditions: UseLocalSettings

Test Objectives: UseLocalSettings
Model Coverage Objectives:  MCDC

Maximum Analysis Time: 60s

Block Replacement: on

Block Replacement Rules: <FactoryDefaultRules>
Parameters Analysis: on

Parameters Configuration File: sldv_params template.m
Save Data: on

Save Harness: on

Save Report: on

Note For more information about these parameters, see “Simulink® Design
Verifier™ Configuration Parameters” on page 15-2.

Unsupported Blocks

If your model includes unsupported blocks, by default, automatic stubbing is
enabled to allow the analysis to proceed. With automatic stubbing enabled,
the software considers only the interface of the unsupported blocks, not
their actual behavior. This technique allows the software to complete the
analysis. However, the analysis may achieve only partial results if any of the
unsupported model blocks affect the simulation outcome.
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The Unsupported Blocks section appears only if the analysis stubbed

unsupported blocks; it lists the unsupported block in a table, with a hyperlink
to the block in the model.

Unsupported Blocks

The following blocks are not supported by Simulink Design Verifier. They were abstracted during the
analysis. This can lead Simulink Design Verifier to produce only partial results for parts of the model that
depends on the output values of these blocks.

Block Type

Discrete State-Space DiscreteStateSpace

For more information about automatic stubbing, see “Handle Incompatibilities
with Automatic Stubbing” on page 2-8.

Constraints

The Constraints section provides information about test conditions that the
Simulink Design Verifier software applied when it analyzed a model.

Constraints

Analysis Constraints

Name Analysis Constraint
constraint [0, 100]

You can navigate to the constraint in your model by clicking the hyperlink
in the Constraints table. The software highlights the corresponding Test

Condition block in your model window and opens a new window showing
the block in detail.
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Block Replacements Summary

The Block Replacements Summary provides an overview of the block
replacements that the Simulink Design Verifier software executed. It appears
only if the Simulink Design Verifier software replaced blocks in a model.

Each row of the table corresponds to a particular block replacement rule that
the Simulink Design Verifier software applied to the model. The table lists
the following:

e Name of the file that contains the block replacement rule and the value of
the BlockType parameter the rule specifies

® Description of the rule that the MaskDescription parameter of the
replacement block specifies

e Names of blocks that the Simulink Design Verifier software replaced in
the model

To locate a particular block replacement in your model, click on the name for
that replacement in the Replaced Blocks column of the table; the software
highlights the affected block in your model window and opens a new window
that displays the block in detail.

Block Replacements Summary
Table 2.1. Block Replacements

#: Replacement Rule / Block Type |Rule Description Replaced Blocks

Inserts test objectives for

switch blocks that requite | ¢itch
each switch position be 1o
demonstrated when the :
values of input ports 1 and Switch3
3 differ.

1 blkrep rule switch normal /Switch Switch2
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Approximations

Each row of the Approximations table describes a specific type of
approximation that the Simulink Design Verifier software used during its
analysis of the model.

Approximations

Simulink Design Verifier performed the following approximations during analysis. These can impact the
precision of the results generated by Simulink Design Verifier. Please see the product documentation for
further details.

# Type Description

The model includes floating-point arithmetic. Simulink Design Verifier

! Rational approximation approximates floating-point arithmetic with rational number arithmetic.

Note Review the analysis results carefully when the software uses
approximations. In rare cases, an approximation may result in test cases that
fail to achieve test objectives or counterexamples that fail to falsify proof
objectives. For example, a floating-point round-off error might prevent a
signal from exceeding a designated threshold value.

Derived Ranges Chapter

In a design error detection analysis, the analysis calculates the derived
ranges of the signal values for the Outports for each block in the model.
This information can help you identify the source of data overflow or
division-by-zero errors.

The table in the Derived Ranges chapter of the analysis report lists these
bounds.
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Chapter 3. Derived Ranges

Signal

Controller/Constantl- outport 1
Controller/Unit Delay- outport 1
Controller/Sum- outport 1
Controller/Constant3- outport 1
Controller/Sum2- outport 1

Controller/Switch3/Switch. Defined by block replacement rule
'blkrep rule switch normal'.- outport 1

Controller/Switch2/Switch. Defined by block replacement rule
'blkrep rule switch normal'.- outport 1

Controller/Switch1/Switch. Defined by block replacement rule
'blkrep rule switch normal'.- outport 1

Controller/Sum1- outport 1
Controller/Logical Operatorl- outport 1
Controller/Unit Delay1- outport 1
Controller/Logical Operator2- outport 1
Controller/Logical Operator- outport 1

throt- outport 1

target- outport 1

Objectives Status Chapters

Derived Ranges

3.5954e+306..3.5954e+306]
[-Inf..Inf]

This section of the report provides information about all objectives in a model,
including an objective’s type, the model item to which it corresponds, and its

description.

® “Design Error Detection Objectives Status” on page 13-37

® “Test Objectives Status” on page 13-40
® “Proof Objectives Status” on page 13-41
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® “Objectives Undecided” on page 13-42

® “Objectives Undecided Due to Division by Zero” on page 13-43
® “Objectives Undecided Due to Nonlinearities” on page 13-43

® “Objectives Undecided Due to Stubbing” on page 13-44

Design Error Detection Objectives Status
If you run a design error detection analysis, the Design Error Detection

Objectives Status section can include the following tables:

e “Active Logic” on page 13-37

¢ “Dead Logic” on page 13-38

® “Objectives Proven Valid” on page 13-39

® “Objectives Falsified with Test Cases” on page 13-39

Active Logic. The Active Logic section lists the model items for which
the analysis found active logic. The following image shows a portion

of the Active Logic section of the generated analysis report for the
sldvdemo_fuelsys logic_simple example model.
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Active Logic

Simulink Design Verifier found that these decision and condition outcomes can occur and are active logic in the model.

Analysis
# |Type Model Item Description Time
(sec)
5  |Decision |controllogic. Oxveen Sensor Mode State: Substate executed State "0O2_fail" |52
.. \ State: Substat ted Stat
6  |Decision |control logic.Oxveen Sensor Mode " ae. Sos E,,l & exectied Slate 52
02 normal
.. . State: Substat ted Stat
7  |Decision |conirol logic.Oxveen Sensor Mode " a?e Hos a,? exectted State 52
02 _warmup
.. control logic.Oxveen Sensor Mode."[Ego < Transition: Transition trigger expression
8  Decision X — 52
max ego]/ Sens Fail .. F
. control logic. Oxvgen Sensor Mode."[Ego < Transition: Transition trigger expression
9  Decision ; — 52
max ego]/ Sens Fail .. T
.. control logic. Oxveen Sensor Mode."[Ego = Transition: Transition trigger expression
10 |Decision > . 52
max ego]’ Sens Failu F
.. control logic.Oxveen Sensor Mode."[Ego = Transition: Transition trigger expression
11 |Decision ; P 52
max ego]/ Sens Failu... T
. control logic. Oxveen Sensor Mode."[after Transition: Transition trigger expression
12 Decision ; . 52
(5 tick) F
.. control logic. Oxveen Sensor Mode."[after Transition: Transition trigger expression
153 |Decision . " 52
(5 tick) T

Dead Logic. The Dead Logic section lists the model items for which the
analysis found dead logic. The following image shows the Dead Logic section
of the generated analysis report for the sldvdemo_fuelsys logic_simple
example model.
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Dead Logic

Simulink Design Verifier proved that these decision and condition outcomes cannot occur and are dead-logic in the
model. Dead-logic in the model can also be a side-effect of parameter configurations, input specified minimum masximum
constraints, or in rare cases, the approximations performed by Simulink Design Verifier.

. Analysis
# Tvpe Model Item Description Time (sec)
) - control logic Speed Sensor Mode "[speed==0 |Transition: Condition 2, "press < 5
49 Condition & press < zero th.." zero_thresh' F 20
86  Decis control logic Fueling Mode Fuel Disabled "[in  |Transition: Transition trigger 20
ecision (Sens Faihwe Counter Mu..." expression F =

Objectives Proven Valid. The Objectives Proven Valid section lists the
design error detection objectives that the analysis proved valid. For these

objectives, the analysis determined that the described design errors cannot
occur.

Objectives Proven Valid

.. Analysis
# Tvpe Model Item Description Time (sec) Test Case
20 Overflow debounce’ SFunction Overflow 5 n'a

Objectives Falsified with Test Cases. The Objectives Falsified with
Test Cases section lists the objectives for which the analysis found test cases
that demonstrate design errors.

Objectives Falsified with Test Cases

o Analysis
# Type Model Item Description Time (sec) Test Case
12 Overflow Verify True Qutput/Sum Overflow 13 1
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Test Objectives Status

If you run a test case generation analysis, the Test Objectives Status
section can include the following tables:

® “Objectives Satisfied” on page 13-40
® “Objectives Proven Unsatisfiable” on page 13-40

Objectives Satisfied. The Objectives Satisfied section lists test objectives
that the analysis satisfied.

Objectives Satisfied

Simulink Design Verifier found test cases that exercise these test objectives.

L. Analysis
# Type Model Item Description Time (sec) Test Case
1 Condition Controller L ogical Operatorl Logic: input port 1 T 0 3
2 Condition ControllerLogical Operator] Logic:inputport 1 F 0 g
3 Condition ControllerLogical Operator2 Logic: inputport 1 T 0 g
4 Condition ControllerLogical Operator2 Logic: input port 1 F 0 5
5 Condition Controller T ogical Operator2 Logic: input port 2 T 1 ]
6 Condition ControllerLogical Operator Logic:input port 2 F 0 5
. Logic: MCDC expression for output
o 2]
7 MCDC Controller’Logical Operator2 with input port 1 T 0 g
. Logic: MCDC expression for output
o 3
8 MCDC Controller/T ogical Operator2 with input port 2 T 1 4]
9  McDC ControllerLogical Operator? Logic: MCDC expression for output |, 5

with input port 1 F

Objectives Proven Unsatisfiable. The Objectives Proven Unsatisfiable
section lists the test objectives that the analysis determined could not be
satisfied.

In the following example, the Stateflow chart Mode Logic updates at every
time step, so the implicit event tick is never false. The analysis cannot
satisfy condition coverage for the temporal event after (4, tick). For this
and other unsatisfiable objectives in the model, the report lists the type,
model item, and description.
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Objectives Proven Unsatisfiable

Simulink Design Verifier proved that there does not exist any test case exercising these test objectives. This often indicates the presence
of dead-logic in the model. Other possible reasons can be inactive blocks in the model due to parameter configuration or test constraints
such as given using Test Condition blocks. In rare cases, the approximations performed by Simulink Design Verifier can make objectives
impossible to achieve.

L. Analysis
# Tvpe Model Item Description Time (sec) Test Case
4 Decision Switchable config enable logical value T 1 n'a
5 Condition Logical Operator Logic:inputport 1 T 1 n'a
7 Decision Normal config (feedthrough) enable logical value F 1 n'a
9  Decision Switchable config Multiport Switch | Pic8°F input value = 0 (output is from na
input port 0)
10 Decision Switchable configMultiport Switch | cecr put value =1 (outputs fom |, wa
input port 1)
; ; o — .
11 Decision |Switchable configMultiport Switch | Pogc PUt value =2 (outputis from |, wa
input port 1)
. . o .
12 [Decision Switchable config Multiport Switch | PicE°F inPut value = %.3 (output is ffom wa
input port 3)
22 Condition Mode Logic."after(4. tick)" Transition: Condition 1, "tick" F 1 n'a
37 Decision protected divisionl/Switch Ioglclal trigger input false (output is from 1 n'a
3rd input port)
41 Decision protected division/Switch Iogmlal trigger input false (output is from 1 n'a
3rd input port)
45 Decision Mode Logic. Clipped "[lon]" Transition: Transition trigger expression |, wa

F

Proof Obijectives Status

If you run a property-proving analysis, the Proof Objectives Status section
can include:

® “Objectives Proven Valid” on page 13-41

® “Objectives Falsified with Counterexamples” on page 13-42

Objectives Proven Valid. The Objectives Proven Valid section lists the
proof objectives that the analysis proved valid.
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Objectives Proven Valid

.. Analysis
# Type Model Item Description Time (sec) Counterexample
Proof . } . ,
1 objective Verifv Quiput’FoutCorrect Objective: T 1 n'a
Proof
2 objective Verify Output'ToutCorrect Objective: T 1 n/a

Obijectives Falsified with Counterexamples. The Objectives Falsified
with Counterexamples section lists the proof objectives that the
analysis disproved. In this example, the software generated at least one
counterexample that falsifies the specified objective.

Objectives Falsified with Counterexamples

L. Analysis
# Tvpe Model Item Description Time (sec) Counterexample
1 Assert Verifv True Qutput/Assertion Assert 1 1

Objectives Undecided

For all types of objectives, the Objectives Undecided section lists the
objectives for which the analysis was unable to determine an outcome in
the allotted time.

In the following property-proving example, either the software exceeded its
analysis time limit (which the Maximum analysis time parameter specifies),
or you aborted the analysis before it completed processing these objectives.
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Objectives Undecided

Stmulink Design Verifier was not able to process these objectives with the current options.

# Type Model Item Description ;&?E-[Sslzc} Counterexample
1 Pr(.mf , Verifv QutputFoutCorrect Objective: T -1 n'a

objective
2 Pr(.mf . Verify Qutput/ ToutCorrect Objective: T -1 n/a

objective

Objectives Undecided Due to Division by Zero

For all types of objectives, the Objectives Undecided Due to Division by
Zero section lists objectives that the analysis was unable to decide because of
division by zero errors in the associated model items. To detect division by zero
errors before running further analysis on your model, follow the procedure in
“Detect Integer Overflow and Division-by-Zero Errors” on page 6-23.

Objectives Undecided Due to Division by Zero

Stmulink Design Verifier was not able to decide these objectives due to division by zero errors in the model.

# Type Model Item Description fi.x;;:g—(s;:c) Test Case
1 Decision Saturation mnput > lower limit F 0 n'a
2 Decision Saturation input > lower mit T 0 n'a
3 Decision Saturation input >= upper limit F 0 n'a
4 Decision Saturation input >= upper limit T 0 n'a

Objectives Undecided Due to Nonlinearities

For all types of objectives, the Objectives Undecided Due to
Nonlinearities section lists the objectives that the analysis was unable to
decide because they require nonlinear computation. Simulink Design Verifier
does not support nonlinear arithmetic or nonlinear logic.
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Objectives Undecided Due to Nonlinearities

Simulink Design Verifier was not able to decide these objectives due to the presence of nonlinear arithmetic in the model.

# Type

30 Decision

32 Decision

Analysis

Model Item Description Time (sec) Test Case
BasicRollMode/Integrator integration result <= lower lmit T 2 n'a
BasicRolMode/ Integrator integration result >= upper limit T 2 n'a

Objectives Undecided Due to Stubbing

For all types of objectives, the Objectives Undecided Due to Stubbing
section lists model items with objectives that the analysis was unable to
decide because of stubbing. These can include objectives that, in releases
prior to R2013b, were marked as Objectives Satisfied — No Test Case or
Objectives Falsified - No Counterexample.

Objectives Undecided Due to Stubbing

Simulink Design Verifier was not able to decide these objectives due to stubbing.

# Type

2 Decision
3 Decision
4 Decision
5 Decision

Analysis Time

Model Item Description

(sec)
Saturation input > lower limit F 12
Saturation input > lower limit T 12
Saturation input >= upper limit F 12
Saturation input >= upper limit T 12

Model Items Chapter

The Model Items chapter of the HTML report includes a table for each object
in the model that defines coverage objectives. The table for a particular object
lists all of the associated objectives, the objective types, objective descriptions,
and the status of each objective at the end of the analysis.

The table for an individual object in the model will look similar to this one
for the Discrete-Time Integrator in the PI Controller subsystem of the
sldvdemo_cruise control example model.
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Controller/PI Controller/Discrete-Time Integrator

View

H: Type Description Status zgs;e
31 Decision E:igaﬁicﬁ rFesult = Satisfied |3

32 Decision ﬂ:iia&ﬂ 1;%3111’[ == Satisfied 8

33 Decision ?;;iaﬁ 1;}3111’[ - Satisfied 3

34 Decision ﬁg;g;a]?;i 1:[esult - Satisfied |9

To highlight a given object in your model, click View at the upper-left corner
of the table; the software opens a new window that displays the object in
detail. To view the details of the test case that was applied to a specific
objective, click the test case number in the last column of the table.

Design Errors Chapter

If you run a design error detection analysis, the report includes a Design
Errors chapter. This chapter includes sections that summarize the design
errors the analysis validated or falsified:

e “Table of Contents” on page 13-45

¢ “Summary” on page 13-46

® “Test Case” on page 13-46

Table of Contents

Each Design Errors chapter contains a table of contents. Each item in the
table of contents is a hyperlink to results about a specific design error.
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Summary
The Summary section lists:

® The model item
¢ The type of design error that was detected (overflow or division by zero)

¢ The status of the analysis (Falsified or Proven Valid)

In the following example, the software analyzed the

sldvdemo_debounce falseprop model to detect design errors. The analysis
detected an overflow error in the Sum block in the Verification Subsystem
named Verify True Output.

Summary

Model I[tem: Venfy True Output/Sum
Type: Overflow
Status: Falsified

Test Case

The Test Case section lists the time step and corresponding time at which the
test case falsified the design error objective. The Inport block raw had a value
of 255, which caused the overflow error.
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Test Cases Chapter

If you run a test-case generation analysis, the report includes a Test Cases
chapter. This chapter includes sections that summarize the test cases the
analysis generated:

“Table of Contents” on page 13-48
“Summary” on page 13-48
“Objectives” on page 13-49
“Generated Input Data” on page 13-49
“Expected Output” on page 13-51
“Combined Objectives” on page 13-51
“Long Test Cases” on page 13-52

Table of Contents

Each Test Cases chapter contains a table of contents. Each item in the table
of contents is a hyperlink to information about a specific test case.

Summary
The Summary section lists:

Length of the signals that comprise the test case

Total number of test objectives that the test case achieves

Summary

Length: 0.06 second (7 sample periods)
Objectives

Satisfied: 1
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Objectives
The Objectives section lists:

® The time step at which the test case achieves that objective.

® The time at which the test case achieves that objective.

A link to the model item associated with that objective. Clicking the link
highlights the model item in the Simulink Editor.

The objective that was achieved.

Objectives
Step |Time Model Item Objectives
. 0.06 Controller/PI Controller/Discrete-Time

Itecrator integration result >= upper limit T

Generated Input Data

For each input signal associated with the model item, the Generated Input
Data section lists the time step and corresponding time at which the test case
achieves particular test objectives. If the signal value does not change over
those time steps, the table lists the time step and time as ranges.
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Generated Input Data

. 0.01-
Time 0 0.05 0.06

Step
enable
brake
set

nc

=t [ = = | | | ek

dec
speed |97

Note The Generated Input Data table displays a dash (-) instead of a
number as a signal value when the value of the signal at that time step does
not affect the test objective. In the harness model, the Inputs block represents
these values with zeros unless you enable the Randomize data that does
not affect outcome parameter (see “Randomize data that does not affect
outcome” on page 15-53).
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Expected Output

If you select the Include expected output values on the Design
Verifier > Results pane of the Configuration Parameters dialog box, the
report includes the Expected Output section for each test case. For each
output signal associated with the model item, this table lists the expected
output value at each time step.

Expected Output These output values are expected assuming that inputs that do not affect the test
objectives (- in the table above) are given a default value - 0 for numeric types, and default value for
enumerated types.

Time 0 (0.01/0.02 |0.03 |0.04 |0.05 |0.06
Step 1 2 3 4 3 6 7
throt [0 |1.96 |1.9898/2.01972.04972.07980.05
target|97/98 |99 100 101 102 |0

Combined Objectives

If you set the Test suite optimization option to CombinedObjectives (the
default), the Test Cases chapter may include individual information about
many test cases.
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Chapter 5. Test Cases

Table of Contents

Test Case 1
Test Case 2
Test Case 3
Test Case 4
Test Case 5
Test Case 6
Test Case 7
Test Case 8
Test Case 9

This section contains detailed information about each generated test case.

Test Case 1

Summary

Length: 0 second (1 sample period)
Objectives 12

Satisfied:

Long Test Cases

If you set the Test suite optimization option to LongTestcases, the Test
Cases chapter in the report includes fewer sections about longer test cases.
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Chapter 5. Test Cases

Table of Contents
Test Case 1

This section contains detailed information about each generated test case.

Test Case 1

Summary
Length: 0.26 second (27 sample periods)
Objectives
q
Satisfied: 239

Properties Chapter

If you run a property-proving analysis, the report includes a Properties
chapter. This chapter includes sections that summarize the proof objectives
and any counterexamples the software generated:

e “Table of Contents” on page 13-53

¢ “Summary” on page 13-54

¢ “Counterexample” on page 13-54

Table of Contents

Each Properties chapter contains a table of contents. Each item in the table
of contents is a hyperlink to information about a specific property that was
falsified.
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Summary
The Summary section lists:

¢ The model item that the software analyzed
¢ The type of property that was evaluated

¢ The status of the analysis

In the following example, the software analyzed the
sldvdemo_cruise_control verification model for property proving. The
analysis proved that the input to the Assertion block named BrakeAssertion
was nonzero.

Summary

Model Item: Safety Properties/BrakeAssertion
Property: Assert
Status: Falsified

Counterexample

The Counterexample section lists the time step and corresponding time at
which the counterexample falsified the property. This section also lists the
values of the signals at that time step.
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Counterexample

: 0.02-
Time 00.01 0.04
Step 12 |3-5
[nputData.Actual speed 00 |0
[nputData. Switches.enable 110
InputData.Switches.brake 00 |1
InputData.Switches.set 10 0
[nputData.Switches.setlncDec.inc 111 |0
[nputData.Switches.setlncDec.dec 00 |0
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Simulink Design Verifier Log Files

Every time you analyze a model, the Simulink Design Verifier software
creates a log file. To view the log file, click View Log in the Simulink Design
Verifier log window.

The log file contains a list of the analysis results for each object in the model.
The content of the log file corresponds to the analysis results displayed in
the log window during the analysis.
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Starting test generation for model

Conmpiling model... done
Translating model... done

'sldvdemo cruise control' is compatible with

Generating tests...

SATISFIED

Controller/Logical Operator
Logic: MCDC expression for output
Analysis Time = 00:00:01

SATISFIED

Controller/Logical Operator
Logic: MCDC expression for output
Analy=sis Time = 00:00:01

SATISFIED

Controller/Logical Operator
Logic: MCDC expression for output
Analy=sis Time = 00:00:01

SATISFIED

Controller/Logical Operatorz
Logic: MCDC expression for output
Analysis Time = 00:00:01

SATISFIED

Controller/PI Controller
enable logical wvalue T
Analy=sis Time = 00:00:01

'zldvdemo cruise control'

with

with

with

with

input

input

input

input

Simmlink Design Verifier.

port 3 T

%]
=

port

port 1 T

port 1 T
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Review Analysis Results

13-58

In this section...

“View Active Results” on page 13-58
“Load Previous Results” on page 13-58
“Explore Results” on page 13-59

View Active Results

After analysis 1s complete, the Simulink Design Verifier Results Summary
window opens, showing different ways you can use the results. See “Explore
Results” on page 13-59.

If you close the Results Summary window so you can fix the cause of any
analysis errors in your model, you might need to review the analysis results
again. If you have not closed your model since you ran the analysis, you
can reopen the latest analysis results for your model. In the Simulink
Editor, select Analysis > Design Verifier > Results > Active. The Results
Summary window reopens with the latest analysis results for your model.

You can also view Simulink Design Verifier analysis results in the Model
Explorer.

Load Previous Results

If you want to review results of a previous analysis on a model, you can

load these results from the analysis data file. In the Simulink Editor, select
Analysis > Design Verifier > Results > Load. Browse and select the data
file that corresponds to the analysis you want to review.

For more information on analysis data files, see “Simulink® Design Verifier™
Data Files” on page 13-9.

If you load analysis results for a model from a data file that was generated
with a previous version of that model, you might see unexpected effects. To
avoid inconsistencies between your model and analysis results data, when you
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load results for a model, choose a data file that contains results from the
same version of that model.

Explore Results

With active or previous analysis results loaded in the Model Explorer or
Results Summary window, you can perform the following tasks.

Task

For more information

Highlight the analysis results on the
model.

“Highlighted Results on the Model”
on page 13-2

Generate a detailed analysis report.

“Simulink® Design Verifier™
Reports” on page 13-29

Create the harness model, or if the
harness model already exists, open
it.

You will not be able to create the

harness model if:

® No design error objectives were
falsified

® No test cases were generated

* No counterexamples were created

“Simulink® Design Verifier™
Harness Models” on page 13-17

View the data file.

“Simulink® Design Verifier™ Data
Files” on page 13-9

View the log file.

“Simulink® Design Verifier™ Log
Files” on page 13-56
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® “Sources of Model Complexity” on page 14-2

® “Analyze a Large Model” on page 14-3

® “Increase Allocated Memory for Analysis Report Generation” on page 14-8
e “Manage Model Data to Simplify the Analysis” on page 14-9

e “Partition Model Inputs for Incremental Test Generation” on page 14-13

e “Bottom-Up Approach to Model Analysis” on page 14-16

e “Extract Subsystems for Analysis” on page 14-17

e “Logical Operations” on page 14-24

* “Models with Large Verification State Space” on page 14-25

® “Counters and Timers” on page 14-26

® “Prove Properties in Large Models” on page 14-28
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Sources of Model Complexity

Some characteristics of Simulink models can cause problems during a
Simulink Design Verifier analysis in the following ways:
e Complexity of model inputs due to:

= Large number of inputs (The number of inputs can vary, depending
on the individual model.)

= Types of inputs (floating-point values, for example)

= The way the inputs affect the model state and the objectives of the
analysis

e Number of possible simulation paths through a model
e Portions of the model that cannot be reached

e Large counters in the model

The topics in “Complexity Reduction” describe techniques designed to reduce
the impact of this complexity and achieve the best performance from the
Simulink Design Verifier software.

Most of these techniques focus on test generation for large models. However,
you can use many of them to detect design errors or prove the properties of a
large model and generate counterexamples when a property is disproved. In
addition, “Prove Properties in Large Models” on page 14-28 describes specific
techniques for proving properties in a large model.
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Analyze a Large Model

In this section...

“Types of Large Model Problems” on page 14-3
“Use the Default Parameter Values” on page 14-4
“Modify the Analysis Parameters” on page 14-5
“Use the Large Model Optimization” on page 14-6

“Stop the Analysis Before Completion” on page 14-6

Types of Large Model Problems

The Simulink Design Verifier software may encounter some of these problems
when analyzing a large model:

® Unsatisfiable objectives — The software proved there are no test cases that
exercise these test objectives, and did not generate any test cases.

¢ Undecided objectives — The software was not able to satisfy or falsify
these objectives.

® (Objectives with errors — This problem usually occurs when a model
component uses nonlinear arithmetic, which can affect a test objective.

¢ Cannot complete the analysis in the time allotted — This problem may
indicate an area of your model where the software encountered problems,
or you may need to increase value of the Maximum analysis time
parameter.

® Analysis hangs — If the number of objectives processed remains constant
for a considerable length of time, the software has likely encountered
complexity between the model and its objectives.

® Does not achieve a high percentage of model coverage — When you run
the test cases on the harness model, the percentage of model coverage is
insufficient for your design.

The next few sections describe the initial steps to take when analyzing a large

model. Although these steps address test generation, you can use a similar
approach when detecting design errors or proving properties in a model.
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Use the Default Parameter Values

When you generate test cases for a model, whether large or small, the first
step is to analyze the model using the Simulink Design Verifier default
parameter values:

1 Check to see if your model is compatible with the Simulink Design Verifier

software, as described in “Check Model Compatibility” on page 3-2.

2 Using the default parameter values, analyze the model. The following table

lists the default values for parameters in the Configuration Parameters
dialog box that you might change when analyzing large models.

Parameter

Default Value

Description

Maximum
analysis time

()

300 (seconds)

If the analysis does not finish
within the specified time,
the analysis times out and
terminates.

Test suite CombinedObjectiyd$enerates test cases that address
optimization (Nonlinear more than one test objective, as
extended) with the CombinedObjectives

option, but with improved support
for nonlinear arithmetic. Each
test case tends to include many
time steps.

Model coverage | Condition Generates test cases that achieve

objectives Decision condition and decision coverage.

window while the analysis runs:

3 Review the following information in the Simulink Design Verifier log

e Number of objectives processed — How many objectives were processed?
Did the analysis hang after processing a certain number of objectives?
The answers to these questions might give you a clue about where a
problem might lie.

e Number of objectives satisfied/Number of objectives falsified — Which
objectives were falsified?



Analyze a large Model

* Time elapsed — Did the analysis time out, or did it finish within the
specified maximum analysis time?

4 When the analysis completes, you can highlight the results in the model
and individually review the analysis of each model object, as described in
“Highlighted Results on the Model” on page 13-2. You can also generate
and review the Simulink Design Verifier HTML report. This report
contains links to the model elements for satisfied and falsified objectives
so you can see what portions of the model might have problems. For more
information, see “Simulink® Design Verifier™ Reports” on page 13-29.

5 For a test-generation analysis, if all the test objectives have been satisfied,
run the test cases on the harness model to determine model coverage.

If model coverage is enough for your design, you do not need to do anything
else. If the coverage is insufficient, take additional steps to improve the
analysis performance, as described in the following sections.

Note A large percentage of falsified objectives and poor model coverage often
indicate that you need to change model parameter values to get complete
coverage. This can occur when you have tunable parameters in Constant
blocks that are connected to enabled subsystems or to the trigger inputs

of Switch blocks. In these situations, configure Simulink Design Verifier
parameter support as described in the example “Specify Parameters as
Variables for Full Coverage” on page 5-9.

Modify the Analysis Parameters

If the analysis satisfied most but not all of the objectives, try the following
steps:

1 Increase the Maximum analysis time parameter. This gives the analysis
more time to satisfy all the objectives.

2 Set the Model coverage objectives parameter to Decision. Selecting
this option generates only test cases that achieve decision coverage. These
test cases are a subset of the MCDC option.

3 Rerun the analysis and review the report.

14-5
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If the results are still not satisfactory, try the techniques described in the
following sections.

Use the Large Model Optimization

Set the Test suite optimization parameter to LargeModel or LargeModel
(Nonlinear Extended), and rerun the Simulink Design Verifier analysis.

The large model optimization strategies are designed for large, complex
models. The LargeModel (Nonlinear Extended) strategy includes improved
support for nonlinear arithmetic. These two strategies may or may not
improve the results of your analysis enough to fully test your design.

If you have outstanding objectives you want the software to generate, continue
with the following techniques.

Stop the Analysis Before Completion

Watch the Objectives processed value in the log window. If about 50
percent of the Maximum analysis time parameter has elapsed and this
value does not increase, the model analysis may have trouble processing
certain objectives. If the analysis does not progress, take the following steps:

1 Click Stop in the log window.

A dialog box appears, informing you that the analysis was aborted and
asking you if you still want to produce results.

2 Click Yes to save the results of the analysis so far.

The log window lists the following options, depending on which analysis
mode you ran:

e Highlight analysis results on model
* Generate detailed analysis report
¢ Create harness model

e Simulate tests and produce a model coverage report

3 Click Generate detailed analysis report.
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4 In the HTML report, review the following sections to identify the model
elements that are causing problems:

® Objectives Undecided when the Analysis was Stopped
¢ Objectives Producing Errors
5 Review the model elements that have undecided objectives or objectives

with errors to see if any of the following problems are present. Consult the
respective documentation for specific techniques to improve the analysis.

Problem in your model More information

Floating-point inputs “Manage Model Data to Simplify
the Analysis” on page 14-9

Nonlinear operations ¢ “Bottom-Up Approach to Model
Analysis” on page 14-16

® “Logical Operations” on page

14-24
Large state spaces “Models with Large Verification
State Space” on page 14-25
Large timers and time delays “Counters and Timers” on page
14-26
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Increase Allocated Memory for Analysis Report Generation

When you analyze a model with a large root-level input signal count, you may
encounter an insufficient memory error when the Simulink Design Verifier
software 1s generating the report.

When this occurs, you need to increase the amount of memory the Sun™
Java® Virtual Machine (JVM™) software can allocate. For steps on how to
increase this memory, see “Increase the MATLAB JVM Memory Allocation
Limit” in the MATLAB Report Generator™ documentation.
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Manage Model Data to Simplify the Analysis

In this section...

“Simplify Data Types” on page 14-9

“Constrain Data” on page 14-9

Simplify Data Types

One way to simplify your model is to use for the designated signal data type
a data type requiring the least amount of space for the expected data. For
example, do not use an int data type for Boolean data, because only one bit
is required for Boolean data.

In another example, suppose you have a Sum block with two inputs that are
always integers between —10 and 10. Set the Output data type parameter to
int8, rather than int32 or double.

To display the signal data types in the model window, select
Display > Signals & Ports > Port Data Types.

Constrain Data

Another effective technique for reducing complexity is to restrict the inputs
to a set of representative values or, ideally, a single constant value. This
process, called discretization, treats the input as if it were an enumeration.
Discretization allows you to handle nonlinear arithmetic from multiplication
and division in the simplest way possible.

The following model has a Product block feeding a Saturation block.
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Ot
Saturation

"

Product

The Simulink Design Verifier software generates errors when attempting

to satisfy the upper and lower limits of the Saturation block, because the
software does not support nonlinear arithmetic. To work around these errors,
restrict one of the inputs to a set of discrete values.

Identify discrete values that are required to satisfy your testing needs. For
example, you may have an input for model speed, and your design contains
paths of execution that are conditioned on speed above or below thresholds of
80, 150, 600, and 8000 RPM. For an effective analysis, constrain speed values
to be 50, 100, 200, 1000, 5000, or 10000 RPM so that every threshold can

be either active or inactive.

If you need to use more than two or three values, consider specifying the
constrained values using an expression like

num2cell (minval:increment:maxval)

Using the previous example model, restrict the second input (y) to be either 1,
2, 5, or 10 using the Test Condition block as shown in the following model.
The Simulink Design Verifier software produces test cases for all inputs.
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12510} Crut1

Saturation
—
¥

Product

You can also constrain signals that are intermediate or output values

of the model. Constraining such signals makes it easier to work around
multiplication or division inside lower level subsystems that do not depend
on model inputs.

Note Discretization is best limited to a small number of inputs (less than
10). If your model requires discretization of many inputs, try to achieve model
coverage through successive simulations, as described in “Partition Model
Inputs for Incremental Test Generation” on page 14-13.

Test Condition blocks do not need to be placed exactly on the inputs. In
deciding where to place the constraints in your model, consider the following
guidelines:

¢ Favor constraints on the input values because the software can process
inputs easier.

¢ If you need to place constraints on both the input and the output, for
example, to avoid nonlinear arithmetic, one of the constraints should be
a range such as [minval maxval]. The software first tests the values at
both ends of the range and can return a test case, even if the underlying
calculations are nonlinear.

® Make sure that constraints at corresponding input and output points are
not contradictory. Do not constrain the output signals to values that are
not achievable because of the constraints on the input values.
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® Avoid creating constraints that contradict the model. Such contradictions

occur when a constraint can never be satisfied because it contradicts some
aspect of the model or another constraint. Analyzing contradictory models
can cause the Simulink Design Verifier software to hang.

The next model is a simple example of a contradictory model. The second
input to the Multiply block is the constant 1, but the Test Condition block
constrains it to a value of 2, 5, or 10. The analysis cannot achieve all the

test objectives in this model.

O

X

25 Cutl
i 10} Saturation

1 — —»

Constant

Product

When you work with large models that have many multiplication and
division operations, you may find it easier to add constraints to all of the
floating-point inputs rather than to identify the precise set of inputs that
require constraints.
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Partition Model Inputs for Incremental Test Generation

As described in “Constrain Data” on page 14-9, you can constrain the values
of model inputs using the Simulink Design Verifier Test Condition block.

Like other Simulink parameters, constraint values can be shared across
several blocks by referencing a common workspace variable; you can initialize
constraint values using MATLAB commands. If you have several inputs
related to speed, such as desired speed, measured speed, and average speed,
you might choose to constrain all of them to the same set of values.

As an advanced technique for experienced MATLAB programmers, you can
use parameterized constraints and successive runs of the Simulink Design
Verifier software to implement an incremental test-generation technique:

1 Partition model inputs so that some are held constant, some are constrained
to sets of constants using the Test Condition block, and some can have
any value.

2 Generate test cases and run those test cases to collect model coverage.
3 Choose new values and partition the inputs with these new values.

4 Generate test cases for missing coverage using the sldvgencov function
and the current test coverage.

Note To view an example of extending an existing test suite to achieve
missing model coverage, enter the following at the command prompt in
the MATLAB Command Window:

showdemo ( 'sldvdemo_incremental_test_generation')

5 Repeat steps 3 and 4 until you have achieved the desired coverage.
Partition the model inputs that enable further simplification when an analysis

runs. Consider the following model, which has three mutually independent
enabled subsystems:
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Partition Model Inputs for Incremental Test Generation

You can incrementally generate test cases for each subsystem by constraining
the first input to a constant value before running an analysis. In this way, as

you create test cases for each subsystem, the software ignores the complexity
of the other two subsystems.
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Bottom-Up Approach to Model Analysis

14-16

Simulink Design Verifier software works most effectively at analyzing large
models using a bottom-up approach. In this approach, the software analyzes
smaller model components first, which can be faster than using the Large
model test suite optimization.

The bottom-up approach offers several advantages:
¢ [t allows you to solve the problems that slow down error detection, test

generation, or property proving in a controlled environment.

® Solving problems with small model components before analyzing the model
as a whole is more efficient, especially if you have unreachable components
in your model that you can only discover in the context of the model.

® You can iterate more quickly—find a problem and fix it, find another
problem and fix it, and so on.

e If one model component has a problem—for example, a component is
unreachable in simulation—that can prevent the software from generating
tests for all the objectives in a large model.

Try this workflow with your large model:

1 Break down the model into components of 100-1000 objectives each. Use
the sldvextract function to extract components into a new model for
analysis purposes.

2 Analyze the individual components, starting with the lowest level
subsystems.

3 Fix any problems by adding constraints or specifying block replacements.

4 After you analyze the smaller components, reapply the required constraints
and substitutions to the original model and analyze the full model.

When you finish a bottom-up analysis, you should have a top-level model
that the Simulink Design Verifier software can analyze quickly.
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Extract Subsystems for Analysis

In this section...

“Overview of Subsystem Extraction” on page 14-17

“sldvextract Function” on page 14-18

“Structure of the Extracted Model” on page 14-18

“Analyze Subsystems That Read from Global Data Storage” on page 14-18
“Analyze Function-Call Subsystems” on page 14-21

Overview of Subsystem Extraction

If you have a large model that slows down your analysis or has unreachable
objectives, you may want to analyze atomic subsystems or Stateflow atomic
subcharts using the Simulink Design Verifier software. This technique allows
you to implement a bottom-up approach to analyzing a large model, as
described in “Bottom-Up Approach to Model Analysis” on page 14-16.

When you analyze a subsystem or atomic subchart, the software:

® Extracts the subsystem or subchart into a new model.

¢ If required, adds blocks to the newly created model that replicate the
execution context of the subsystem or subchart within its parent model.

® Analyzes the extracted model and produces results.

Note The Simulink Design Verifier software can only analyze atomic
subsystems and atomic subcharts.

For more information about analyzing subsystems, see “Analyze a Subsystem”
on page 1-27.

For more information about analyzing atomic subcharts, see “Analyze a
Stateflow Atomic Subchart” on page 1-29.
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sldvextract Function

The sldvextract function allows you to extract subsystems and atomic
subcharts for component verification. By extracting the subsystem or atomic
subchart, you can verify the component in isolation from the rest of the
system, allowing you to test the component algorithm. For more information,
see “What Is Component Verification?” on page 10-2 and “Functions for
Component Verification” on page 10-4.

Structure of the Extracted Model

When you analyze a subsystem or atomic subchart, the Simulink Design
Verifier software creates a new model that contains the subsystem or atomic
subchart, and any input and output ports that correspond to the ports
connected to the original subsystem. The software assigns the following
properties to the ports in the new model, as determined by compiling the
original model:

® Data types
e Sample rates

® Signal dimensions

The software names the new model subsystem name, where subsystem_name
is the name of the subsystem.

The next sections provide examples of how the Simulink Design Verifier
software extracts and analyzes subsystems.

Analyze Subsystems That Read from Global Data
Storage

A data store is a repository to which you can write data, and from which you
can read data, without having to connect an input or output signal directly
to the data store.

You create a data store using a Data Store Memory block or a
Simulink.Signal object. The Data Store Memory block or Simulink.Signal
object represents the data store and specifies its properties. Every data store
must have a unique name.
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When you analyze a subsystem that reads data from a data store that is
accessed outside the subsystem, the analysis:
e Adds a Data Store Memory block to the new model.

¢ Adds an input port that writes to the data store. Since the input writes to
the data store, the data can have any values (within the specified data
type) for the purpose of the Simulink Design Verifier analysis.

If the data store specifies minimum and maximum values, those values
are assigned to the new input port.

The following example analyzes a subsystem in the s1_subsys_fcncall8
example model:

1 Open the s1_subsys_fcncall8 example model:

sl _subsys_fcncall8

This model defines a data store A, from which the atomic subsystem Reader
reads data using a Data Store Read block.

2 Right-click the Reader subsystem and select Design Verifier > Generate
Tests for Subsystem.

The Simulink Design Verifier log window shows that the software extracts
the subsystem into a new model named Reader, analyzes the extracted
model, and offers you the choice of which results to produce.

3 Open the new Reader model that the software created in
<current_folder>\sldv_output\Reader.
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The new Inport block A writes into the data store, which is used by the

subsystem Reader in the new model.
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Analyze Function-Call Subsystems

A function-call subsystem 1s a triggered subsystem whose execution 1s
determined by logic internal to a C MEX S-function instead of by the value of
a signal. Function-call subsystems are always atomic.

Note For more information, see “Function-Call Subsystems and S-Functions”
in the Simulink documentation.

When you analyze a model with a function-call subsystem, the Simulink
Design Verifier software creates a new model with an Inport block that
mimics the trigger and a copy of the subsystem. The software then analyzes
the new model.

The following example analyzes a function-call subsystem in the
sl subsys_fcncall2 model:

1 Open the s1_subsys_fcncall2 example model:

sl _subsys_fcncall2

This model contains a Stateflow chart named Chart that triggers the
function-call subsystem f.

2 Right-click the f subsystem and select Design Verifier > Generate Tests
for Subsystem.

The software extracts the subsystem into a new model named f, analyzes
the extracted model, and produces results.
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P

Simulink Design Verifier log: f @

Progress |

Objectives processed 5/5

Satisfied 5
Falsified i
Elapsed time 0:01

Test generation completed normally.
All 5 objectives satisfied.

Results:

= Highlight analvsis results on model

* Generate detailed analvsis report

* Create harness model

* Simulate tests and produce a model coverage report

Data saved in: £ sldvdatal.mat
in folder: H:\Documents\MATLAB\sldv_output\f

View Log I I Close

3 Open the f model that the software created in
<current_folder>\sldv_output\f.

The Inport block and the new subsystem block mimic the trigger for the
function-call subsystem f in the new f model.
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Logical Operations

14-24

If you have a Simulink model with both logical and arithmetic operations,
consider analyzing only the logical operations.

The Simulink Design Verifier software does not support nonlinear arithmetic
of floating-point numbers, as occurs with multiplication or division, unless
one of the multiply operands or the divisor is a constant.

To simplify models that contain integers or floating-point numbers, the
software maps the model computations into expressions of Boolean variables.
For example, the software might represent an eight-bit number as a set of
eight Boolean values, with one for each digit. It might represent a bit-wise OR
operation of two eight-bit integers as eight separate logical OR operations.

Mapping problems of one data type into Boolean variables is complex, and
this complexity increases when the software performs such mapping. The
software handles models with predominantly logical signals more efficiently
than it does those with large integer or floating-point signals.

Note Simulink Design Verifier software can handle floating-point inputs
when their values impact the design through linear inequalities such as
x<yora>0.

In addition, input complexity can result from certain cast operations. For
example, casting a double to an int8 can introduce a nonlinearity in certain
situations.
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Models with Large Verification State Space

Persistent design variables (variables that are assigned in one time step and
used in a later time step during simulation) affect the complexity of analysis
in much the same way as input complexity. You can use one or more of the
following techniques to simplify the complexity of the state space you want to
search:

® Apply constraints to input signals that are delayed.

e Constrain the inputs to states that are contained within conditionally
executed subsystems.

® Limit the number of test case steps by setting the Maximum test case
step parameter to 20.

¢ Increase the sample time for part or all of the model. (This procedure is
similar to reducing timer thresholds, as described in “Counters and Timers”
on page 14-26.) A test case that you generate at a lower sample rate often
has similarities to the test case with a high sample rate that you need to
achieve an objective.

e Use tight variable types where ever possible. For example, if a flag with
values of 0 or 1 only is defined as a double, restrict the type to Boolean.

States that are computed from previous state values present a special
challenge. For example, if you want to restrict the integrator value in a PID
controller, you can only use a set of values that includes all reachable values
from the initial value. Otherwise, the input must be forced to 0. Neither

of these limitations is practical and would probably make the analysis less
complete.

Alternatively, you can use existing simulation data to help satisfy your
testing needs. If you have existing test data, run it on your model and collect
model coverage. For an example of extending an existing test suite to achieve
missing model coverage, see Extending an Existing Test Suite.
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Counters and Timers
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Simulink Design Verifier analysis searches through sequences of states to
find input values that drive the analysis to reach a state that satisfies an
objective. Each counter value or timer step corresponds to a different state,
so the presence of long timers or counters can dramatically increase the size
of the state representation. Since analysis complexity depends on the size of
the state representation, you must give special consideration to counters and
timers in your model to avoid overcomplicating Simulink Design Verifier
analysis.

Note For the purposes of Simulink Design Verifier analysis, the term
configuration refers to a set of values for all the persistent information in
your model.

The search process investigates all configurations that can be reached

in a single timer step before considering any of the configurations that

can be reached in two timer steps. Likewise, the search investigates all
configurations that can be reached in two timer steps before it considers any
configuration that requires three or more timer steps, and so on. The number
of timer steps required to exhaust the counter directly affects the number of
states that the analysis needs to search. Models that contain time delays,
such as countdown timers, complicate the analysis by forcing the search to
span a large number of states.

You may see similar effects when systems use extensive averaging and
filtering to delay the response to a change in inputs. Any aspect of the design
that delays the response causes the test sequences to contain more timer
steps, resulting in longer test cases that are more difficult to identify.

Some basic techniques you can use to improve analysis performance in models
with counters or timers include the following:

® Choose very small values for time delays. A system with a logical error
when a time delay is set to 2000 steps usually demonstrates that error if
the time delay is changed to 2 steps. If your system has several delays,
choose small but unique values for each of them so that your delays are
progressively satisfied.
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e Make the initial values of counters and timers parameter values that
the Simulink Design Verifier software can modify. The software finds
initial values that allow shorter test cases to exceed thresholds. For more
information, see “Parameters as Variables in Simulink® Design Verifier™
Analysis” on page 5-2.

® Choose higher frequency cutoffs for filters and fewer samples to average to

minimize filtering delays.

Some more advanced techniques you can use to improve analysis performance
in models with counters or timers include the following:

e Use sldvtimer to identify timer patterns that can be optimized for
Simulink Design Verifier test generation.

¢ Use an existing test case or set of test cases that exhausts the counter
or timer, and extend those test cases to create a full test suite. For more
information, see Defining and Extending Existing Test Cases.
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Property proving uses the same underlying techniques as design error
detection and test generation and suffers from the same performance
limitations. However, unlike design error detection or test generation, you
often cannot simplify the problem without compromising the validity of the
results.

You can quickly prove simple proof objectives that are not affected by
model dynamics. However, a thorough proof requires that the Simulink
Design Verifier software search through all reachable configurations of your
model—even the ones that are reached only after long time delays. The
computation time and memory required to search a model completely often
make an exhaustive proof impractical.

There are two techniques you can use to improve the performance of property
proving in a large model:

In this section...

“Find Property Violations While Designing Your Model” on page 14-28

“Combine Proving Properties and Finding Proof Violations” on page 14-29

Find Property Violations While Designing Your Model

Simulink Design Verifier software offers a strategy that quickly identifies
property violations in larger, more complicated models. While designing your
model, analyze your model using this strategy so that you can fix any property
violations before finalizing your design.

To identify property violations of a model, on the Design Verifier >
Property Proving pane of the Configuration Parameters dialog box, specify
the value of the Strategy parameter as FindViolation. When you use this
strategy, the Maximum violation steps parameter becomes active so that
you can specify an upper bound for the number of time steps in the search.

When analyze the model, the software searches only for property violations
within the specified number of time steps. By identifying and fixing the
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property violations first, you improve the performance of a property-proving
analysis that uses the Prove strategy.

If a violation is not detected, it 1s impossible to violate the property with

any input sequence having fewer time steps than the specified limit.
However, you cannot prove that the property is true because there might be a
counterexample within more time steps than the specified limit.

Combine Proving Properties and Finding Proof
Violations

Use the following technique for proving properties in large model. This
technique combines proving and searching for violations:

1 On the Design Verifier > Property Proving pane, set the Strategy
parameter to Prove.

2 On the Design Verifier pane, use a relatively short value for the
Maximum analysis time parameter, such as 5-10 minutes. If trivial
counterexamples exist — or if your properties do not depend on model
dynamics—the analysis should complete in that amount of time.

3 Change the Strategy parameter to FindViolation, and choose a small
bound for the Maximum violation steps parameter, such as 4, 5, or 6. If
your properties have simple counterexamples, the software should discover
them.

4 If you do not find any violations with a small bound, increase the bound
and look for longer counterexamples.

a Increase the bound in several increments, and observe the processing
time and memory consumption. System resources might limit the length
of violation that can be searched.

b In addition, consider the dynamics of your model and the number of time
steps required to transition between an arbitrary pair of configurations.
If you choose too large a bound, the violation search can be more complex
than the unbounded proof.
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5 If you can run violation searches with relatively large bounds, e.g., 30-50
time steps, switch back to the Prove strategy, and use a longer time limit,
such as several hours.
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Simulink Design Verifier Configuration Parameters

The Simulink Design Verifier software provides numerous options in the
Configuration Parameters dialog box that control its behavior when analyzing
models. To view the options related to Simulink Design Verifier, in the model
window, select Analysis > Design Verifier > Options.

The Configuration Parameters dialog box opens; the Design Verifier panes
are listed in the Select tree on the left-hand side.

Typically, you specify values for these options using the Configuration
Parameters dialog box. See “Configuration Parameters Dialog Box Overview”
for more information about working with this interface.

Note By default, Simulink Design Verifier options do not appear in a
model’s Configuration Parameters dialog box. In the model window, if you
select Analysis > Design Verifier > Options, the Simulink Design Verifier
software initially associates its default options with that model. After you
save the model, you access the Simulink Design Verifier options directly from
the Configuration Parameters dialog box or from the Model Explorer.

Alternatively, you can use the sldvoptions function to view Simulink Design
Verifier options at the command line. Use the following syntax to view
programmatically the options associated with a Simulink model:

opts = sldvoptions('model_name') ;
get(opts)
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Design Verifier Pane

Analysis options

Mode: [Test generation

Maximum analysis time (s): 300
[T Display unsatisfiable test objectives
Automatic stubbing of unsupported blocks and functions

Use specified input minimum and maximum values

Output
Qutput directory: sldv_output/$ModelName$

Make output file names unique by adding a suffix

[ Check Model Compatibility ]

[ Generate Tests

)

In this section...

“Design Verifier Pane Overview” on page 15-4

“Mode” on page 15-4

“Maximum analysis time” on page 15-6

“Display unsatisfiable test objectives” on page 15-7

“Automatic stubbing of unsupported blocks and functions” on page 15-8
“Use specified input minimum and maximum values” on page 15-9

“Output directory” on page 15-10

“Make output file names unique by adding a suffix” on page 15-12
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Design Verifier Pane Overview

Specify analysis options and configure Simulink Design Verifier output.

Mode

Specify the analysis mode for the Simulink Design Verifier software.

Settings
Default: Test generation

Design error detection
Detects integer and fixed-point overflow errors and division-by-zero
errors in a model

Test generation
Generates test cases for a model.

Property proving
Proves properties of a model.

Tip

The Simulink Design Verifier software specifies the value of this option
automatically when you select one of the following menu options:

® Analysis > Design Verifier > Generate Tests

¢ Analysis > Design Verifier > Detect Design Errors

® Analysis > Design Verifier > Prove Properties

Dependency

Selecting Test generation enables the Display unsatisfiable test
objectives parameter.

When you set the Mode parameter, the button below Check Model
Compatibility changes as follows:

® Mode: Test generation, button reads: Generate Tests

® Mode: Design error detection, button reads: Detect Errors
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® Mode: Property proving, button reads: Prove Properties

Command-Line Information

Parameter: DVMode

Type: string

Value: 'TestGeneration' | 'DesignErrorDetection' |
‘PropertyProving'

Default: 'TestGeneration'

See Also

¢ Basic Workflow for Simulink Design Verifier
¢ What Is Design Error Detection?
¢ What Is Test Case Generation?

¢ What Is Property Proving?
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Maximum analysis time

Specify the maximum time (in seconds) that the Simulink Design Verifier
software spends analyzing a model.

Settings
Default: 300

The value that you enter represents the maximum number of seconds the
Simulink Design Verifier software analyzes your model.

Command-Line Information

Parameter: DVMaxProcessTime
Type: double

Value: any valid value
Default: 300
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Display unsatisfiable test objectives

Specify whether to display warnings if the analysis detects unsatisfiable test
objectives.

Settings
Default: Off

¥ On
Displays a warning in the Simulation Diagnostics Viewer when the
Simulink Design Verifier software is unable to satisfy a test objective.

I off
Does not display a warning when the Simulink Design Verifier software
is unable to satisfy a test objective.

Tip If you first select Display unsatisfiable test objectives, set the Test
suite optimization option to the Combined objectives strategy and
analyze the model. If that test returns objectives without outcomes, then
select the Individual objectives strategy and reanalyze the model. The
Individual objectives strategy analyzes each objective independently
and identifies unsatisfiable objectives.

Command-Line Information

Parameter: DVDisplayUnsatisfiableObjectives
Type: string

Value: 'on' | 'off'

Default: 'off'
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Automatic stubbing of unsupported blocks and
functions

Specify whether or not Simulink Design Verifier software should ignore
unsupported blocks and functions and proceed with the analysis.

Settings
Default: On

¥ on
Ignores unsupported blocks and functions and proceeds with the
analysis.

I off
Displays a warning when the Simulink Design Verifier software
encounters an unsupported block or function and asks if you want to
continue the analysis.

Command-Line Information

Parameter: DVAutomaticStubbing
Type: string

Value: 'on' | 'off'
Default: 'on'
See Also

Handle Incompatibilities with Automatic Stubbing
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Use specified input minimum and maximum values

Specify whether or not Simulink Design Verifier software should generate test
cases that consider specified minimum and maximum values as constraints
for all input signals in your model.

Settings
Default: On

¥ On
Considers specified minimum and maximum values as constraints for
all input signals.

I ofr

Ignores any specified minimum and maximum values.

Command-Line Information

Parameter: DVDesignMinMaxConstraints
Type: string

Value: 'on' | 'off'
Default: 'on'
See Also

Minimum and Maximum Input Constraints
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Output directory

Specify a path name to which the Simulink Design Verifier software writes its
output.

Settings
Default: sldv_output/$ModelName$

¢ Enter a path that is either absolute or relative to the current folder.

® $ModelName$ is a token that represents the model name.

Ti
Yoi can use the following parameters to customize the names and locations
of Simulink Design Verifier output:
® On the Results pane:
= Data file name
= Harness model file name
= SystemTest file name
* On the Report pane:
= Report file name
= File path of the output model
* On the Block Replacements pane:
= File path of the output model

Command-Line Information

Parameter: DVOutputDir

Type: string

Value: any valid path

Default: 'sldv_output/$ModelName$'
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See Also
Results Interpretation and Use
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Make output file names unique by adding a suffix

Specify whether the Simulink Design Verifier software makes its output file
names unique by appending a numeric suffix.

Settings
Default: On

¥ On
Appends an incremental numeric suffix to Simulink Design Verifier
output file names. Selecting this option prevents the software from
overwriting existing files that have the same name.

" o
Does not append a suffix to Simulink Design Verifier output file names.
In this case, the software might overwrite existing files that have the
same name.

Command-Line Information

Parameter: DVMakeOutputFilesUnique
Type: string

Value: 'on' | 'off'
Default: 'on'
See Also

Results Interpretation and Use
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Design Verifier Pane: Block Replacements

Block replacements

Apply block replacements

List of block replacement rules (in order of priority):

Output model

File path of the output model:

In this section...

“Block Replacements Pane Overview” on page 15-14
“Apply block replacements” on page 15-15
“List of block replacement rules” on page 15-16

“File path of the output model” on page 15-17
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Block Replacements Pane Overview

Specify options that control how the Simulink Design Verifier software
preprocesses the models it analyzes.

See Also
Block Replacement
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Apply block replacements

Specify whether the Simulink Design Verifier software replaces blocks in
a model before its analysis.

Settings
Default: Off

¥ On
Replaces blocks in a model before the Simulink Design Verifier software
analyzes it.

I off
Does not replace blocks in a model before the Simulink Design Verifier
software analyzes it.

Dependencies

This parameter enables List of block replacement rules and File path of
the output model.

Command-Line Information

Parameter: DVBlockReplacement
Type: string

Value: 'on' | 'off!'

Default: 'off'

See Also
Block Replacement
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List of block replacement rules

Specify a list of block replacement rules that the Simulink Design Verifier
software executes before its analysis.

Settings
Default: <FactoryDefaultRules>

® Specify block replacement rules as a list delimited by spaces, commas,
or carriage returns.

® The Simulink Design Verifier software processes block replacement rules
in the order that you list them.

¢ If you specify the default value, the Simulink Design Verifier software uses
its factory default block replacement rules.

Dependency

This parameter is enabled when you select Apply block replacements.

Command-Line Information

Parameter: DVBlockReplacementRulesList
Type: string

Value: any valid rules

Default: '<FactoryDefaultRules>'

See Also
Block Replacement
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File path of the output model

Specify a folder and file name for the model that results after applying block
replacement rules.

Settings
Default: $ModelName$ replacement

e QOptionally, enter a path that is either absolute or relative to the path name
specified in Output directory.

e Enter a file name for the model that results after applying block
replacement rules.

® $ModelName$ is a token that represents the model name.

Dependency

This parameter is enabled when you select Apply block replacements.

Command-Line Information

Parameter: DVBlockReplacementModelFileName
Type: string

Value: any valid path and file name

Default: '$ModelName$_replacement'

See Also
Block Replacement
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Design Verifier Pane: Parameters

15-18

Farameters
Apply parameters

Parameter configuration file:

In this section...

“Parameters Pane Overview” on page 15-19

“Apply parameters” on page 15-19

“Parameter configuration file” on page 15-19
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Parameters Pane Overview

Specify options that control how the Simulink Design Verifier software uses
parameter configurations when analyzing models.

Apply parameters

Specify whether the Simulink Design Verifier software uses parameter
configurations when analyzing a model.

Settings
Default: Off

M on
The Simulink Design Verifier software uses parameter configurations
when analyzing a model.

I off
The Simulink Design Verifier software does not use parameter
configurations when analyzing a model.

Dependency

This parameter enables Parameter configuration file.

Command-Line Information

Parameter: DVParameters
Type: string

Value: 'on' | 'off!'
Default: 'off'

See Also
Define Parameters as Variables

Parameter configuration file

Specify a MATLAB function that defines parameter configurations for a
model.
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Settings
Default: sldv_params_template.m

® The default file, sldv_params_template.m, is a template that you can edit
and save. The comments in the template explain the syntax you use to
specify parameter configurations.

® (Click the Browse button to select an existing MATLAB file.
¢ (Click the Edit button to open the specified MATLAB file in an editor.

Tips

When Simulink Design Verifier is configured to apply parameters specified
in Parameter configuration file, you cannot use the Extend existing
test cases option. If you specify your model to extend existing test cases
with a Data file and apply parameter configurations with a Parameter
configuration file, when you attempt to perform Simulink Design Verifier
analysis, the software reports that your model is incompatible. This occurs
because the existing test cases do not include corresponding parameter values.

Dependency
This parameter is enabled by Apply parameters.

Command-Line Information

Parameter: DVParametersConfigFileName
Type: string

Value: any valid MATLAB file

Default: 'sldv_params_template.m'

See Also
Define Parameters as Variables
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Design Verifier Pane: Test Generation

Test generation

Model coverage objectives: [Cundition Decision v]
Test conditions: [Use local settings VI
Test objectives: [Use local settings VI

Maximum test case steps: 500

Test suite optimization: ’Cnmbinedobjecti\res (Monlinear Extended) ']

Existing test cases

[C] Bxtend existing test cases:

Data file: Browse
Ignore objectives satisfied by existing test cases

Existing coverage data

[7] 1gnore objectives satisfied in existing coverage data:

Coverage data file: Browse

Coverage objective filter
[7] 1gnore objectives based on filter:

Coverage filter file: Browse

In this section...

“Test Generation Pane Overview” on page 15-23
“Model coverage objectives” on page 15-24

“Test conditions” on page 15-25

“Test objectives” on page 15-26

“Maximum test case steps” on page 15-27

“Test suite optimization” on page 15-28
“Extend existing test cases” on page 15-29

“Data file” on page 15-30
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In this section...

“Ignore objectives satisfied by existing test cases” on page 15-31
“Ignore objectives satisfied in existing coverage data” on page 15-32
“Coverage data file” on page 15-33

“Ignore objectives based on filter” on page 15-34

“Coverage filter file” on page 15-34
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Test Generation Pane Overview

Specify options that control how the Simulink Design Verifier software
generates tests for the models it analyzes.

See Also
Workflow for Test Case Generation

15-23



15 Ssimulink® Design Verifier™ Configuration Parameters

15-24

Model coverage objectives

Specify the type of model coverage that the Simulink Design Verifier software
attempts to achieve.

Settings
Default: Condition Decision

None
Generates test cases that achieve only the custom objectives that you
specified in your model using, for example, Test Objective blocks.

Decision
Generates test cases that achieve decision coverage.

Condition Decision
Generates test cases that achieve condition and decision coverage.

MCDC
Generates test cases that achieve modified condition/decision coverage

(MCDC).

When you set Model coverage objectives to MCDC, the Simulink Design
Verifier software automatically enables every coverage objective for decision
coverage and condition coverage as well. Similarly, enabling coverage for
condition coverage causes every decision and condition coverage outcome to
be enabled.

Command-Line Information

Parameter: DVModelCoverageObjectives

Type: string

Value: 'None' | 'Decision' | 'ConditionDecision' | 'MCDC'
Default: 'ConditionDecision'

See Also
Workflow for Test Case Generation



Design Verifier Pane: Test Generation

Test conditions
Specify whether Test Condition blocks in your model are enabled or disabled.

Settings
Default: Use local settings

Use local settings
Enables or disables Test Condition blocks based on the value of the
Enable parameter of each block. If a block’s Enable parameter is
selected, the block is enabled; otherwise, the block is disabled.

Enable all
Enables all Test Condition blocks in the model regardless of the settings
of their Enable parameters.

Disable all
Disables all Test Condition blocks in the model regardless of the settings
of their Enable parameters.

Command-Line Information

Parameter: DVTestConditions

Type: string

Value: 'UselLocalSettings' | 'EnableAll' | 'DisableAll’
Default: 'UseLocalSettings'

See Also

e Test Condition

e Workflow for Test Case Generation
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Test objectives
Specify whether Test Objective blocks in your model are enabled or disabled.

Settings
Default: Use local settings

Use local settings
Enables or disables Test Objective blocks based on the value of the
Enable parameter of each block. If a block’s Enable parameter is
selected, the block is enabled; otherwise, the block is disabled.

Enable all
Enables all Test Objective blocks in the model regardless of the settings
of their Enable parameters.

Disable all
Disables all Test Objective blocks in the model regardless of the settings
of their Enable parameters.

Command-Line Information

Parameter: DVTestObjectives

Type: string

Value: 'UselLocalSettings' | 'EnableAll' | 'DisableAll’
Default: 'UseLocalSettings'

See Also

¢ Test Objective

e Workflow for Test Case Generation
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Maximum test case steps

Specify the maximum number of simulation steps the Simulink Design
Verifier software takes when attempting to satisfy a test objective.

The analysis uses the Maximum test case steps parameter during certain
parts of the test-generation analysis to bound the number of steps that test
generation uses. When you set a small value for this parameter, the parts of
the analysis that are bounded complete in less time. When you set a larger
value, the bounded parts of the analysis take longer, but it is possible for
these parts of the analysis to generate longer test cases.

To achieve the best performance, set the Maximum test case steps
parameter to a value just large enough to bound the longest required test case,
even if the test cases that are ultimately generated are longer than this value.

When you also specify LongTestcases for the Test suite optimization
parameter, the analysis uses successive passes of test generation to extend a
potential test case so that it satisfies more objectives. When this happens, the
analysis applies the Maximum test case steps parameter to each individual
iteration of test generation.

Settings
Default: 500

You can specify a value that represents the maximum number of simulation

steps the Simulink Design Verifier software takes when attempting to satisfy
a test objective.

Command-Line Information

Parameter: DVMaxTestCaseSteps
Type: int32

Value: any valid value

Default: 500

See Also
Workflow for Test Case Generation
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Test suite optimization
Specify the optimization strategy to use when generating test cases.

Settings
Default: CombinedObjectives (Nonlinear Extended)

CombinedObjectives (Nonlinear Extended)
Analyzes the model using a variation of the CombinedObjectives
optimization. This optimization includes improved support for nonlinear
arithmetic.

LargeModel (Nonlinear Extended)
Analyzes the model using a variation of the LargeModel optimization.
This optimization includes improved support for nonlinear arithmetic.

IndividualObjectives
Maximizes the number of test cases in a suite by generating cases that
each address only one test objective. Each test case tends to be short,
1.e., it includes only a few time steps.

LongTestcases
Combines test cases to create a smaller number of test cases. This
strategy generates fewer, but longer, test cases that each satisfy
multiple test objectives and creates a more efficient analysis and
easier-to-review results.

CombinedObjectives
Minimizes the number of test cases in a suite by generating cases that
address more than one test objective. Each test case tends to be long,
1.e., it includes many time steps.

LargeModel
Minimizes the number of test cases in a suite by generating cases that
address more than one test objective. This strategy is tailored for large,
complex models; consequently, it tends to use all the time that the
Maximum analysis time option allots.

Tip

If an analysis using the CombinedObjectives or CombinedObjectives
(Nonlinear Extended) strategy returns unsatisfiable objectives, set
this option to IndividualObjectives and reanalyze the model. The
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IndividualObjectives strategy analyzes each objective independently and
1s better at identifying unsatisfiable objectives.

However, set this option to LargeModel or LargeModel (Nonlinear
Extended) if the model has both of the following characteristics:

® Nonlinearities, such as those that result from multiplying or dividing the
model’s input signals

®* Numerous test objectives, such as those that result when using blocks
that receive model coverage

The LargeModel and LargeModel (Nonlinear Extended) strategies perform
an analysis that is tailored to large, complex models. However, these
strategies tend to use all the time that the Maximum analysis time option
allots.

If you have a large number of test objectives, select LongTestcases for a more
efficient analysis and an easy-to-review report.

Command-Line Information

Parameter: DVTestSuiteOptimization
Type: string

Value: 'CombinedObjectives (Nonlinear Extended)' | 'LargeModel
(Nonlinear Extended)' | 'IndividualObjectives' | 'LongTestcases'
| 'CombinedObjectives' | 'LargeModel' |

Default: 'CombinedObjectives (Nonlinear Extended)'

See Also

Workflow for Test Case Generation

Extend existing test cases

Extend the Simulink Design Verifier analysis by importing test cases logged
from a harness model or a closed-loop simulation model.

Settings
Default: Off
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¥ On
Extends the analysis by using the logged test cases specified in Data
file.

™ off

Does not extend the analysis.

Tips

When Simulink Design Verifier is configured to apply parameters specified
in Parameter configuration file, you cannot use the Extend existing
test cases option. If you specify your model to extend existing test cases
with a Data file and apply parameter configurations with a Parameter
configuration file, when you attempt to perform Simulink Design Verifier
analysis, the software reports that your model is incompatible. This occurs
because the existing test cases do not include corresponding parameter values.

Dependency

This parameter enables Data file and Ignore objectives satisfied by
existing test cases.

Command-Line Information

Parameter: DVExtendExistingTests
Type: string

Value: 'on' | 'off'

Default: 'off'

See Also

¢ When to Extend Existing Test Cases

¢ Common Workflow for Extending Existing Test Cases

Data file

Specify a folder and file name for the MAT-file that contains the logged test
case data.
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Settings
Default: '

® Specify a folder and file name for the MAT-file that contains the logged
test case data in an sldvData object.

¢ (Click the Browse button to navigate to and select an existing file.

Tips

When Simulink Design Verifier is configured to apply parameters specified
in Parameter configuration file, you cannot use the Extend existing
test cases option. If you specify your model to extend existing test cases
with a Data file and apply parameter configurations with a Parameter
configuration file, when you attempt to perform Simulink Design Verifier
analysis, the software reports that your model is incompatible. This occurs
because the existing test cases do not include corresponding parameter values.

Command-Line Information

Parameter: DVExistingTestFile
Type: string

Value: any valid path and file name
Default: ''

See Also
Simulink Design Verifier Data Files

Ignore objectives satisfied by existing test cases
Ignore the coverage objectives satisfied by the logged test cases in Data file.

Settings
Default: On

¥ On
Generates results, but excludes coverage objectives satisfied by logged
test cases in Data file from the analysis.
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I off
Generates results for the full test suite, including coverage objectives
satisfied by the logged test cases in Data file.

Command-Line Information

Parameter: DVIgnoreExistTestSatisfied
Type: string

Value: 'on' | 'off'
Default: 'on'
See Also

e “Extend Test Cases for Closed-Loop System” on page 8-13

¢ Simulink Design Verifier Data Files

Ignore objectives satisfied in existing coverage data

Specify to analyze the model, ignoring satisfied coverage objectives, as
specified in Coverage data file.

Settings
Default: Off

¥ On
Ignores satisfied coverage objectives in Coverage data file during
the analysis.

I off
Generates results for all coverage objectives, including those in
Coverage data file.

Dependency

This parameter enables Coverage data file.
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Command-Line Information

Parameter: DVIgnoreCovSatisfied
Type: string

Value: 'on' | 'off'

Default: 'off'

See Also

® “Achieve Missing Coverage in Closed-Loop Simulation Model” on page 9-9

® Test Case Extension

Coverage data file

Specify a folder and file name for the file that contains data about satisfied
coverage objectives.

Settings
Default: ''

¢ Specify the name of the folder and file name that contains the satisfied
coverage objectives data

Click the Browse button to select an existing MATLAB file.

Command-Line Information

Parameter: DVCoverageDataFile
Type: string

Value: any valid path and file name
Default: ''

See Also

® “Achieve Missing Coverage in Closed-Loop Simulation Model” on page 9-9

e Test Case Extension
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Ignore objectives based on filter

Specify to analyze the model, ignoring the coverage objectives in the
Coverage filter file.

Settings
Default: Off

¥ On
Ignores coverage objectives in the Coverage filter file during the
analysis.

I off
Generates results for all coverage objectives, including those in
Coverage filter file.

Dependency

This parameter enables Coverage filter file.

Command-Line Information

Parameter: DVCovFilter
Type: string

Value: 'on' | 'off!'
Default: 'off'

See Also

“Coverage Filtering” in the Simulink Verification and Validation
documentation

Coverage filter file

Specify a folder and file name for the file that contains the coverage objectives
you want to ignore. The Coverage filter file specifies model objects to
exclude from model coverage during test case generation.
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Settings
Default: '

¢ Specify the name of the folder and file name that contains the coverage
objectives you want to ignore.

Click the Browse button to select an existing MATLAB file.

Command-Line Information

Parameter: DVCovFilterFileName
Type: string

Value: any valid path and file name
Default: ''

See Also

“Coverage Filter Rules and Files” in the Simulink Verification and Validation
documentation
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Design Verifier Pane: Design Error Detection

Design Error Detection
Dead logic
v | Integer overflow
v | Division by zero
Check specified intermediate minimum and maximum values

Out of bound array access

In this section...

“Design Error Detection Pane Overview” on page 15-37
“Dead Logic” on page 15-37

“Integer overflow” on page 15-38

“Division by zero” on page 15-38

“Check specified intermediate minimum and maximum values” on page
15-39

“Out of bound array access” on page 15-40
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Design Error Detection Pane Overview

Specify options that control how the Simulink Design Verifier software
detects runtime errors in the models it analyzes.

Dead Logic

Specify whether to analyze your model for dead logic.

Settings
Default: Off

I7On

Reports dead logic in your model.

I off

Does not report dead logic in your model.

Dependency

This parameter disables:
¢ Integer overflow

¢ Division by zero

® Check specified intermediate minimum and maximum values

Command-Line Information

Parameter: DVDetectDeadLogic
Type: string

Value: 'on' | 'off!'

Default: 'off'

See Also
Dead Logic Detection
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Integer overflow

Specify whether to analyze your model for integer and fixed-point data
overflow errors.

Settings
Default: On

IFOn

Reports integer or fixed-point data overflow errors in your model.

I ofr

Does not report integer or fixed-point data overflow errors in your model.

Dependency
This parameter is disabled by Dead Logic.

Command-Line Information

Parameter: DVDetectIntegerOverflow
Type: string

Value: 'on' | 'off'
Default: 'on'
See Also

Static Run-Time Error Detection

Division by zero
Specify whether to analyze your model for division-by-zero errors.

Settings
Default: On

IFOn

Reports division-by-zero errors in your model.

15-38



Design Verifier Pane: Design Error Detection

™ off

Does not report division-by-zero errors in your model.

Dependency
This parameter is disabled by Dead Logic.

Command-Line Information

Parameter: DVDetectDivisionByZero
Type: string

Value: 'on' | 'off!'
Default: 'on'
See Also

Static Run-Time Error Detection

Check specified intermediate minimum and
maximum values

Specify whether to check that the intermediate and output signals in your
model are within the range of user-specified minimum and maximum
constraints.

Settings
Default: Off

¥ On
Checks that intermediate and output signals are within the range of
user-specified minimum and maximum constraints.

I ot
Does not check that intermediate and output signals are within the
range of user-specified minimum and maximum constraints.

Dependency
This parameter is disabled by Dead Logic.
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Command-Line Information

Parameter: DVDesignMinMaxCheck
Type: string

Value: 'on' | 'off'

Default: 'off'

See Also
Design Range Checks

Out of bound array access
Specify whether to analyze your model for out of bound array access errors.

Settings
Default: Off

IFOn

Reports out of bound array access errors in your model.

I ofr

Does not report out of bound array access errors in your model.

Dependency
This parameter is disabled by Dead Logic.

Command-Line Information

Parameter: DVDetectOutOfBounds
Type: string

Value: 'on' | 'off'

Default: 'off!'

See Also

® Detect Out of Bound Array Access in Example Model

e Static Run-Time Error Detection



Design Verifier Pane: Property Proving

Design Verifier Pane: Property Proving

Froperty proving
Assertion blocks:
Proof assumptions:
Strateqgy:

Maximum violation steps:

[Use local settings

’Use local settings

l Prowve

In this section...

“Property Proving Pane Overview” on page 15-42
“Assertion blocks” on page 15-43

“Proof assumptions” on page 15-44

“Strategy” on page 15-45

“Maximum violation steps” on page 15-46
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Property Proving Pane Overview

Specify options that control how the Simulink Design Verifier software proves
properties for the models it analyzes.

See Also

* “What Is Property Proving?” on page 12-2
o “Workflow for Proving Model Properties” on page 12-4

® “Prove Properties in a Model” on page 12-5



Design Verifier Pane: Property Proving

Assertion blocks

Specify whether Assertion blocks in your model are enabled or disabled.

Settings
Default: Use local settings

Use local settings
Enables or disables Assertion blocks based on the value of the Enable
parameter of each block. If a block’s Enable parameter is selected, the
block is enabled; otherwise, the block is disabled.

Enable all
Enables all Assertion blocks in the model regardless of the settings of
their Enable parameters.

Disable all
Disables all Assertion blocks in the model regardless of the settings of
their Enable parameters.

Command-Line Information

Parameter: DVAssertions

Type: string

Value: 'UselLocalSettings' | 'EnableAll' | 'DisableAll’
Default: 'UseLocalSettings'

See Also

® Assertion
* “Workflow for Proving Model Properties” on page 12-4

e “Prove Properties in a Model” on page 12-5
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Proof assumptions

Specify whether Proof Assumption blocks in your model are enabled or
disabled.

Settings
Default: Use local settings

Use local settings
Enables or disables Proof Assumption blocks based on the value of the
Enable parameter of each block. If a block’s Enable parameter is
selected, the block is enabled; otherwise, the block is disabled.

Enable all
Enables all Proof Assumption blocks in the model regardless of the
settings of their Enable parameters.

Disable all
Disables all Proof Assumption blocks in the model regardless of the
settings of their Enable parameters.

Command-Line Information

Parameter: DVProofAssumptions

Type: string

Value: 'UselLocalSettings' | 'EnableAll' | 'DisableAll’
Default: 'UseLocalSettings'

See Also

® Proof Assumption
* “Workflow for Proving Model Properties” on page 12-4

® “Prove Properties in a Model” on page 12-5
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Strategy

Specify the strategy that the Simulink Design Verifier software uses when
proving properties.

Settings
Default: Prove

Prove
Performs property proofs.

FindViolation
Searches only for property violations within the number of simulation
steps specified by the Maximum violation steps option.

ProveWithViolationDetection
Searches first for property violations within the number of simulation
steps specified by the Maximum violation steps option; then it
attempts to prove properties for which it failed to detect a violation. This
strategy is a combination of the Prove and FindViolation strategies.

Dependency

Selecting FindViolation or ProveWithViolationDetection enables the
Maximum violation steps parameter.

Command-Line Information

Parameter: DVProvingStrategy

Type: string

Value: 'Prove' | 'FindViolation' | 'ProveWithViolationDetection'
Default: 'Prove'’

See Also

® “What Is Property Proving?” on page 12-2
¢ “Workflow for Proving Model Properties” on page 12-4

® “Prove Properties in a Model” on page 12-5
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Maximum violation steps

Specify the maximum number of simulation steps over which the Simulink
Design Verifier software searches for property violations.

Settings
Default: 20
The Simulink Design Verifier software does not search beyond the maximum

number of simulation steps that you specify. Therefore, it cannot identify
violations that might occur later in a simulation.

Dependency

This parameter is enabled when you set Strategy to Findviolation or
ProveWithViolationDetection.

Command-Line Information

Parameter: DVMaxViolationSteps
Type: int32

Value: any valid value

Default: 20

See Also

* “What Is Property Proving?” on page 12-2
* “Workflow for Proving Model Properties” on page 12-4

® “Prove Properties in a Model” on page 12-5
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Design Verifier Pane: Results

Data file options

/| Save test data to file

Data file name: $ModelNames_sldvdata
Include expected output values

Randomize data that do not affect the outcome

Display results on model

Display results of the analysis on the model

Harness model options
Save test harness as model
Harness model file name:

Reference input model in generated harness

SystemTest options
Save test harness as SystemTest TEST-file (will reference saved data file)

SystemTest file name:

In this section...

“Results Pane Overview” on page 15-49

“Save test data to file” on page 15-50

“Data file name” on page 15-51

“Include expected output values” on page 15-52

“Randomize data that does not affect outcome” on page 15-53
“Display results of the analysis on the model” on page 15-54
“Save test harness as model” on page 15-56

“Harness model file name” on page 15-57

“Reference input model in generated harness” on page 15-58
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In this section...

“Save test harness as SystemTest TEST-file (will reference saved data file)”
on page 15-60

“SystemTest file name” on page 15-61
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Results Pane Overview

Specify options that control how the Simulink Design Verifier software
handles the results that it generates.

See Also
Results Interpretation and Use
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Save test data to file

Save the test data that the Simulink Design Verifier analysis generates to
a MAT-file.

Settings
Default: On

¥ On
Saves the test data that the analysis generates to a MAT-file.

I ofr

Does not save the test data that the analysis generates.

Dependency

This parameter enables Data file name.

Command-Line Information

Parameter: DVSaveDataFile
Type: string

Value: 'on' | 'off'
Default: 'on'
See Also

¢ Simulink Design Verifier Data Files

e Results Interpretation and Use



Design Verifier Pane: Results

Data file name

Specify a folder and file name for the MAT-file that contains the data
generated during the analysis, stored in an sldvData structure.

Settings
Default: $ModelName$ sldvdata

e QOptionally, enter a path that is either absolute or relative to the path name
specified in Output directory.

e Enter a file name for the MAT-file.

® $ModelName$ is a token that represents the model name.

Dependency

This parameter is enabled by Save test data to file.

Command-Line Information

Parameter: DVDataFileName
Type: string

Value: any valid path and file name
Default: '$ModelName$_sldvdata'

See Also

¢ Simulink Design Verifier Data Files

¢ Results Interpretation and Use
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Include expected output values

Simulate the model using test case signals and include the output values in
the Simulink Design Verifier data file.

Settings
Default: Off

¥ On
Simulates the model using the test case signals that the analysis
produces. For each test case, the software collects the simulation output
values associated with Outport blocks in the top-level system and
includes those values in the MAT-file that it generates.

I off
Does not simulate the model and collect output values for inclusion in
the MAT-file that the analysis generates.

Tips

® The TestCases.expectedOutput subfield of the MAT-file contains the
output values. For more information, see “Contents of sldvData Structure”
on page 13-9.

e When Include expected output values is enabled, the Simulink Design
Verifier software successively simulates the model using each test case
that it generates. Enabling this option requires more time for the Simulink
Design Verifier software to complete its analysis.

Dependency

This parameter is enabled by Save test data to file.

Command-Line Information

Parameter: DVSaveExpectedOutput
Type: string

Value: 'on' | 'off'

Default: 'off'



Design Verifier Pane

: Results

See Also

¢ Simulink Design Verifier Data Files

¢ Results Interpretation and Use

Randomize data that does not affect outcome

Specify whether to use random values instead of zeros for input signals that
have no impact on test or proof objectives.

Settings
Default: Off

IFOn

Assigns random values to test case or counterexample signals that do
not affect the outcome of test or proof objectives in a model. This option
can enhance traceability and improve your regression tests.

" o
Assigns zeros to test case or counterexample signals that do not affect
the outcome of test or proof objectives in a model.

Tips

¢ This option assigns random values to test case or counterexample signals
that otherwise would be zero. In the Simulink Design Verifier report, the
Generated Input Data table always displays a dash (-) for such signals.

¢ Enable this option to enhance traceability when simulating test cases or
counterexamples. For instance, consider the following model:
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Ind
O

In2 i o Ot
Switch
In3

Only the signal entering the Switch block’s control port impacts its decision
coverage. If the Randomize data that does not affect outcome
parameter 1s off, the Simulink Design Verifier software uses zeros to
represent the signals from In1 and In3. When inspecting the results from
test case or counterexample simulations, it is unclear which of these signals
passes through the Switch block because they have the same value. But if
the Randomize data that does not affect outcome parameter is on, the
software uses unique values to represent each of those signals. In this case,
it is easier to determine which signal passes through the Switch block.

Dependency

This parameter is enabled by Save test data to file.

Command-Line Information

Parameter: DVRandomizeNoEffectData
Type: string

Value: 'on' | 'off'

Default: 'off!'

See Also

¢ Simulink Design Verifier Data Files

¢ Results Interpretation and Use

Display results of the analysis on the model

Specify whether to display analysis results by highlighting the model and
providing context-sensitive details about the results.



Design Verifier Pane: Results

Settings
Default: Off

I7On

Highlight the model with the analysis results and provide
context-sensitive details about the results.

I off

Do not display analysis results on the model.

Command-Line Information

Parameter: DVDisplayResultsOnModel
Type: string

Value: 'on' | 'off'

Default: 'off'

See Also

e “Highlighted Results on the Model” on page 13-2

¢ Results Interpretation and Use
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Save test harness as model

Create a harness model generated by the Simulink Design Verifier analysis.

Settings
Default: Off

¥ On

Saves the harness model that the Simulink Design Verifier software
generates as a model file.

I off
Does not save the harness model that the Simulink Design Verifier
software generates.

Dependency

This parameter enables Harness model file name.

Command-Line Information

Parameter: DVSaveHarnessModel
Type: string

Value: 'on' | 'off'

Default: 'off'

See Also

e “Simulink® Design Verifier™ Harness Models” on page 13-17

¢ Results Interpretation and Use
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Harness model file name
Specify a folder and file name for the harness model.

Settings
Default: $ModelName$ harness

e QOptionally, enter a path that is either absolute or relative to the path name
specified in Output directory.

e Enter a file name for the harness model.

® $ModelName$ is a token that represents the model name.

Dependency

This parameter is enabled by Save test harness as model.

Command-Line Information

Parameter: DVHarnessModelFileName
Type: string

Value: any valid path and file name
Default: '$ModelName$_harness'

See Also

e “Simulink® Design Verifier™ Harness Models” on page 13-17

¢ Results Interpretation and Use
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Reference input model in generated harness
Use a Model block to reference the model to run in the harness model.

Settings
Default: Off

IFOn

Uses a Model block to reference the model to run in the harness model.

™ off

Uses a copy of the model in the harness model.

Tips

e If the Test Unit in the harness model is a subsystem, the values of the

Simulink simulation optimization parameters on the Configuration
Parameters dialog box may impact your coverage results.

Note The simulation optimization parameters are on the following
Configuration Parameters dialog box panes:

= Optimization pane
= Optimization > Signals and Parameters pane

= Optimization > Stateflow pane

If your model contains bus objects and you select Reference

input model in generated harness, in the Configuration
Parameters > Diagnostics > Connectivity pane, you must set the
Mux blocks used to create bus signals parameter to error. For more
information, see “Prevent Bus and Mux Mixtures”.

On the Design Verifier > Parameters pane, if you select the Apply
parameters parameter, the Simulink Design Verifier software uses a
subsystem that contains a copy of the original model in the harness model,
even if you select Reference input model in generated harness.
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Command-Line Information

Parameter: DVModelReferenceHarness
Type: string

Value: 'on' | 'off!'

Default: 'off'

See Also

* “Simulink® Design Verifier™ Harness Models” on page 13-17

¢ Results Interpretation and Use
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Save test harness as SystemTest TEST-file (will
reference saved data file)

Save the analysis results as a SystemTest TEST-file so you can run test cases
using the SystemTest capabilities.

Note The option to create a SystemTest TEST-file is only available
In test-generation mode; you cannot create this file when running a
property-proving analysis.

Settings
Default: Off

¥ on
Saves the analysis results as a SystemTest TEST-file.

I ofr

Does not save the analysis results as a SystemTest TEST-file.

Dependency

This parameter enables SystemTest file name.

Command-Line Information

Parameter: DVSaveSystemTestHarness
Type: string

Value: 'on' | 'off'

Default: 'off'

See Also

o “Export Test Cases to SystemTest” on page 13-26

¢ Results Interpretation and Use
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SystemTest file name
Specify a folder and file name for the SystemTest TEST-file.

Settings
Default: $ModelName$ harness

e QOptionally, enter a path that is either absolute or relative to the path name
specified in Output directory.
¢ Enter a file name for the SystemTest TEST-file.

® $ModelName$ is a token that represents the model name.

Dependency

This parameter is enabled by Save test harness as SystemTest TEST-file
(will reference saved data file).

Command-Line Information

Parameter: DVMSystemTestFileName
Type: string

Value: any valid path and file name
Default: '$ModelName$_harness'

See Also

o “Export Test Cases to SystemTest” on page 13-26

¢ Results Interpretation and Use
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Design Verifier Pane: Report

15-62

Report

Generate report of the results

Report file name:

Include screen shots of properties

Display report

In this section...

“Report Pane Overview” on page 15-63

“Generate report of the results” on page 15-64
“Report file name” on page 15-65

“Include screen shots of properties” on page 15-66

“Display report” on page 15-67




Design Verifier Pane: Report

Report Pane Overview

Specify options that control how the Simulink Design Verifier software
reports its results.

See Also

¢ “Simulink® Design Verifier™ Reports” on page 13-29

e Results Interpretation and Use
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Generate report of the results

Generate and save a Simulink Design Verifier report.

Settings
Default: Off

¥ On
Saves the HTML report that the Simulink Design Verifier software
generates.

I ofr

Does not generate a Simulink Design Verifier report.

Dependencies

When this parameter is enabled, you must enable Save test harness as
model.

This parameter enables the following parameters:

¢ Report file name
¢ Include screen shots of properties

* Display report

Command-Line Information

Parameter: DVSaveReport
Type: string

Value: 'on' | 'off'
Default: 'off"

See Also

e “Simulink® Design Verifier™ Reports” on page 13-29

¢ Results Interpretation and Use
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Report file name

Specify a folder and file name for the report that Simulink Design Verifier
analysis generates.

Settings
Default: $ModelName$ report

e QOptionally, enter a path that is either absolute or relative to the path name
specified in Output directory.

e Enter a file name for the report that the analysis generates.

® $ModelName$ is a token that represents the model name.

Dependency

This parameter is enabled by Generate report of the results.

Command-Line Information

Parameter: DVReportFileName
Type: string

Value: any valid path and file name
Default: '$ModelName$ report'

See Also

e “Simulink® Design Verifier™ Reports” on page 13-29

¢ Results Interpretation and Use
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Include screen shots of properties

Includes screen shots of properties in the Simulink Design Verifier report.
Only valid in property-proving mode.

Settings
Default: Off

¥ On
Includes screen shots of properties in the Simulink Design Verifier
report. Only valid in property-proving mode.

" o
Does not include screen shots of properties in the Simulink Design
Verifier report.

Dependency

This parameter is enabled by Generate report of the results.

Command-Line Information

Parameter: DVReportIncludeGraphics
Type: string

Value: 'on' | 'off!'

Default: 'off"

See Also

¢ “Simulink® Design Verifier™ Reports” on page 13-29

¢ Results Interpretation and Use
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Display report
Display the report that the Simulink Design Verifier analysis generates after
completing its analysis.

Settings
Default: On

¥ On
Displays the report that the analysis generates after completing its
analysis.

I off
Does not display the report that the analysis generates after completing
its analysis.

Dependency

This parameter is enabled by Generate report of the results.

Command-Line Information

Parameter: DVDisplayReport
Type: string

Value: 'on' | 'off!'
Default: 'on'
See Also

e “Simulink® Design Verifier™ Reports” on page 13-29

® Results Interpretation and Use
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Parameter Command-Line Information Summary

The following table lists parameters that you can use to configure the
behavior of the Simulink Design Verifier software. Use the get _param and
set_param functions to retrieve and specify values for these parameters
programmatically.

For each parameter listed in the table, the Description column indicates
where you can set its value on the Configuration Parameters dialog box.

The Values column shows the type of value required, the possible values
(separated with a vertical line), and the default value (enclosed in braces).

Parameter

Description

Values

DVAssertions

Set by the Assertion blocks
parameter on the Design
Verifier > Property
Proving pane.

'EnableAll' | 'DisableAll’
{'UselLocalSettings'}

DVAutomaticStubbing

Set by the Automatic
stubbing of unsupported
blocks and functions
parameter on the Design
Verifier pane.

{'on'} | 'off'

DVBlockReplacement

Set by the Apply

block replacements
parameter on the
Design Verifier > Block
Replacements pane.

‘on' | {'off'}

DVBlockReplacement-
ModelFileName

Set by the File path

of the output model
parameter on the
Design Verifier > Block
Replacements pane.

string
{'$ModelName$ replacement'}

DVBlockReplacement-
RulesList

Set by the List of
block replacement
rules parameter on the
Design Verifier > Block
Replacements pane.

string
{'<FactoryDefaultRules>"'}
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Parameter

Description

Values

DVCoverageDataFile

Set by the Coverage data
file parameter on the
Design Verifier > Test
Generation pane.

string {''}

DVCovFilter

Set by the Ignore
objectives based on
filter parameter on the
Design Verifier > Test
Generation pane.

‘on' | {'off'}

DVCovFilterFileName

Set by the Coverage filter
file parameter on the
Design Verifier > Test
Generation pane.

string {''}

DVDataFileName

Set by the Data file name
parameter on the Design
Verifier > Results pane.

string
{'$ModelName$_sldvdata'}

DVDesignMinMaxCheck

Set by the Check specified
intermediate minimum
and maximum values
parameter on the Design
Verifier > Design Error
Detection pane.

‘on' | {'off'}

DVDesignMinMax -
Constraints

Set by the Use specified
input minimum and
maximum values
parameter on the Design
Verifier pane.

{'on'} | 'off'

DVDetectIntegerOverflow

Set by the Integer overflow
parameter on the Design
Verifier > Design Error
Detection pane.

{'on'} | 'off'

DVDetectDivisionByZero

Set by the Division by zero
parameter on the Design
Verifier > Design Error
Detection pane.

{'on'} | 'off'
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Parameter

Description

Values

DVDetectOutOfBounds

Set by the Out of
bound array access
parameter on the Design
Verifier > Design Error
Detection pane.

‘on' | {'off'}

DVDisplayReport

Set by the Display report
parameter on the Design
Verifier > Report pane.

{'on'} | 'off'

DVDisplayResultsOnModel

Set by the Display results
of the analysis on the
model parameter on the
Design Verifier > Results
pane.

‘on' | {'off'}

DVDisplayUnsatisfiable-
Objectives

Set by the Display
unsatisfiable test
objectives parameter on the
Design Verifier pane.

‘on' | {'off'}

DVExtendExistingTests

Set by the Extend existing
test cases parameter on
the Design Verifier > Test
Generation pane.

‘on' | {'off'}

DVExistingTestFile Set by the Data file string {''}
parameter on the
Design Verifier > Test
Generation pane.
DVHarnessModelFileName Set by the Harness model | string

file name parameter on the
Design Verifier > Results
pane.

{'$ModelName$ harness'}

DVIgnoreCovSatisfied

Set by the Ignore objectives
satisfied in existing
coverage data parameter on
the Design Verifier > Test
Generation pane.

‘on' | {'off'}
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Parameter Description Values
DVIgnoreExistTest- Set by the Ignore objectives | {on'}| 'off'
Satisfied satisfied by existing test

cases parameter on the
Design Verifier > Test
Generation pane.

DVMakeOutputFilesUnique Set by the Make output file | {'on'} | 'off'
names unique by adding
a suffix check box on the
Design Verifier pane.

DVMaxProcessTime Set by the Maximum double {'300'}
analysis time parameter on
the Design Verifier pane.

DVMaxTestCaseSteps Set by the Maximum test int32 {'500"'}
case steps parameter on
the Design Verifier > Test
Generation pane.

DVMaxViolationSteps Set by the Maximum int32 {'20'}
violation steps
parameter on the Design
Verifier > Property
Proving pane.

DVMode Set by the Mode parameter | {'TestGeneration'} |
on the Design Verifier 'DesignErrorDetection’' |
pane. 'PropertyProving'
DVModelCoverage- Set by the Model coverage | 'None' | 'Decision' |
Objectives objectives parameter on {'ConditionDecision'} |

the Design Verifier > Test | 'MCDC'
Generation pane.

DVModelReferenceHarness Set by the Reference ‘on' | {'off")
input model in generated
harness parameter on the
Design Verifier > Results
pane of the Configuration
Parameters dialog box.
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Parameter Description Values
DVOutputDir Set by the Output directory | string
parameter on the Design {'sldv_output/$ModelName$'}
Verifier pane.
DVParameters Set by the Apply ‘on' | {off'}
parameters parameter
on the Design
Verifier > Parameters
pane.
DVParametersConfigFile- Set by the Parameter string

Name configuration file {'sldv_params_template.m'}
parameter on the Design
Verifier > Parameters
pane.
DVProofAssumptions Set by the Proof 'EnableAll' | 'DisableAll’ |
assumptions parameter {'UselLocalSettings'}
on the Design
Verifier > Property
Proving pane.
DVProvingStrategy Set by the Strategy ‘FindViolation'
parameter on the Design | {'Prove'} |

Verifier > Property
Proving pane.

'"ProveWithViolationDetection'

DVRandomizeNoEffectData

Set by the Randomize data
that do not affect the
outcome parameter on the
Design Verifier > Results
pane.

‘on' | {'off'}

DVReportFileName

Set by the Report file name
parameter on the Design
Verifier > Report pane.

string {'$ModelName$ report'}

DVReportIncludeGraphics

Set by the Include screen
shots of properties
parameter on the Design
Verifier > Report pane.

‘on' | {'off'}
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Parameter

Description

Values

DVSaveDataFile

Set by the Save test data
to file parameter on the
Design Verifier > Results
pane.

{'on'} | 'off'

DVSaveExpectedOutput

Set by the Include

expected output values
parameter on the Design
Verifier > Results pane.

‘on' | {'off'}

DVSaveHarnessModel

Set by the Save test harness
as model parameter on the
Design Verifier > Results
pane.

‘on' | {off'}

DVSaveReport

Set by the Generate
report of the results
parameter on the Design
Verifier > Report pane.

‘on' | {off'}

DVSaveSystemTestHarness

Set by the Save test harness
as SystemTest TEST-file
(will reference saved
data file) parameter on the
Design Verifier > Results
pane.

‘on' | {off'}

DVSystemTestFileName

Set by the SystemTest file
name parameter on the
Design Verifier > Results
pane.

string
{'$ModelName$ harness'}

DVTestConditions

Set by the Test conditions
parameter on the

Design Verifier > Test
Generation pane.

'EnableAll' | 'DisableAll’' |
{'UseLocalSettings'}
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Parameter Description Values
DVTestObjectives Set by the Test objectives 'EnableAll' | 'DisableAll’
parameter on the {'UselLocalSettings'}

Design Verifier > Test
Generation pane.

DVTestSuiteOptimization Set by the Test suite {'CombinedObjectives'} |
optimization parameter on | 'IndividualObjectives'
the Design Verifier > Test | | 'LargeModel' |
Generation pane. 'LongTestcases' |

"CombinedObjectives

(Nonlinear Extended)'
'LargeModel (Nonlinear
Extended) '

15-74



Glossary

abstraction
The process of ignoring certain aspects of model behavior that do not
affect the test objective or property under investigation.

analysis model
The target model for a Simulink Design Verifier analysis. If you select
an atomic subsystem for analysis, the analysis model is generated by
extracting the subsystem to a new model.

assumption
A property that is assumed to be true during a property proof. The proof
result holds only when the assumption is true.

block replacement rule
A rule that is registered with the Simulink Design Verifier software and
defines how instances of specific blocks are replaced by an alternate
implementation. The software uses MATLAB commands to define when
and how to apply a block replacement rule (see “Define Custom Block
Replacements” on page 4-8).

component verification
The process of verifying an individual components in a model. You
can verify a component within the execution context of the model, or
independently of its parent model.

condition coverage
Measures the percentage of the total number of logic conditions
associated with logical model objects that the simulation actually
exercised. Enabling condition coverage causes every decision and
condition coverage outcome to be enabled. See “Types of Model
Coverage” in the Simulink Verification and Validation documentation.

constraint
A property that is forced to be true during test case generation.

counterexample
A test case that demonstrates a property violation.
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Glossary-2

coverage objective
A test objective that defines when a coverage point results in a
particular outcome.

coverage point
A decision, condition, or MCDC expression associated with a model
object. Each coverage point has a fixed number of mutually exclusive
outcomes.

decision coverage
Measures the percentage of the total number of simulation paths
through model objects that the simulation actually traversed. Decision
coverage 1s a subset of modified decision/condition coverage. See
“Types of Model Coverage” in the Simulink Verification and Validation
documentation.

floating-point approximation
The process of approximating floating-point numbers using rational
numbers (i.e., fractions whose numerator and denominator are small
integers). The Simulink Design Verifier software performs floating-point
approximations during its analysis. It can generate invalid test cases
that result from numerical differences. For example, given a large
enough floating-point number X, the expression x==(x+1) can be true;
however, this expression never holds if x is a rational number.

invalid test case
A test case that does not satisfy its objectives.

modified condition/decision coverage (MCDC)
Measures the independence of logical block inputs and transition
conditions associated with logical model objects during the simulation.
When you set the coverage objective to MCDC, Simulink Design Verifier
automatically enables every coverage objective for decision coverage and
condition coverage as well.

Note that MCDC test cases are not generated for XOR configured logic
operators. You can achieve MCDC by using the same tests that would
be generated from AND configured blocks or OR configured blocks.

See “Types of Model Coverage” in the Simulink Verification and
Validation documentation.
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nonlinear arithmetic
A computation in the model that cannot be expressed as a combination
of mutually exclusive linear expressions. Nonlinear arithmetic can
affect a property or test objective, and it can cause the analysis to return
an error. In this case, you should apply simplifying approximations
and abstractions.

property
A logical expression of the signals and data values, within a model, that
1s intended to be proven true during simulation. Properties evaluate at
specific points in the model.

property violation
The condition during a simulation when a property is false.

test case
A sequence of numeric values and input data time that you input to a
model during its simulation.

test harness
A model that runs test cases on an analysis model.

test objective
A logical expression of the signals and data values, within a model, that
is intended to be true at least once in the resulting test case during
simulation. Test objectives evaluate at specific points in the model.

Test Objective block
The block that you add to a model to define test objectives. In the block
mask, define test objectives as values or ranges that an input signal
must satisfy during a test case.

unsatisfiable test objective
The status of a test objective that indicates a test case cannot be
generated for the specified approximations. This includes floating-point
approximations and maximum-step limitations specified in the Design
Verifier > Test Generation pane of the Configuration Parameters
dialog box.
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validated property
The status of a property that indicates no counterexample exists,
subject to floating-point approximations and the settings specified in the
Property Proving pane of the Configuration Parameters dialog box.
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